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Notes for the reader

Introduction

This manual helps you to use the Océ TDS450. The manual contains a 
description of the Océ TDS450 and guidelines to use and operate the Océ 
TDS450. There are also tips to increase your knowledge of the Océ TDS450 
and to help you manage the workflow even better.

Definition

Attention Getters

Parts of this manual require your special attention. These parts provide 
important, additional information or are about the prevention of damage to 
your properties. 

Note, Attention and Caution

The words Note, Attention and Caution indicate these important parts. 

■ The word Note comes before additional information about the correct 
operation of the Océ TDS450 or a tip.

■ A part marked with Attention contains information to prevent damage to 
items, for example the Océ TDS450, an original or a file.

■ A part marked with Caution contains information to prevent personal 
injury. Caution is found only in manuals that describe physical products.

Safety information

The safety information for this product is included in a separate manual with 
the title Safety manual. This manual is part of the documentation set that you 
received with your product.
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The product concept and complete workflow

Definition

A complete Océ solution includes several different hardware and software 
products to manage your complete document workflow. The complete 
document workflow includes several different jobs and documents. The 
following illustration gives an overview of a complete Océ solution and the 
document workflow.

Illustration
[1] Overview of a complete Océ solution. The system set-up and control.

[1] Overview of a complete Océ solution. The system set-up and control.

Different documents

The complete workflow includes the following different documents.

Nr. Document

1 Original

2 Copy

3 Print

4 File

Scanner Controller Printer
Finishing
Options

Job
Submission

Document
Management
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Different products

The complete Océ solution is a combination of the following elements.
■ Scanner
■ Controller
■ Printer
■ Finishing options
■ Job submission software
■ Document management software.

Different jobs

The arrows in the illustration show the different possible jobs (see figure 1 on 
page 12). The complete document workflow of the Océ solution includes the 
following different jobs.
■ Print job.

A print job starts with a file (4) and ends with a print (3). 
■ Copy job.

A copy job starts with an original (1) and ends with a copy (2).
■ Scan-to-file job.

A scan-to-file job starts with an original (1) and ends with a file (4).
■ Set-up and control the complete workflow.

Do  which job where

Use the following products to do the following jobs.
■ Print jobs on the job submission software
■ Copy jobs on the scanner operator panel
■ Scan-to-file jobs on the scanner operator panel
■ Set up and control the complete  workflow on the controller.

Note: A setting in the job submission software or driver always overrules a 
system setting.
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How to use this manual

Introduction

You can access a topic quickly through the following methods.
■ Refer to the alphabetical index at the end of the manual.
■ Refer to the table of contents at the beginning of this manual.

Before you turn to the complete table of contents, you can also use the 
following table to find a topic quickly.

The sections of this manual

The following table gives an overview of how the chapters are arranged 
logically.

Chapters Section Topics

1 - 6 Get to know the 
system

■ The product concept and 
complete workflow.

■ Scanner
■ Controller
■ Printer
■ Finishing options.
■ Software applications.

7 - 9 Set up and control the 
system

■ Set up the system.
■ Set up the workflow.
■ Control the workflow.

10 - 13 Use the system ■ Copy job
■ Print job
■ Scan job
■ Finishing options

14 Maintain the system ■ Replace media
■ Add toner
■ Maintain the scanner, printer 

and finishing options.
■ Find solutions.

Appendix A & B Specifications ■ System specifications
■ Supported media types and 

sizes.
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Available documentation

Introduction

This manual is part of a complete documentation set. The following table 
shows a complete overview of the available documentation.
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Available documentation
[1] Available documentation

Product Documentation Medium

Océ TDS450 Océ TDS450 User manual. CD-ROM, as a PDF file in 
multiple languages.

Océ TDS450 Quick 
Reference Card.

Paper poster, A3 in colour.

Océ TDS450 Maintenance 
Card.

Paper poster, A3 in colour.

Océ TDS450 scanner 
Safety Manual.

Manual, multilingual.

Océ TDS450 printer Safety 
Manual.

Manual, multilingual.

Océ Power Logic®  
controller

Océ TDS-TCS connectivity 
manual.

CD-ROM, as a PDF file in 
English only.

Océ Power Logic® 
applications on-line help

Embedded in the 
applications, as an on-line 
help file in multiple 
languages.

Océ Windows® Printer 
Driver

Océ Windows® Printer 
Driver User Manual

CD-ROM, as a PDF file in 
multiple languages on Océ 
Driver Pack CD-ROM.

Océ Windows® Printer 
Driver on-line help

Embedded in the driver 
application as on-line help 
file in multiple languages.

Océ PostScript® 3 driver Océ PostScript® 3 driver 
Getting Started

CD-ROM, as a PDF file in 
multiple languages on Océ 
Driver Pack CD-ROM.

Océ PostScript® 3 driver 
Getting Started

Embedded in the driver 
application as on-line help 
file in multiple languages.

Océ HDI Driver Océ HDI Driver User 
Manual

CD-ROM, as a PDF file in 
multiple languages on Océ 
Driver Pack CD-ROM.

Océ HDI driver on-line 
help

Embedded in the driver 
application as on-line help 
file in multiple languages.
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[1] Available documentation

Note: Visit Océ on the internet at www.oce.com for the latest information.

Océ Windows® Raster 
Driver 

Océ Windows® Raster 
Driver User Manual

CD-ROM, as a PDF file in 
multiple languages on Océ 
Driver Pack CD-ROM.

Océ Windows® Raster 
Driver on-line help

Embedded in the driver 
application as on-line help 
file in multiple languages.

Océ Account Center Océ Account Center User 
Manual

CD-ROM, as a PDF file in 
multiple languages.

Océ Account Logic on-line 
help.

Embedded in the 
application, as an on-line 
help file in multiple 
languages.

Océ Account Console 
on-line help.

Embedded in the 
application, as an on-line 
help file in multiple 
languages.

Océ License Logic Océ License Logic on-line 
help

Embedded in the 
application, as an on-line 
help file in multiple 
languages.

Océ Print Exec® 
Workgroup

Océ Print Exec® 
Workgroup User Manual

CD-ROM, as a PDF file in 
multiple languages.

Océ Print Exec® 
Workgroup on-line help

Embedded in the driver 
application as on-line help 
file in multiple languages.

Product Documentation Medium
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The Océ TDS450 users

Introduction

The Océ TDS450 has the following types of users.
■ Common user
■ Repro operator
■ Key operator
■ System administrator.

Common user

The common user is a person who uses the system for print, copy and 
scan-to-file jobs. The common user has no permission to change the system 
settings. Therefore, the common user is referred to as an anonymous user. In 
order to be consistent with the Océ Power Logic® controller software, in this 
manual the common user is referred to as an anonymous user.

Repro operator

The repro operator is responsible for the daily use of the Océ TDS450 in a 
central repro department. The repro operator has no permission to change the 
settings in the Océ Settings Editor. 
The repro operator has full permission in the Océ Queue Manager.

Key operator

The key operator is responsible for the user maintenance and the system 
settings of the Océ TDS450.
The key operator has the permission to define the key operator settings in the 
Océ Settings Editor.

Key operator settings

Mode Settings to change

Key operator ■ System settings
■ Printer settings
■ Scanner settings
■ Job settings for print jobs
■ Job settings for copy jobs
■ Job settings for scan-to-file jobs 
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The key operator has full permission in the Océ Queue Manager.

System administrator

The system administrator is responsible for the installation and the 
configuration of  the Océ TDS450 in the network environment.

The system administrator has the permission to define the system 
administrator settings in the Océ Settings Editor.

System administrator settings

Mode Settings to change

System 
administrator

■ System settings
■ Connectivity settings
■ Printer PDL settings
■ Printer pen settings
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The Océ TDS450 scanner

Introduction

The Océ TDS450 scanner is a wide-format scanner with an optical resolution 
of 600 dpi.

Illustration
[2] The Océ TDS450 scanner

[2] The Océ TDS450 scanner

1 2
3

4

5
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The main components of the Océ TDS450 scanner

Number Component Function

1 Top cover Get access to the glass plate.

2 Original feed table Feed the original.

3 Operator panel Define the job settings.

4 On / off switch Turn the Océ TDS450 scanner 
on and off.

5 Integrated receiving tray Receive the originals.
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The scanner operator panel

Introduction

Use the scanner operator panel to do a copy or scan-to-file job.

Illustration
[3] The operator panel of the Océ TDS450 scanner

[3] The operator panel of the Océ TDS450 scanner

1 2 3 4 5 6 7 8 9 0

3

5

6

11

4

1 2

78

10

  9

12
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The keys and their functions
[2] The keys and their functions

Number Component Function

1 Green and red light Indicate the status of the scanner.
■ A green light indicates that the scanner is 

ready.
■ A blinking green light indicates that the 

scanner is busy.
■ A red light indicates that an error occurred.
■ A blinking red light indicates that the scanner 

is busy and an error occurred.

2 Screen Show the system information in text and icons.

3, 12 Upper softkeys The upper-left softkey can have one of the 
following functions.
■ Select the job, 'Copy' or 'Scan-to-file'. 
■ Return to  the home screen with the '\ue177 

Home' function.
■ Cancel a set with 'Cancel set' in case of a set 

copy.

The upper-right softkey can have one of the 
following functions.
■ Cancel a setting with the 'Cancel' function.
■ Create and close a set with the 'Create set' and 

'Close set' function.

4 Scroll-wheel key ■ Open a template or a  setting
■ Close a setting
■ Define a toggle setting.

5 Scroll wheel ■ Scroll to a setting or template
■ Define the value of a setting.

6, 10 Lower softkeys The lower-left softkey can have one of the 
following functions.
■ Select another language.
■ Reset the settings of the templates with the 

'Defaults' function.

The lower-right softkey can have one of the 
following functions.
■ Close a setting with the 'Close' function.
■ Open the system settings with the 'System' 

function.
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[2] The keys and their functions

Note: The function of a softkey depends on where you are in the definition the 
job settings step.

7 Start key Start a copy or scan-to-file job.

8 Stop key ■ Stop a copy or scan-to-file job
■ Release an original.

9 Numeric keys Enter a numeric value.

11 Left softkeys ■ Open a template.
■ Define a setting that contains two values.
This setting is called a toggle setting.
■ Open a setting that contains various values
■ Open a setting that contains various settings.
This setting is called a grouped setting.

Number Component Function
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The Océ Power Logic® controller

Introduction

The Océ Power Logic® controller is based on a PC platform running 
Windows® XP embedded.

The Océ Power Logic® controller is required for the following.
■ Process the print jobs
■ Define the default system settings
■ Manage the job queue
■ Manage the set memory
■ Receive jobs over the network.

The location of the Océ Power Logic® controller

You can place the Océ Power Logic® controller in one of the following 
locations.
■ Inside the controller cabinet of the Océ TDS450 printer.
■ When you have a monitor, a keyboard and a mouse connected to the Océ 

Power Logic® controller, the controller is always placed inside a separate 
controller cabinet.  
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The applications that run on the Océ Power Logic® controller
[3] Océ applications that can run on the Océ Power Logic® controller

Application Function

Océ System Control Panel ■ Display the status of the printer
■ Display the media available on the system
■ Display the status of the scanner
■ Display the volume of set memory in use
■ Print the configuration settings
■ Print a demo print.

Océ Settings Editor With the Océ Settings Editor you can view or edit the 
default settings of the system. 
The repro operator and the anonymous users can only 
view the default settings.
To edit the default settings you need a password.
There are two types of settings.
■ Key operator settings (KO settings).
To edit the key operator settings you need a key-operator 
password.
■ System administrator settings (SA settings).
To edit the system administrator settings you need a 
system administrator password.

Océ Queue Manager ■ Control and view the job queue
■ Inspect the progress of a job by set and page.
■ Cancel jobs
■ Delete jobs
■ Pause and restart jobs
■ Move jobs to the top of the queue
■ Reprint multiple sets from the history queue.
■ Print jobs from the inbox queue
■ View the properties of jobs in the print queue, inbox 

queue and history queue.

Océ Scan Manager ■ Create and manage the destinations for scan to file
■ Define the file names
■ Manage the files
■ View the scanned files.

Océ Account Logic ■ Create an exact record of the print, copy and 
scan-to-file volume for accounting purposes.
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[3] Océ applications that can run on the Océ Power Logic® controller

Note: To perform some of these actions you need a password.

Océ License Logic ■ Manage the licenses for the Océ software applications

Océ Remote Logic® Use Océ Remote Logic® to access the Océ System Control 
Panel, the Océ Settings Editor, and the Océ Queue 
Manager from a remote workstation.

Application Function
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Océ Settings Editor

Introduction to the Océ Power Logic® controller: Océ Settings 
Editor

Definition

This chapter gives information about the Océ Settings Editor. The on-line help 
of the Océ Settings Editor application contains exact information about 
specific settings.

You can access the Océ Settings Editor locally on the controller if you have a 
keyboard, mouse and monitor with your Océ Power Logic® controller. You 
must use Océ Remote Logic® to connect to the Océ Settings Editor when you 
do not have a keyboard, mouse and monitor with your Océ Power Logic® 
controller.

Description of the Océ Settings Editor

Use the Océ Settings Editor to define the default settings for the system 
according to your requirements.

The Océ Settings Editor contains the following types of settings.
■ Key Operator settings (KO settings).
■ System Administrator settings (SA settings).
■ A password protects the KO settings and the SA settings. Without a 

password, you can only view the settings.

The key operator is allowed to change the following groups of settings (see 
‘Define the settings in the Océ Settings Editor’ on page 41).
■ Job settings for the print jobs
■ Printer settings
■ System settings.
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The system administrator is allowed to change the following groups of settings 
(see ‘Define the settings in the Océ Settings Editor’ on page 41).
■ Poker settings
■ Printer language (PDL) settings
■ Pen settings
■ Automatic Language Selection (ALS) settings
■ Controller identification settings
■ Set memory reservation settings
■ Connectivity settings.

In the 'Anonymous' mode, the operator is not logged on. The anonymous user 
is allowed only to view the settings.
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Overview

Overview of the Océ Settings Editor

Introduction

The Océ Settings Editor has the following fields.
■ The menu bar
■ The top toolbar
■ The left toolbar
■ The settings area
■ The status bar.
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Illustration
[4] The structure of the Océ Settings Editor

[4] The structure of the Océ Settings Editor

[5] The menu bar

[5] The menu bar

[6] The top toolbar

[6] The top toolbar
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[7] The left toolbar

[7] The left toolbar
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[8] The settings area

[8] The settings area
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The menu bar
[4] The menu bar items

[4] The menu bar items

Menu Function

'File' ■ Log on to a user mode
■ Log off from the previous user mode
■ Open a file that contains saved settings
■ Save the current settings to a file
■ Connect to a different controller ( for remote users 

only).
■ Close the application.

'Edit' ■ Define the host name
■ Define the default system you want to connect to at 

the start-up
■ Use 'Automatic logon', to start the Océ Settings 

Editor application automatically in the defined user 
mode.

'View' ■ Toggle between the display languages
■ Toggle between the display of the KO settings and 

the SA settings.

'Help' ■ Access the contents of the on-line help
■ Get more information about the copyright and the 

version of the application.



38 User manual

The top toolbar
[5] The buttons of the top toolbar

[5] The buttons of the top toolbar

The left toolbar
[6] The buttons of the left toolbar

[6] The buttons of the left toolbar

Click a button to access the special group of settings of this button. A shadow 
highlight indicates which button is activated.

The on-line help in the Océ Settings Editor includes complete information 
about the different settings.

Button Function

'Open' Open a file that contains saved settings.

'Save as...' Save all the KO settings or the SA settings in a file.

'Apply' Apply the changes you made to the settings.
Note: The button is enabled after you change a setting. 
The button is disabled after you apply the settings, or 
after an undo action.

'Undo' Restore the settings to the state before the settings 
were changed. The 'Undo' button does not restore the 
factory default.
Note: The button is enabled after you change a setting. 
The button is disabled after you apply a changed 
setting.

Button Function

'Jobs' Gives access to the settings for the jobs.
Note: The 'Jobs' button is only available in the key 
operator view.

'Printer' Gives access to the settings for the printer.

'System' Gives access to the settings for the system.

'Scanner' Gives access to the settings for the scanner.
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The settings area
[7] The parts of the settings area

[7] The parts of the settings area

The status bar

The status bar at the bottom of the Océ Settings Editor displays the following 
(from left to right).
■ The system status ('connected' or 'disconnected').
■ The system name ('local host' if you are working on the controller).
■ The user mode (key operator, system administrator or anonymous).
■ The view mode (KO Settings or SA Settings).
[8] The icons for the connection status

[8] The icons for the connection status

Part Function

Tree structure Display the settings.
Open a folder to show all the settings in that folder.
The display does not include the unavailable settings for 
the system components.

Update area Define the settings selected in the tree structure.
The update area can contain additional information 
(definition and values) about the selected setting.
Only authorised users can change the settings. If the user 
is not authorised to change a setting, the update area is 
greyed out.

Icon Description

The Océ Settings Editor is connected to a system.

The Océ Settings Editor is not connected to a system.
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Start the Océ Power Logic® controller applications

Introduction

You can start the Océ Power Logic® controller applications locally on the 
controller or from a remote workstation. This section describes how to start the 
applications locally on the Océ Power Logic® controller. The section 'Start the 
applications with Océ Remote Logic®' describes how to start the applications 
from a remote workstation (see ‘Start the applications with Océ Remote 
Logic®’ on page 66).

Start the applications locally on the Océ Power Logic® Controller

1. Select the 'Launcher' application.
2. Select the required application.

The application starts with your default system.
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Use the Océ Settings Editor

Define the settings in the Océ Settings Editor

Introduction

The Océ Settings Editor allows you to define the following settings.
■ Key operator settings (KO settings)
■ System administrator settings (SA settings).

You need a password to change the KO settings and SA settings (see ‘Log on 
to the controller applications’ on page 73).

Note: Only one key operator, system administrator or repro operator at a time 
is authorised to change the settings. An error message appears when a second 
user tries to log on to the key operator mode or system administrator mode. 
Multiple users are authorised to view the settings.

How to define the key operator settings

1. Log on to the key operator mode.
2. Use the buttons on the left toolbar to display the required group of settings.
3. Select the required settings in the tree structure.
4. Define the settings in the update area.
5. Click the 'Apply' button to confirm the new settings.
6. Log off from the key operator mode to prevent unauthorised use of the 

application.

How to define the system administrator settings

1. Log on to the system administrator mode.
2. Use the buttons on the left toolbar to display the required group of settings.
3. Select the required settings in the tree structure.
4. Define the settings in the update area.
5. Click the 'Apply' button to confirm the new settings.
6. Log off from the system administrator mode to prevent unauthorised use of the 

application.
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Save, load,and print the settings

Introduction

It is possible that you need different settings for different customers, 
departments or other conditions. For this reason, you can save the settings to a 
file and then load the settings from a file.

The Océ TDS450 has the following special files for your use.
1. Backup.kos/Backup.sas  

These files contain the previous values for the key operator settings and the 
system administrator settings before the last 'Apply'.

2. Current.kos/Current.sas  
These files contain the values for the key operator settings and the system 
administrator settings after the last 'Apply'.

If you need a complete overview of all settings defined in the Océ Settings 
Editor, you can print a list of all current settings.

How to save the settings to a file

1. From the 'File' menu, select 'Save as'.
You can also click the 'Save as' button on the toolbar.
If the client is a local client, the screen displays a dialogue box. The user can 
enter a file name. The file is saved in the specified directory on the system.
If the client is a remote client, the screen displays a dialogue box. The user can 
enter a directory name and a file name.
Note: Repro operators and anonymous users are not authorised to save the 
settings to a file.
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How to load the settings from a file

1. From the 'File' menu, select 'Open'.
You can also click the 'Open' button on the toolbar.
The screen displays a dialogue box from where you can browse to the required 
file.

2. Click the 'Apply' button.
The settings are transferred to the system.
When you are logged on as a key operator, the system only loads the KO 
settings.
When you are logged on as a system administrator, the system only loads the 
SA settings.
Repro operators and anonymous users are not authorised to load the settings 
from a file.

How to print a list of the current settings

1. From the 'System' menu in the Océ System Control Panel, select 'Print 
settings'.
A list of the current settings on the Océ Power Logic® controller is printed.
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Océ System Control Panel

Introduction to the Océ Power Logic® controller: Océ System 
Control Panel

Definition

The Océ System Control Panel application provides you with the following 
information about the status of the system.
■ Status of the printer
■ Descriptions of the different types and sizes of available media on the 

system
■ Status of the scanner
■ Status of the controller
■ The amount of set memory in use.

You can access the Océ System Control Panel locally on the controller if you 
have a keyboard, mouse and monitor with your Océ Power Logic® controller. 
If you do not have a keyboard, mouse and monitor with your Océ Power 
Logic® controller you must use Océ Remote Logic® to connect to the Océ 
System Control Panel.

See  'Océ Power Logic® controller: Océ Settings Editor' for information about 
how to start the application locally on the controller.(see ‘Start the Océ Power 
Logic® controller applications’ on page 40).
See 'Océ Power Logic® controller: Océ Remote Logic®' for information about 
how to start the application from a remote workstation. (see ‘Start the 
applications with Océ Remote Logic®’ on page 66).

User operations in the Océ System Control Panel

The Océ System Control Panel allows you to

■ Print your system configuration  (see ‘Save, load,and print the settings’ on 
page 42)

■ Clear the system memory (see ‘Clear the set memory’ on page 248) 
■ Shut down the system (see ‘Turn on and shut down the Océ Power Logic® 

controller’ on page 114)
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Overview of the Océ System Control Panel

Introduction

The Océ System Control Panel contains the following items.
1. The menu bar
2. The toolbar, with buttons to access the view area
3. The status of the printer
4. An overview of the loaded media types
5. The status of the scanner
6. The status of the Océ Power Logic® controller
7. The amount of set memory in use
8. The status bar

Illustration
[9] The structure of the Océ System Control Panel

[9] The structure of the Océ System Control Panel
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The menu bar
[9] The items of the menu bar

[9] The items of the menu bar

Menu Items

'File' ■ Click 'Log on' to select the user mode. Then enter the 
password.

■ Click 'Log off' to leave the user mode.
■ Click 'Connect to' and select a different controller (only for 

remote users).
■ Click 'Close' to leave the Océ System Control panel.

'Edit' Click 'Options' to define the following.
■ The 'Host name'.
■ The 'Default system'.
■ The 'Automatic logon'. Use 'Automatic logon' to start up 

automatically in the defined user mode.
■ Select the two screen languages.

'View' ■ Select one of the display languages for the application.
■ Display the items for the status control. Click an item to 

view the status. The items correspond with the buttons of 
the toolbar.

'System' ■ Click 'Print settings' to print a report of the configuration 
settings.

■ Click 'Demo print' to make a demo print.
■ Click 'Clear system' to remove all the jobs from the system.
■ Click 'Shut down' to shut down the system.

'Help' ■ Click 'Contents' to access the topics of the on-line help.
■ Click 'About' for general information about the Océ System 

Control Panel.
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The toolbar

Click the buttons on the toolbar of the Océ System Control Panel to check the 
status of the items in the view area. If operator action is required, the 
appropriate button will flash.

[10] The buttons of the toolbar

[10] The buttons of the toolbar

Item Function

'Printer' View the status of the printer. If the printer operator panel 
displays an error, the 'Printer' status window of the Océ System 
Control Panel will display the same error.

'Media' View the status of the media (available, empty or disabled). 
The 'Media' display also shows information about the available 
media sizes and media types.
Note: When a roll is disabled, the roll icon is greyed out. The 
text '-disabled-' replaces the media information.

'Controller' View the status of the controller.

'Memory' Check the amount of set memory that is available. The 
percentage on the right-hand side of the set memory meter 
indicates the amount of set memory in use. The colours 
indicate the following.
■ Green indicates that the set memory has sufficient space for 

a large print job or many small jobs.
■ Orange indicates that the set memory approaches the red 

zone. Large print jobs may not be possible.
■ Red indicates that the set memory is (nearly) full. The 

system does not accept new print jobs. Remove files or wait 
until files are printed and automatically removed from the 
memory.

Note: Define the threshold values for the orange zone and the 
red zone in the Océ Settings Editor.
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The status bar

The status bar at the bottom of the Océ System Control Panel displays the 
following.
■ The system status (connected or disconnected).
■ The system name ('local host' if you work on the Océ Power Logic® 

controller).
■ The job status (for example 'Printing').
■ The user mode (Key operator, Repro operator, System administrator, 

Service operator or 'Anonymous').
[11] The icons of the status bar

[11] The icons of the status bar

Icon Function

The Océ System Control Panel is connected to a system.

The Océ System Control Panel is not connected to a 
system.



Get to know the Océ Power Logic® controller applications 49

Icons

The Océ System Control Panel uses a number of icons to display the 
information about the media available on the printer. The following icons are 
used.

Icon Description

The media roll is available and the roll is ready to print

The media roll is disabled.

The media roll is enabled but empty.
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Océ Queue Manager

Introduction to the Océ Power Logic® controller: Océ Queue 
Manager

Definition

This chapter describes how to view and manage the jobs with the Océ Queue 
Manager.

You can access the Océ Queue Manager locally on the controller if you have a 
keyboard, mouse and monitor with your Océ Power Logic® controller.You 
must use Océ Remote Logic® to connect to the Océ Queue Manager when you 
do not have a keyboard, mouse and monitor with your Océ Power Logic® 
controller.

(see ‘Introduction to the Océ Power Logic® controller: Océ Settings Editor’ 
on page 31) for information about how to start the application locally on the 
controller. (see ‘Start the Océ Power Logic® controller applications’ on 
page 40).
(see ‘Start the applications with Océ Remote Logic®’ on page 66) for 
information about how to start the application from a remote workstation .

Description of the Océ Queue Manager

The Océ Queue Manager application provides you with a graphical image of 
the print queue, the history queue or the inbox queue

The Océ Queue Manager allows you to do the following.
■ View the queue of jobs.
■ Cancel the current job.
■ Delete jobs in the queue.
■ Place jobs on hold in the queue.
■ Print jobs from the history queue.
■ Print jobs from the inbox queue.
■ Move jobs to the top of the queue.
■ Give priority to jobs in the queue.
■ Restart the jobs that were placed on hold in the queue.
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User modes

The Océ Queue Manager has the following user modes.
■ The key operator mode
■ The repro operator mode
■ The system administrator mode
■ The service operator mode.

Note: The service operator mode is for the Océ service engineer only.
The user modes provide the following permissions.

The key operator, the repro operator and the system administrator user modes 
allow you to hold, resume or delete the jobs or to move the jobs to the top of 
the queue.

The anonymous user mode only allows the user to view the queue. All the 
buttons and menu items are disabled in this mode. The anonymous user is 
allowed to delete the jobs when the user works locally with the Océ Queue 
Manager on the controller.

Note: The key operator, the system administrator and the repro operator have 
the same access permissions to functions in the Océ Queue Manager and the 
Océ System Control Panel. The permissions to access the settings in the Océ 
Settings Editor vary according to the different user modes.
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Overview of the Océ Queue Manager

Introduction

This section contains an overview of the Océ Queue Manager application. Use 
the Océ Queue Manager to manage the jobs in the job queue.

Illustration
[10] The Océ Queue Manage

[10] The Océ Queue Manage

The structure of the Océ Queue Manager

The Océ Queue Manager contains the following items.

1. The menu bar

2. The tool bar

3. The window for the print queue

4. The window for the inbox queue or history queue

5. The status bar
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The Océ Queue Manager uses columns to display the following information 
for each job.
■ The current status and the schedule of the job
■ The name of the job
■ The type of job (a print job or a copy job)
■ The name of the user who sent the print job
■ The number of sets and pages
■ Remarks.

Note: Drag the table header separators to change the width of the columns. 
Drag a column to a new position to change the sequence of the columns.

The menu bar
[12] The items of the menu bar

[12] The items of the menu bar

Menu Items

'File' ■ Click 'Log on' to select the user mode. Then enter the 
password.

■ Click 'Log off' to leave the user mode.
■ Click 'Connect to' and select a different controller 

(only for remote users).
■ Click 'Close' to leave the Océ Queue Manager.

'Edit' Click 'Options' to define the following.
■ The 'Host name'.
■ The 'Default system'.
■ The 'Automatic logon'. Use 'Automatic logon' to start 

up automatically in the defined user mode.
■ Select the two screen languages.

'View' ■ Toggle between the defined display languages.
■ Toggle between the 'Inbox' queue and the 'History' 

queue.
■ Define the 'Column options'. Select the table headers 

you want to see when you open the Océ Queue 
Manager.

'Job' Display the actions for a job. The menu items correspond 
with the toolbar buttons.

'Help' ■ Click 'Contents' to access the topics of the on-line 
help.

■ Click 'About' for general information about the Océ 
Queue Manager.
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The toolbar
[13] The toolbar buttons

[13] The toolbar buttons

The status bar

The status bar at the bottom of the Océ Queue Manager displays the following.
■ The system status (connected or disconnected).
■ The system name ('local host' if you work on the Océ Power Logic® 

controller).
■ The job status (for example 'Printing').
■ The user mode ('Key operator', 'Repro operator', 'System administrator', 

'Service operator' or 'Anonymous').

The window for the print queue 

The print queue window in the left-hand pane contains two sections.
■ The top section above the separation line shows the job that is printed.
■ The bottom section under the separation line shows the jobs that wait to be 

printed. The window displays the jobs in the order in which the jobs are 
received.

The window for the inbox queue or history queue

The inbox queue in the right-hand pane contains the jobs that were sent to the 
inbox on the controller. You can print the jobs, delete the jobs and view the 
properties of the jobs. The print jobs are sent to the inbox when the setting KO 
- System - Job management - Print jobs in the Océ Settings Editor is set to 
inbox or when 'Send to inbox' is enabled in the driver.

The history queue in the right-hand pane contains the jobs that have been 
printed. You can print the jobs, delete the jobs and view the properties of the 

Button Function

'Hold' Place a job on hold in the print queue .

'Resume' Continue a job that was placed on hold.

'Move to top' Move a job to the top of the print queue, to give the job 
priority.

'Delete' Delete a job from the print queue.

'Properties' View the properties of a selected job.

'Print' Print a job from the print queue.
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jobs. Use the setting KO - System - Job management - History queue - Print 
job lifetime in the Océ Settings Editor to define how long the jobs must remain 
in the history queue.
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Icons

The Océ Queue Manager uses a number of icons to display information about 
a job in the queue. The following icons are used.

Icon Description

Receiving a job in the inbox or the print queue.

Received a job in the print queue.

Processing a job in the print queue.

Processed a job in the print queue.

An active job in the print queue (bold font and above the grey 
separation line).

Printing a job.

Delivering a job to the history queue.

Delivered a job to the history queue.

Deleted a job.

A job that is put on hold by default . This icon indicates that 
the job is displayed in the inbox.

A job is on hold.

Warning, a media request.
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Océ Scan Manager

Introduction to the Océ Power Logic® controller: Océ Scan 
Manager

Definition

This chapter describes how to use the Océ Scan Manager for your scan-to-file 
jobs.

Access the Océ Scan Manager local on the controller. You must have a 
keyboard, mouse and monitor with your Océ Power Logic® controller to use 
the Océ Scan Manager.

See "Océ Power Logic® controller: Océ Settings Editor" for information about 
how to start the application locally on the controller. (see ‘Start the Océ Power 
Logic® controller applications’ on page 40).

Description of the Océ Scan Manager

The Océ Scan Manager allows you to do the following.
■ Create the destinations for scan-to-file
■ Define the file names
■ Print scanned files
■ Retrieve scanned files.

Océ View Station LT

Océ View Station LT is an application that runs with Océ Scan Manager. Océ 
View Station LT enables you to view the scanned file.

When 'Auto view' is enabled, Océ View Station LT starts automatically to 
display the scanned file when the scan to file is complete. (see ‘Manage the 
scanned files’ on page 153).

User modes

Only the key operator and the service operator are allowed to make changes in 
Océ Scan Manager.



58 User manual

Overview of the Océ Scan Manager

Introduction

This section contains an overview of the Océ Scan Manager application. Use 
the Océ Scan Manager for scan to file.

Illustration
[11] The Océ Scan Manager

[11] The Océ Scan Manager

The structure of the Océ Scan Manager

The Océ Scan Manager has the following fields.
■ The menu bar
■ The top tool bar
■ The destination area
■ The scanned files area
■ The status bar.
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The menu bar
[14] The menu bar items

[14] The menu bar items

Component Function

'File' ■ When no objects are selected, you can do the following from the 'File' 
menu.

■ Log on to a user mode
■ Log off from the previous user mode.

When a destination is selected, you can do the following from the 'File' 
menu.
■ Add a new destination
■ Delete the selected destination
■ View the properties of the selected destination
■ Open the destination
■ Save the destination.

When a file is selected, the 'File' menu includes the following items.
■ View the properties of the selected file
■ Delete the selected file
■ Print the selected file
■ View the selected file.

'Edit' ■ Use 'Automatic logon', to start the Océ Scan Manager application 
automatically in the defined user mode.

'View' ■ Toggle between the display languages
■ Refresh the list of files.

'System' ■ Clear the temporary store
■ Use 'Auto view' to enable or disable the automatic view of the scan 

file.

'Help' ■ Access the contents of the on-line help
■ Get more information about the copyright and the version of the 

application.
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The tool bar
[15] The buttons of the toolbar

[15] The buttons of the toolbar

The destination area
[16] The parts of the destination area

[16] The parts of the destination area

The scanned files area

The scanned files area shows the files scanned to the destination selected in the 
destination area.
The scanned files that are scanned last, are shown on the bottom of the list.
When you cannot see the files that are scanned last, use the 'Refresh' button 
( ) on the toolbar to update the view or select 'Refresh' in the 'View' menu .

Component Function

'New' Create a destination

'Delete' Delete a destination

'View' View the scanned file

'Refresh' Update the screen.

'Print' Print a scanned file.

Component Function

The tree 
structure 
(left-hand pane 
of the main 
window)

Displays the following.
■ The destinations
■ The temporary store
■ The 'Unsent' folder.

The destination 
area (right-hand 
pane of the main 
window) 

Displays the following.
■ The file name
■ The file type
■ The file resolution
■ The file size
■ The pixel size of the image
■ The original size.
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The following information is shown for each file.
■ The file name
■ The file size
■ When the file was last modified
■ The resolution of the file
■ The size of the image in the file
■ The progress status of the current scan job.

The status bar

The status bar of Océ Scan Manager displays the following information.
■ The system status (connected, disconnected)
■ The system to which Océ Scan Manager is connected
■ The scan clicks (indicates the area that is scanned)
■ A message field
■ The user mode.

Icon Description

Océ Scan Manager is connected to a system.

Océ Scan Manager is not connected to a system.
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Océ Remote Logic®

Introduction to Océ Remote Logic®

The applications of Océ Remote Logic®

You must use Océ Remote Logic® to connect to the Océ Power Logic® 
controller applications when you do not have a keyboard, mouse and monitor 
with your Océ Power Logic® controller.

You can use Océ Remote Logic® to run the following applications from a 
remote workstation.
■ Océ Settings Editor

Use the application to change the default settings of the system.
■ Océ Queue Manager

Use the application to manage the print jobs.
■ Océ System Control Panel

Use the application to view the status of the printer, the scanner and the 
controller. You can also view the media available on the printer and the 
amount of set memory in use.

User modes

The Océ Remote Logic® controller applications have different user modes (see 
‘The Océ TDS450 users’ on page 18). An additional user mode is the 'Service 
operator' mode. This mode is for the Océ technician only.
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Install and start Océ Remote Logic

Install Océ Remote Logic® on your system

Introduction

The Océ Remote Logic® application can run on all platforms with Java 
Virtual Machine. This section describes the installation procedures for the 
different types of platforms.

Before you begin

To install Océ Remote Logic® on Windows® 9.x, NT, ME, XP, or 2000, your 
system must be at least equipped with a Pentium® 233 with 32 Mb RAM.

Installation procedure for Microsoft® Windows® platforms

1. Insert the Océ Remote Logic® CD-ROM or the Océ Power Logic® controller 
CD-ROM into the CD-ROM drive of your PC.

2. The installation starts automatically. If does not start automatically, run 
Setup.exe.

3. Select the required language in the installation wizard and click 'OK'.
[12] Select the setup language

[12] Select the setup language

4. Follow the instructions on the screen to complete the installation of Océ 
Remote Logic®.
Note: You can only use Océ Remote Logic® when TCP/IP is enabled on your 
system. Refer to your system administrator for help with the installation 
procedure for TCP/IP.
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Installation procedure for UNIX platforms

1. Check if a Java Runtime Environment (JRE) is installed on the system.
2. From the directory  Products/remotelogic/UNIX , unpack the contents of the 

file  RemoteLogic_vX.tar  to a subdirectory on the system.
3. Use  tar xvf RemoteLogic_vX.tar  to unpack the file.
4. Set the environment variable  RL_VM_HOME  to point to the installation of 

the JVM.
5. Run the file  remotelogic  with the applications as parameters (for example  

remotelogic QM SCP SE  to start the three applications), or use  remotelogic 
AL  as the application launcher.

UNIX versions and the required JRE

Note: OS = Operating System, JRE = Java Runtime Environment

UNIX version OS 
version

JRE Default 
installation 
directory

IBM® AIX 4.1.5 1.1.6 /usr/jdk_base

IBM® AIX 4.2.1 1.1.8 /usr/jdk_base

IBM® AIX 4.3.3 + 
fix

1.2.2 /usr/jdk_dev2

IBM® AIX 4.3.3.10 
+ fix

1.3.0 /usr/jdk_java130

SUN® Solaris 2.6 1.1.6

HP-UX 10.20 1.1.3

LINUX® 1.0 1.1.3

LINUX® 1.2 1.1.8
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Where to download the Java Runtime Environments
[17] Download Java Runtime Environments

[17] Download Java Runtime Environments

Installation procedure for other platforms

1. Install Java Virtual Machine (version 1.1.8).
2. From the Océ Remote Logic® CD-ROM, load  RemoteLogic_vX.tar  or  

RemoteLogic_vX.zip .
3. Set the environment variable  RL_VM_HOME  to point to the Java 

Products/remotelogic/UNIX  installation directory.
4. If necessary, edit the Océ Remote Logic® script or batch file.
5. Use the Océ Remote Logic® script or batch file to start the applications.

Platform Preferred version Download location

1 1.1.8 http://www.ibm.com/java

2 C.01.18.xx http://www.unix.hp.com/ja
va

3 N/A http://www.ibm.com/java
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Start the applications with Océ Remote Logic®

Introduction

Use the following 2 methods to start the applications with Océ Remote Logic®.
■ Use the programs menu of your operating system.
■ Use a command line parameter.

Use the programs menu to start the applications

1.  Select 'Océ Remote Logic'  

2. Select the 'Launcher' application.

3. Select the required application.

The application starts with your default system.

Note: You can select another system than your default system (see ‘Connect to 
the controller’ on page 69).

Use command line parameters to start the applications

Six command line parameters are available to facilitate the start of the 
applications.

■ configfile=<config_file>
Sets the configuration file to use.

■ server=server
Sets the indicated server as the server to connect to.

■ language1=lang
Specifies the first language in combination with the parameter  
country1=country .

■ country1=country
Specifies the first language in combination with the parameter  
language1=language .

■ language2=lang
Specifies the second language in combination with the parameter  
country2=country .

■ country2=country
Specifies the second language in combination with the parameter  
language2=language .
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Note: Always use a matching combination of language and country (see the 
following table).

Parameters of supported languages
[18] Parameters of supported languages

[18] Parameters of supported languages

Apply the parameters to the applications

Apply the parameters to the following applications.
■ QM.exe (Océ Queue Manager)
■ SCP.exe (Océ System Control Panel)
■ SE.exe (Océ Settings Editor)
■ AL.exe (Application launcher).

The easiest method to apply the parameters to the applications is to create a 
shortcut for an application. Then add the command line properties.

Language Language parameters Country parameters

Danish da DK

Swedish sv SV

Norwegian no NO

Finnish fi FI

Hungarian hu HU

Czech cs CZ

Polish pl PO

German de DE

Dutch nl NL

UK English en GB

US English en US

French fr FR

Italian it IT

Spanish es ES

Portuguese pt PT

Chinese simplified cn CN

Chinese traditional cn TW

Japanese ja JP
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Note: The .exe files are usually located in C:\Program Files\Remote 
Logic\Bin.

Example of a command line parameter

The example below shows how to start the controller applications with the 
configuration file 'Myconfig.cfg', connected to the 'MyTCS400' server. The 
first language is set to UK English and the second language is set to French.

C:\Program Files\Remote Logic\Bin\AL.exe
configFile=Myconfig.cfg 

server=MyTCS400 language1=en country1=GB language2=fr 
country2=FR .
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Connect to the controller

Introduction

After you start one of the Océ Remote Logic® applications, you must connect 
to the Océ Power Logic® controller of the Océ TDS450. You must connect to 
the system for every separate application.

You can do the following when you connect to the controller. 
■ Select a system from the drop-down list.
■ Add a system to the drop-down list.
■ Remove a system from the drop-down list.

When the Océ TDS450 is not available in the 'Connect to' dialogue box, you 
must add the Océ TDS450 to the list of available systems.

How to connect to a system

1. Open the application you want to run.
2. From the 'File' menu, select 'Connect to'.
3. Select the system from the drop-down list.
4. Click 'OK'.

Note: From the 'File' menu, select 'Options' to define the default system. This 
is recommended if you frequently connect to the same system.

How to add a system

1. From the 'File' menu, select 'Connect to'.
2. Click 'Edit'.

The 'Edit systems' dialogue box appears.
3. Enter the IP address or the name of the system in the 'Systems' box.
4. Click 'Add'.

The system is added to the list.
5. Click 'OK' 2 times to return to the application.
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How to remove a system

1. From the 'File' menu, select 'Connect to'.
2. Click 'Edit'.

The 'Edit systems' dialogue box appears.
3. Select the system you want to remove.
4. Click 'Remove'.

The system is removed from the list.
5. Click 'OK' 2 times to return to the application.
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Use Océ Remote Logic

Automatic logon

Introduction

The 'Automatic logon' option enables you to start an application automatically 
in the indicated user mode.

How to enable automatic logon

Automatic logon is now enabled.

Step Action

1 From the 'Edit' menu, select 'Options'.
The 'Options' window appears.

2 Select the 'Enable automatic logon' checkbox.

3 From the drop-down box, select the user mode for the 
automatic logon.

4 Enter the password that corresponds to the selected user 
mode.

5 Click 'OK'.
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Change the password

How to change the password

1. From the 'File' menu, select 'Log on'.
2. Click 'Password' in the dialogue box.
3. Open the drop-down list and select a user.
4. Enter the old password.
5. Enter the new password .
6. Enter the new password a second time to confirm.
7. Click 'OK' to save the new password.
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Log on to the controller applications

User modes

The Océ Power Logic® controller has the following user modes.
■ Key operator
■ Repro operator
■ System administrator
■ Service operator.

Chapter 1 contains more information about the types of users (see ‘The Océ 
TDS450 users’ on page 18). Chapter 12 contains more information about the 
user modes in the Océ Settings Editor (see ‘Introduction to the Océ Power 
Logic® controller: Océ Settings Editor’ on page 31). Log on to the correct user 
mode in the Océ Settings Editor to change the key operator settings or the 
system administrator settings.

Only assigned operators are allowed to use the user modes. Different 
passwords are required to access the user modes.
You do not need a password for the anonymous user mode.

Passwords

■ The default password for the system administrator is  SysAdm .
■ The default password for the key operator is  KeyOp .
■ The default password for the repro operator is  ReproOp .

When a user is logged on, the user can change the password for the current user 
mode. (see ‘Change the password’ on page 72) 

Note: The passwords are case sensitive.
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Authorisation

Only one key operator, system administrator or repro operator at a time is 
authorised to change the settings.
An error message appears when a second user tries to log on to the key operator 
mode or system administrator mode. 
There is no limitation of users authorised to view the settings.

[13] Error message when a second user tries to log on

[13] Error message when a second user tries to log on

How to log on to the controller applications

1. From the 'File' menu, select 'Log on'.

2. Select the required user name.

3. Enter the password.

4. Click 'OK'.

You are now logged on as special user. When you are not logged on, you have 
'Anonymous' user permissions. (see ‘The Océ TDS450 users’ on page 18).

The status bar at the bottom shows the user mode.

The logon is limited to one user only.

Note: You must separately log on to each application.

How to log off from the controller applications

From the 'File' menu, select 'Log off'.
You return to the anonymous user mode. Log off from the controller 
applications to prevent unauthorised use.

Note: You must separately log off from each application.
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Océ License Logic

About Océ License Logic

Introduction

The Océ applications and options are protected against unauthorised use. You 
need to activate the license to enable an application or option for use. Océ 
License Logic enables you to manage the licenses very easy.

This section describes the following.
■ The basic concept of Océ License Logic
■ How to use  Océ License Logic.
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The possibilities of Océ License Logic

Introduction

Océ License Logic has the following possibilities.

Possibilities

■ View the current active licenses
■ Get the host id of the Océ system
■ Save the active licenses
■ Perform a license activation job.

You can activate new licenses or saved licenses.
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The basic workflow of license activation

Introduction

Before you can use the possibilities of Océ License Logic, you must log on to 
Océ License Logic. The following workflow describes per step when to use 
which possibility.

The workflow

1. Select the new options you need.
Use the following possibilities of Océ License Logic to do so.
■ View the current active licenses

You can make a list of new options you need and make a list of license 
numbers. Océ needs the list of new options and the license numbers to 
create a new license file.

■ Get the host id of the Océ system.
Océ needs the host id of your Océ system to create a new license file.

2. Send the list of new options you need, the list of license numbers and the host 
id to Océ.
Océ creates and delivers one or more new license files.

3. Create a back-up of the current active licenses if necessary.
Use the following possibility of Océ License Logic to do so.
■ Save the current active licenses

4. Activate the licenses.
Use the following possibility of Océ License Logic to do so.
■ Perform a license activation job.
The license activation job guides you through the following steps.
1. Locate the license file
2. Preview the new active licenses
3. Accept the end user license agreement
4. Finish the license activation job
5. Restart the controller of the Océ system.
Note: Perform the license activation job for each license file.
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The structure of license files and licenses

Introduction

A license file contains a license per option of your Océ system. You can view 
the current active licenses with Océ License Logic. You can preview the new 
active licenses with Océ License Logic during the license activation job.

A license file contains licenses of the same license-type

A license file you receive from Océ contains only licenses of the same 
license-type. The following license types are possible.

■ Demo
■ Resale.

If you order demo and resale licenses, you receive 2 license files.
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What  you see  per situation

What you see per situation depends on the license file you use.

[19] What you see depends on the situation

[19] What you see depends on the situation

Situation What do you see

View the current active 
licenses.

You see the following.
■ All current active demo licenses
■ All current active resale licenses
■ All current other not active options.

Océ delivered one or more 
license files.

You see one of the following options.
■ A demo  license file
■ A resale license file
■ A demo  license file and a resale license 

file.

Preview the demo licenses  
during the license activation 
job if you use the license file 
with demo licences.

You see the following.
■ All current active demo licenses
■ All new active demo licenses.

Note: You can not see the current active 
resale licenses at this point.

Preview the resale licenses 
during the license activation 
job if you use the license file 
that contains the resale 
licences.

You see the following.
■ All current active resale licenses
■ All new active resale licenses.

Note: You can not see the current active 
demo licenses at this point.

Preview the demo and resale 
licenses during the license 
activation job if you use the 
saved licenses of your 
back-up file.

You see the following.
■ All demo licenses that where active at the 

time you created the back-up file
■ All resale licenses that where active at the 

time you created the back-up file

The license activation job is 
finished.

You see the following.
■ All current active demo licenses
■ All new active demo licenses
■ All current active resale licenses
■ All new resale licenses
■ All current other not active options.
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The  Océ TDS450 printer

Introduction

The printer is a 36 inch black and white LED printer with a true resolution of 
600 dpi. The Océ TDS450 printer  is default available with an automatic 1-roll 
unit and an Integrated Receiving Tray as the output delivery device. An 
automatic 2-roll unit is available as an option. Each of the rolls can contain 
different types and sizes of media. The size and type of the available media are 
indicated on the operator panel.

Illustration
[14] The Océ TDS450 printer

[14] The Océ TDS450 printer
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The main components of the Océ TDS450 printer

Nr. Component Function

1 Left cover Provide access to the toner

2 Fuser unit Provide access to the fuser section

3 Operator panel Set up the print system and the folder 
settings

4 Manual feed table Use if you need to print or copy on a cut 
sheet.

5 Drawer with media  roll Provide access to the media roll

6 Integrated Receiving 
Tray

Receive the copies and prints
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The printer operator panel

Introduction

This section describes the parts and the functions of the Océ TDS450 printer 
operator panel. Use the printer operator panel to select your print settings or 
finishing settings.

[15] The Océ TDS450 Printer operator panel

[15] The Océ TDS450 Printer operator panel

The components of the User manual operator panel.
1. The display
2. The 'previous' key
3. The 'next/select'  key
4. The 'stop' key 
5. The 'on-line' key with green LED
6. The navigation keys.

on-line stop

next/select

previous

6

5

1

2

3

4
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The display

In the on-line mode the display shows the feedback about the print job status 
and system messages.
In the off-line mode the display shows the off-line menu. (see ‘The menu 
structure of the printer’ on page 86)

On the right-hand side the display shows the menu level indicator. The menu 
level indicator presents in a graphic way the active printer menu level. The 
menu structure of the printer has a maximum of 4 printer menu levels.

The keys

The printer operator panel contains the following keys.

[20] The keys

[20] The keys

Key Function

'previous' Return to a higher menu level

'next/select' Select an option or a setting in the menu

'stop' Stop the current print job

'on-line' ■ Switch between the on-line mode (the green light 
above the key is on) and the off-line mode (the green 
light above the key is off) of the printer.

■ Activate the program mode and enter the top menu 
level

navigation ■ select another mode at the same menu level
■ display the next or the previous option from the option 

list
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The menu structure of the printer

Introduction

In the off-line mode the printer operator panel allows you to define settings.

The table below shows the menu structure of the printer. If you browse through 
the tree, the menu level indicator shows the actual menu level.
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The menu structure of the Océ TDS450 printer with setting references
[21] The menu structure of the Océ TDS450 printer

Setting reference 

'Media 
settings'

'Roll 1' / 'Roll 2' 'Width' / 
'Material'

(see ‘Define the 
media type and 
media size’ on 
page 262)

'Manual feed' 'Material' (see ‘Define the 
media type and 
media size’ on 
page 262)

'Time out' (see ‘Define the 
manual feed 
time-out at the 
printer operator 
panel’ on 
page 133)

'Cut media' (see ‘Cut the 
media’ on 
page 264)

'Print info' 'Configuration' (see ‘Print the 
configuration 
report of the Océ 
TDS450 printer’ 
on page 117)

'Menu card' (see ‘Print the 
menu card of the 
Océ TDS450 
printer’ on 
page 116)
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'Demo print' (see ‘Print the 
demo print of the 
Océ TDS450 
printer’ on 
page 118)

'Folding' 'Delivery' 'Stacker' /   
'Belt' /  'First 
Fold' 

(see ‘Define the 
folded output 
delivery’ on 
page 236)

'Input' 'Legend' 'Trailing' / 
'Leading'

(see ‘Define the 
folding legend’ on 
page 237)

'Method' 'Standard' / 
'Afnor'  / 
'Ericsson'

(see ‘Define the 
drawing method’ 
on page 238)

'Binding' 'Off' / 'On' / 
'Reinforce'

(see ‘Define the 
binding method’ 
on page 239)

'Binding edge' (see ‘Define the 
binding edge 
value’ on 
page 240)

'Package' 'Length'/ (see ‘Define the 
folded package 
length’ on 
page 241)

'Width' (see ‘Define the 
folded package 
width’ on 
page 242)

'Clean RU knife'

Setting reference 
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[21] The menu structure of the Océ TDS450 printer

Note: The menu structure is also displayed in the menu card of the Océ 
TDS450 printer that you can print. (see ‘Print the menu card of the Océ 
TDS450 printer’ on page 116)

'Configuration
'

'Language' (see ‘Define the 
display language 
of the printer’ on 
page 120)

'Paper series' (see ‘Define the 
media series of the 
Océ TDS450 
printer’ on 
page 265)

'System' 'Clear setmem' 

'Diagnostic 
mode' 

'Network sett.' 'adapter 1' / 
'adapter 2' 

'Use DHCP 
server' 

(see ‘Define the 
DHCP server’ on 
page 124)

'IP address' (see ‘Define the IP 
address’ on 
page 125)

'Subnetmask' (see ‘Define the 
subnet mask’ on 
page 126)

'Default 
gateway'

(see ‘Define the 
default gateway’ 
on page 127)

'Installation' 'start install.' 

Setting reference 
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Introduction

Introduction

The Océ TDS450 printer is default available with an automatic 1-roll unit and 
an Integrated Receiving Tray as the output delivery device. The Integrated 
Receiving Tray is advised for a low production environment and a lot of same 
size output.
It is possible to expand your standard configuration with one of the following 
finishing options. 
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Finishing options
[22] Océ TDS450 finishing options

Component Function Position of the component

Output 
Delivery 
Tray

Collects output at the rear side of 
the printer. 
This option is advised for a 
higher production environment 
with many different output sizes 
that you want to stack neatly. 
The stack capacity is 150 prints.
Note: If you install an Output 
Delivery Tray, the printer 
requires more space.

[16] Output delivery tray

[16] Output delivery tray

Compact 
Output 
Stacker

Collects output in the Integrated 
Receiving Tray, but has a 
mechanism to prevent the output 
of different sizes to collide. 
This option is also advised for a 
higher production environment 
with many different output sizes 
that you want to stack neatly. 
The stack capacity is 100 prints.
Note: If you install an Compact 
Output Tray, the printer requires 
the same space.

[17] Compact output stacker

[17] Compact output stacker

Folder Folds the output
[18] Folder

[18] Folder
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[22] Océ TDS450 finishing options

Note: You can use both a Compact Output Stacker and a folder. You can not use 
both an Output Delivery Tray and a folder.

The optional reinforcement 
unit adds reinforcement strips to 
folded output

[19] Reinforcement unit

[19] Reinforcement unit

The optional belt unit transports 
the folded output and provides 
high capacity stacking of the 
folded output

[20] Belt unit

[20] Belt unit

Component Function Position of the component
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The folder components

Introduction

The folder folds the output according to the selected folding settings. 

Attention: You can only fold paper. If you attempt to fold polyester, 
transparent or vellum media, a media jam will occur.

Illustration
[21] Océ TDS450 folder

[21] Océ TDS450 folder
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Folder components
[23] The components of the folder

[23] The components of the folder

Component Function

1 Lever

2 Stacker

3 Belt unit

4 Second fold section

5 Reinforcement unit

6 Folder transport section

7 First fold section

8 First fold delivery
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Job submission software

Job submission methods

Send print jobs to the Océ TDS450

You can send your print jobs to the Océ TDS450 in various ways. The default 
configuration of the Océ TDS450 contains printer drivers, Océ Print Exec® 
Workgroup LT and FTP

Note: You upgrade to the full version of Océ Print Exec® workgroup with a 
license key in Océ License Logic.
After you send jobs to the printer, you can manage the jobs through the Océ 
Queue Manager and the printer operator panel.

Note: The settings defined in the printer drivers or the job submission tools 
always overrule the settings defined in the Océ Settings Editor. 
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Accounting software: Océ Account Center

Introduction

An overview of Océ Account Center

Introduction

Use Océ Account Center to manage the account information of the print, copy 
and scan-to-file jobs for your Océ TDS and Océ TCS devices.

Océ Account Center consists of the following two software modules.
■ Océ Account Logic

Océ Account Logic runs on the Océ Power Logic® controller. You can 
connect to Océ Account Logic from a remote workstation through a web 
browser.
The users use Océ Account Logic to enter the account information. The user 
can enter the account information for the copy and scan-to-file jobs and for 
the print jobs. The users can enter the account information at the Océ Power 
Logic® controller and at the workstation.
The administrator can manage Océ Account Logic from the 
'Administration' screen on the application.

■ Océ Account Console.
Océ Account Console runs on a PC that functions as a server. You can 
connect to Océ Account Console from a remote workstation through a web 
browser. Access to Océ Account Console application is password protected 
and limited to authorised personnel.
The administrator uses Océ Account Console to create the 'Account 
information' dialogue. The administrator publishes the 'Account 
information' dialogue for Océ Account Logic and other applications.
The bookkeeper uses Océ Account Console to retrieve and export the log 
data. The bookkeeper uses the log data for accounting purposes.

Definition
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Illustration

Overview of the workflow

The administrator defines and distributes the 'Account information' dialogue.
The users enter the account information when the users print, copy or scan to 
file.
The bookkeeper collects the account data and converts the account data to 
invoices.
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Océ Account Logic

Introduction to Océ Account logic

Definition

Use Océ Account Logic to link account information to your job. The account 
information requirements are defined and managed by the administrator.

Purpose

Use Océ Account Logic for the following.
■ Enter the account information for the print jobs
■ Manage print jobs that do not have valid account information
■ Enter account information for the copy and scan-to-file jobs
■ Lock and unlock the scanner
■ Administer Océ Account Logic (administrators only).
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Summary of Océ Account Logic

Sections

Océ Account Logic has the following three sections.
■ The 'Copy & File' tab

Use this tab to enter account information for copy jobs and scan-to-file jobs.
■ The 'Print' tab

Use this tab to enter account information for print jobs.
■ The 'Administration' window.

Use this window to define the administrative settings for the application. 
Access to this window is password protected and limited to the application 
administrator.
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Océ Power Logic® controller setup

Introduction

Before you begin to use Océ Account logic, you must define the correct 
settings in the Océ Settings Editor on the Océ Power Logic Controller.

Before you begin

Before you can define the correct settings in the Océ Settings Editor on the Océ 
Power Logic Controller, log on as a Key Operator (KO).

Note: Refer to the on-line help on the Océ Settings Editor for information 
about the settings and the location of the settings.

Example of the Océ Settings Editor
[22] Path: KO - System - ... - ...

[22] Path: KO - System - ... - ...
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The correct settings

The path to the setting 
in the Océ Settings 
Editor

Definition Explanation

Path: KO - System - 
Enabling passwords - 
Account logging

Use the correct 
password to enable 
account logging.

Before you can use Océ 
Account Logic, enable 
account logging on  Océ 
Power Logic® 
controller.

Path: KO - System - 
Job management - 
Print jobs

Select 'Jobs in inbox'. Océ Account Logic 
requires that all jobs are 
send to the Inbox.
Note: The print jobs 
that have valid account 
information are 
automatically moved 
from the Inbox to the 
Print queue.
Enter the account 
information for the 
print jobs that do not 
have valid account 
information on the 
'Print' tab of Océ 
Account Logic.
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Path: KO - System - 
Job management - 
Rights for printing

Select 'Special user'. Océ Account Logic is a 
special user on the Océ 
Power Logic® 
controller.

Path: KO - Scanner - 
Settings - Timers - 
Panel timeout

Océ advises you to set 
the panel timeout to the 
minimum value (30 
seconds).

The scanner locks when 
the scanner panel 
timeout expires. The 
scanner locks to prevent 
users to use the scanner 
without entering 
account information. 
When you set the 
timeout to a minimum 
value, the scanner locks 
after a minimum of time 
has passed.

The path to the setting 
in the Océ Settings 
Editor

Definition Explanation
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Océ Account Console

Introduction to Océ Account Console

Definition

Océ Account Console is installed on the administrator's workstation. Access to 
Océ Account Console is password protected and limited to the administrator.

Purpose

Use Océ Account Console is intended for the following:
■ Manage, preview, and publish the account information dialogue for Océ 

Account Logic
■ Retrieve and export the log files.
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Summary of Océ Account Console

Sections

Océ Account Console has the following three sections.
■ The 'Account fields' tab

Use this tab to create, manage, preview, and publish the 'Account 
information' dialog for Océ Account Logic.

■ The 'Account data' tab
Use this tab to define the devices from where the log files are retrieved.
Use this tab to export the log files.

■ The 'Administration' window.
Use this screen to define the administrative settings for the application, and 
to change the password for Océ Account Console.
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Document management software

Océ Repro Desk

Introduction

Océ Repro Desk is a print management solution for reprographers.

Océ Repro Desk consists of two parts.

1. Océ Repro Desk Client
Océ Repro Desk Client is available in two versions. Both versions allow you 
to create, process and preview jobs, print to A4-size paper and submit drawings 
electronically.
■ Océ Repro Desk Remote Client allows you to submit jobs for printing via 

Internet, modem or FTP communication.
■ Océ Repro Desk LAN Client allows you to submit jobs for printing via 

LAN communication.

2. Océ Repro Desk Server
With the Océ Repro Desk Server software you can receive jobs from the clients 
by a modem, network, FTP or disk and you can arrange, prepare and print the 
digital files.
Océ Repro Desk Scan-to-file is an optional software application , used to scan 
paper originals and store them as digital files.

Note: For this application a separate Océ Repro Desk user manual is 
available.
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Océ Engineering Exec®

Introduction

Océ Engineering Exec®is an integrated suite of applications to distribute, print 
and archive documents across the enterprise.

Océ Engineering Exec® products

Océ Engineering Exec® includes the following products.
■ Océ Doc Exec® Pro

An application to organise, archive and share documents.
■ Océ Print Exec® Pro

An application to provide controlled access to the documents, printing and 
distribution resources.

■ Océ Print Exec® Workgroup.
An application to define and control the print jobs via your  web browser.

■ An application to define and control the print jobs.

Note: Visit Océ on the internet at www.oce.com for the latest information.
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Turn the Océ TDS450 on and off

Turn the Océ TDS450 scanner on and off 

Introduction

When you turn on the Océ TDS450 scanner, the Océ TDS450 scanner needs 
some preparation time before it can handle jobs. The preparation time for 
scan-to-file and copy jobs is less than twenty seconds.

Illustration
[23] The on / off switch at the right of the Océ TDS450 scanner

[23] The on / off switch at the right of the Océ TDS450 scanner

How to turn on the Océ TDS450 scanner

1. Set the on / off switch at the right to position 1.

Result

The green light at the operator panel illuminates.
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How to turn off the Océ TDS450 scanner

1. Set the on / off switch at the right to position 0.

Result

The green light at the operator panel is turned off.
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Turn on and shut down the Océ Power Logic® controller

Introduction

When you turn on the Océ Power Logic®controller, the Océ Power 
Logic®controller needs some preparation time before it can handle jobs. The 
preparation time for print jobs is two and a half minutes, for scan-to-file jobs 
and copy jobs three minutes.

How to turn on the Océ Power Logic® controller

1. Press the on / off key of the Océ Power® Logic controller. 
After the initial system test of the controller the applications, Océ Queue 
Manager, Océ System Control Panel, Océ Settings Editor and Océ Scan 
Manager are automatically started. The Océ TDS450  is ready.
Note: The Océ Queue Manager and the Océ System Control Panel applications 
are shown on the screen. The Océ Settings Editor is minimised.

Result

The Océ Power Logic® controller starts up and displays the Océ Queue 
Manager and the Océ System Control Panel. The Océ Settings Editor is 
minimised.

How to shut down the Océ Power Logic® controller

1. Open the Océ System Control Panel.
2. Click 'System' to open the system menu.
3. Click 'Shutdown'

A dialogue box displays.
4. Click 'Yes' to confirm.
5. Turn off the display.

Result

The green light of the on / off key is  turned off. The Océ Power Logic® 
controller is turned  off.
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Turn the Océ TDS450 printer on and off 

Introduction

When you turn on the Océ TDS450 printer, the Océ TDS450 printer needs 
some preparation time before it can handle jobs. The preparation time for print 
and copy jobs is less than one minute.

Illustration
[24] The on / off switch at the back of the Océ TDS450 printer

[24] The on / off switch at the back of the Océ TDS450 printer

How to turn on the Océ TDS450 printer

1. Set the on / off switch at the back of the  Océ TDS450 printer to position 1.

Result

The green light of the on / off switch illuminates and the operator panel 
displays the message 'Ready'.

How to turn off the Océ TDS450 printer

1. Set the on / off switch at the back of the Océ TDS450 printer to position 0.

Result

The green light of the on / off switch is turned off and the operator panel 
displays no message.
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Print the menu card of the Océ TDS450 printer

Introduction

You can print the following information with the Océ TDS450 printer
■ The menu card to get an overview of the menu structure.
■ The configuration report to get an overview of the configuration and the 

system settings.
■ A demo print to check the controller and printer.

Before you begin

Use the   key, the  key and the 'previous' key to navigate. Use the  
'next/select' key to select a menu or a value.

How to print the menu card of the Océ TDS450 printer

1. Press the  'on-line' key to turn the printer off-line.
2. Navigate to 'Print info' and select this menu.
3. Navigate to 'Menu card' and select this value.
4. Press the 'on-line' key to turn the printer on-line.

Result

The Océ TDS450 printer prints the menu card.
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Print the configuration report of the Océ TDS450 printer

Introduction

You can print the following information with the Océ TDS450 printer
■ The menu card to get an overview of the menu structure.
■ The configuration report to get an overview of the configuration and the 

system settings.
■ A demo print to check the controller and printer.

Before you begin

Use the   key, the  key and the 'previous' key to navigate. Use the  
'next/select' key to select a menu or a value.

How to print the configuration report of the Océ TDS450 printer

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Print info' and select this menu.
3. Navigate to 'Configuration' and select this value.
4. Press the 'on-line' key to turn the printer on-line.

Result

The Océ TDS450 printer prints the configuration report.
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Print the demo print of the Océ TDS450 printer

Introduction

You can print the following information with the Océ TDS450 printer
■ The menu card to get an overview of the menu structure.
■ The configuration report to get an overview of the configuration and the 

system settings.
■ A demo print to check the controller and printer.

Before you begin

Use the   key, the  key and the 'previous' key to navigate. Use the  
'next/select' key to select a menu or a value.

How to print the demo print of the Océ TDS450 printer

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Print info' and select this menu.
3. Navigate to 'Demo print' and select this value.
4. Press the 'on-line' key to turn the printer on-line.

Result

The Océ TDS450 printer prints the demo print.
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Define the display languages

Define the display languages of the scanner and the controller

Introduction

You can toggle between two languages at the following system components.
■ The applications of the Océ Power Logic®controller.
■ The operator panel of the Océ TDS450 scanner.

The operator panel of the Océ TDS450 printer provides one language only.

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following 
steps to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key operator' and enter the password.

How to define the display languages

1. Click 'View' and select 'KO settings'.
2. Navigate to KO - System - Regional settings - Display languages - First 

language.
3. Define the default language
4. Navigate to KO - System - Regional settings - Display languages - Second 

language
5. Define the alternative language.
6. Click 'Apply' to confirm the settings.
7. Click 'File' and select 'Log off' to prevent unauthorised use.

Result

You can use the defined settings at the scanner operator panel and the 
applications of the Océ Power Logic® controller.
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Define the display language of the printer

Introduction

You can toggle between two languages at the following system components.
■ The applications of the Océ Power Logic®controller.
■ The operator panel of the Océ TDS450 scanner.

The operator panel of the Océ TDS450 printer provides one language only.

Before you begin

Use the   key, the  key and the 'previous' key to navigate. Use the  
'next/select' key to select a menu or a value.

How to define the display language

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Configuration'  and select this menu.
3. Navigate to 'Language' and select this menu.
4. Navigate to the required language and select this value.
5. Press the 'on-line' key to turn the printer on-line.
6. Turn the printer off and on.

Result

The selected language appears on the printer operator panel.
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Define the network settings

Define the network settings with the Océ Settings Editor

Introduction

You can define the network settings of the network adapter at the following 
locations.
■ The Océ Settings Editor
■ The printer operator panel of the Océ TDS450 printer.

Before you begin

Open the Océ Settings Editor and log on as System Administrator. Take the 
following steps to log on.

1. Click 'File' and select 'Log on'.
2. Select 'System administrator' and enter the password.

How to define the network settings with the Océ Settings Editor

1. Click 'View' and select 'SA settings'.
2. Navigate to SA - System - Connectivity - TCP/IP
3. Define the required settings.
4. Click 'Apply'.
5. Click 'File' and select 'Log off' to prevent unauthorised use.

Result

The Océ TDS450 is connected to the local network.
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Define the network settings at the printer operator panel

About the network settings

Introduction

You can define the network settings of the network adapter at the following 
locations.
■ The Océ Settings Editor
■ The printer operator panel of the Océ TDS450 printer.

Access the network settings

Before you can set the network settings, you need to enter the system menu.

Available network settings

You can use the following settings to define the network settings.
■ Dynamic Host Configuration Protocol (DHCP) server.

The DHCP protocol assigns Internet Protocol (IP) addresses in a network 
automatically. If you do not use the DHCP protocol, enter the IP address 
manually.

■ Internet Protocol (IP) address.
■ Subnetmask.
■ Gateway.
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Access the system settings in the system menu

Introduction

Use the following procedure to access  the system menu.

Before you begin

Use the   key, the  key and the 'previous' key to navigate. Use the  
'next/select' key to select a menu or a value.

How to access the system settings

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'System'  and select this menu.

The string 'Enter password' appears. To enter this 'password' you must press the 
following keys in the right sequence.

3. Press the  key.
4. Press the 'stop' key.
5. Press the  key.
6. Press the 'stop' key.
7. Press the  key.

Result

You have access to the system settings.
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Define the DHCP server

Introduction

Use the following procedure to define the DHCP server.

Before you begin

Use the   key, the  key and the 'previous' key to navigate. Use the  
'next/select' key to select a menu or a value.

How to define the DHCP server

1. Make sure you have access to the system settings.
(see ‘Access the system settings in the system menu’ on page 123)

2. Navigate to 'Network settings' and select this menu.
3. Navigate to 'Adapter 2' and select this menu.
4. Navigate to 'Yes' and select this value.
5. Navigate to the next network setting or press the 'on-line' key to put the printer 

on-line again.

Result

The DHCP setting is defined.
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Define the IP address

Introduction

Use the following procedure to define the IP address.

Note: If the DHCP server is defined, you can skip this procedure.

Before you begin

Use the   key, the  key and the 'previous' key to navigate. Use the  
'next/select' key to select a menu or a value.

How to define the IP address

1. Make sure you have access to the system settings.
(see ‘Access the system settings in the system menu’ on page 123)

2. Navigate to 'Network settings' and select this menu.
3. Navigate to 'Adapter 2' and select this menu.
4. Navigate to 'IP address' and select this menu.

The first three digits flash.
5. Enter the first three numbers with the  key and the  key

and press the 'next/select' key  to confirm the value.
The next three digits flash.

6. Enter the next three numbers with the  key and the  key
and press the 'next/select' key to confirm the value.
The next three digits flash.

7. Enter the next three numbers with the  key and the  key
and press the 'next/select' key to confirm the value.
The next three digits flash.

8. Enter the next three numbers with the  key and the  key
and press the 'next/select' key to confirm the value.
The next three digits flash.

9. Navigate to the next network setting or press the 'on-line' key to turn the printer 
on-line again.

Result

The IP address is defined.
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Define the subnet mask

Introduction

Use the following procedure to define the subnet mask.

Note: If the DHCP server is defined, you can skip this procedure.

Before you begin

Use the   key, the  key and the 'previous' key to navigate. Use the  
'next/select' key to select a menu or a value.

How to define the subnet mask

1. Make sure you have access to the system settings.
(see ‘Access the system settings in the system menu’ on page 123)

2. Navigate to 'Network settings' and select this menu.
3. Navigate to 'Adapter 2' and select this menu.
4. Navigate to 'Subnet mask' and select this menu.

The first three digits flash.
5. Enter the first three numbers with the  key and the  key

and press the 'next/select' key to confirm the value.
The next three digits flash.

6. Enter the next three numbers with the  key and the  key
and press the 'next/select' key to confirm the value.
The next three digits flash.

7. Enter the next three numbers with the  key and the  key
and press the 'next/select' key to confirm the value.
The next three digits flash.

8. Enter the next three numbers with the  key and the  key
and press the 'next/select' key to confirm the value.
The next three digits flash.

9. Navigate to the next network setting or press the 'on-line' key to turn the printer 
on-line again.

Result

The subnet mask is defined.
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Define the default gateway

Introduction

Use the following procedure to define the default gateway.

Note: If the DHCP server is defined, you can skip this procedure.

Before you begin

Use the   key, the  key and the 'previous' key to navigate. Use the  
'next/select' key to select a menu or a value.

How to define the default gateway

1. Make sure you have access to the system settings.
(see ‘Access the system settings in the system menu’ on page 123)

2. Navigate to 'Network settings' and select this menu.
3. Navigate to 'Adapter 2' and select this menu.
4. Navigate to 'Default gateway' and select this menu.

The first three digits flash.
5. Enter the first three numbers with the  key and the  key

and press the 'next/select' key to confirm the value.
The next three digits flash.

6. Enter the next three numbers with the  key and the  key
and press the 'next/select' key to confirm the value.
The next three digits flash.

7. Enter the next three numbers with the  key and the  key
and press the 'next/select' key to confirm the value.
The next three digits flash.

8. Enter the next three numbers with the  key and the  key
and press the 'next/select' key to confirm the value.
The next three digits flash.

9. Navigate to the next network setting or press the 'on-line' key to turn the printer 
on-line again.

Result

The default gateway is defined.
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Define the time-outs

About the time-out settings

Introduction

You can use time-out settings to define the behaviour of the Océ TDS450 if the 
Océ TDS450 remains unused for a time.

Time-out settings of the Océ TDS450 scanner

You can define the following time-out settings for the Océ TDS450 scanner.
■ The set time-out of an opened set in a copy job.

When the scanner remains unused for a time after a set was opened, the set 
closes automatically.

■ The panel  time-out of the scanner operator panel.
When the scanner operator panel remains unused for a time, the scanner 
operator panel returns to the home screen automatically. The Océ TDS450 
scanner is ready for the next user.

■ The sleep mode time-out of the scanner.
When the Océ TDS450 scanner remains unused for a time, the Océ TDS450 
scanner enters the sleep mode automatically and saves energy. When the 
Océ TDS450 scanner enters the sleep mode, the job settings are set to 
default.

Note: The time that the Océ TDS450 scanner enters the sleep mode depends on 
the values of the above settings and the status of the Océ TDS450 scanner.

Time-out settings of the Océ TDS450 printer

You can define the following time out settings for the Océ TDS450 printer.
■ The sleep mode time-out of the printer.

When the  Océ TDS450 printer remains unused for a time, the Océ TDS450 
printer enters the sleep mode automatically and saves energy.

Note: There is no sleep mode time-out for the Océ Power Logic®controller.
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Behaviour of the unused Océ TDS450 scanner and time-out 
settings

Introduction

The automatic behaviour of the scanner when the scanner is unused for a while 
depends on two items, the status of the scanner and the values of the time-out 
settings. You are advised to define the time-out settings in the following order.
■ Define the set time-out to the lowest value according to the sleep mode 

time-out and the  scanner operator panel time-out setting.
■ Define the scanner operator panel time-out to the middle value according to 

the sleep mode time-out and the set time-out setting.
■ Define the sleep mode time-out as the highest value according to the set 

time-out and scanner operator panel time-out  setting.

Automatic behaviour of the unused Océ TDS450 scanner

■ The scanner operator panel was used for a copy or scan-to-file job.
The scanner operator panel returns to the home screen when the scanner 
operator panel time-out expires. The settings are set to default. The scanner 
enters the sleep mode when the sleep mode timer expires.

■ The scanner operator panel was used to copy a set.
The set will close when the set time-out expires. The scanner operator panel 
returns to the home screen  when the scanner operator panel time-out 
expires. The settings are set to default. The scanner enters the sleep mode 
when the sleep mode timer expires.
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Define the sleep mode time-out of the Océ TDS450 scanner

Introduction

When the time-out of the Océ TDS450 scanner expires, the Océ TDS450 
scanner enters the sleep mode to save energy. Use the Océ Settings Editor to  
set the sleep mode time-out of the Océ TDS450 scanner.

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following 
steps to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key operator' and enter the password.

How to define the sleep mode time-out of the system

1. Click 'View' and select 'SA settings'.
2. Navigate to Path: KO - System - Timers - Sleep mode timer scanner.
3. Define the required settings.
4. Click 'Apply'.
5. Click 'File' and select 'Log off' to prevent unauthorised use.

Result

The sleep mode time-out of the Océ TDS450 scanner is defined.
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Define the panel time-out of the scanner operator panel

Introduction

When the scanner operator panel remains unused for a time, the scanner 
operator panel returns to the home screen automatically. The Océ TDS450 
scanner is ready for the next user. Use the Océ Settings Editor to define the 
panel time-out.

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following 
steps to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key operator' and enter the password.

How to define the panel time-out of the scanner operator panel

1. Click 'View' and select 'KO settings'.
2. Navigate to KO - Scanner - Timers - Panel time-out.
3. Define the required settings.
4. Click 'Apply'.
5. Click 'File' and select 'Log off' to prevent unauthorised use.

Result

The panel time-out of the scanner operator panel is defined.
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Define the set time-out of a copy job

Introduction

When the scanner operator panel remains unused for a time after a set was 
opened, the set closes automatically. Use the Océ Settings Editor to define the 
panel time-out.

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following 
steps to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key operator' and enter the password.

How to define the set time-out of a copy job

1. Click 'View' and select 'KO settings'.
2. Navigate to KO - Scanner - Timers - Set time-out.
3. Define the required settings.
4. Click 'Apply'.
5. Click 'File' and select 'Log off' to prevent unauthorised use.

Result

The set time-out of a copy job is defined.
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Define the manual feed time-out at the printer operator panel

Introduction

You can define the time-out period for the manual feed function. The factory 
default value is 1 minute. This value indicates that the printer will inform you 
during 1 minute after you send the print job, to feed the media into the printer. 
After this time-out period expires, the printer prints the next job (either the 
print job that is in the queue, or the next print job that arrives if the queue is 
empty).

Before you begin

Use the   key, the  key and the 'previous' key to navigate. Use the  
'next/select' key to select a menu or a value.

How to define the manual feed time out

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Media settings' and select this menu.
3. Navigate to 'Manual feed' and select this menu.
4. Navigate to 'Time out' and select this menu.
5. Navigate to the required time out and select this value.
6. Press the 'on-line' key to turn the printer on-line.
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Introduction

Introduction

The Océ Power Logic controller has two important, main roles.
■ Set up the Océ TDS450 to integrate into your environment and create the 

most productive workflow.
■ Control your workflow for the print, copy and scan-to-file jobs.

Set up your workflow  with the Océ Settings Editor

The Océ TDS450 offers a lot of settings to optimize your workflow. Use the 
Océ Settings Editor to define the most used settings for your jobs. Open the 
Océ Settings Editor to get a complete overview of the available settings. Refer 
to the on-line help of the Océ Settings Editor for an explanation of each setting.

Control your workflow

The  Océ TDS450 offers the following applications to control your workflow.

■ Océ System Control Panel
■ Océ Queue Manager
■ Océ Scan Manager
■ Océ License Logic

See the on-line help files of these applications for a complete overview of the 
application.
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Set up your workflow with the Océ 
Settings Editor

Define the job templates

Introduction

Job templates enable you to easily perform copy jobs and scan-to-file jobs that 
you do very often. Job templates appear on the scanner operator panel when 
you select 'Copy' or 'Scan-to-file'.
A job template defines the following.

■ The top 5 settings.
You can select 5 settings that you want to see immediately when you open 
the job template at the scanner operator panel.  The top 5 settings are the 
settings that you need to change frequently if you use this job template. You 
can see the remaining settings when you scroll downwards.

■ The default values for  all available settings.
You can define a default value per setting. Define a value that you use very 
often.

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following 
steps to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key operator' and enter the password.
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How to define a job template

1. Click 'View' and select 'KO settings'.
2. Navigate to KO - Jobs - Copy - Copy job templates - Job templates to define 

the copy job templates.
Navigate to KO - Jobs - Scan to file - Scan to file job templates - Job 
templates to define the scan-to-file job templates.

3. Define the job template name and the job template description.
4. Select the top 5 settings that you want to see on the scanner operator panel 

when you open the job  template.
5. Define the number of prints / sets.
6. Select a default value for all the settings that you want to pre-define for your 

job template. 
7. Click 'Apply' to confirm the settings.
8. Click 'File' and select 'Log off' to prevent unauthorised use.
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Define the automatic original feed setting

Introduction

This setting provides an easy method to feed a set of originals, because you 
only need to press the start key once. If you use this setting you can also define 
the original feed time-out.

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following 
steps to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key operator' and enter the password.

How to define the auto original feed settings

1. Click 'View' and select 'KO settings'.
2. Navigate to 'KO - Scanner - Original handling - Auto original feed' 
3. Select 'On'
4. Define the original feed time-out if necessary.
5. Click 'Apply' to confirm the settings.
6. Click 'File' and select 'Log off' to prevent unauthorised use.

Note: You can also define the auto original feed setting at the scanner operator 
panel. Select 'System' - 'Auto feed' - 'On'.

Result

Feed a set of originals in a more productive way. 
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Define the original release mode

Introduction

Use the original release mode setting to define if the scanner must hold or 
release the original after the scan procedure.

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following 
steps to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key operator' and enter the password.

How to define the original release mode

1. Click 'View' and select 'KO settings'.
2. Navigate to KO - Scanner - Original handling - Original release mode.
3. Select the required value.

You can select one of the following modes.
■ Hold the original at the front.
■ Release the original at the front.
■ Hold the original at the back.
■ Release the original at the back.

4. Click 'Apply' to confirm the settings.
5. Click 'File' and select 'Log off' to prevent unauthorised use.

Note: You can also define the original release mode at the scanner operator 
panel. Select 'System' - 'Original release mode' - 'Release' / 'Hold'.

Result

The original release mode is defined.
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Create  the stamps and their default settings

Introduction

A stamp is a pre-defined text you can set on every copy. The stamp function is 
an option. Use Océ License logic to enable this option. Use the Océ Settings 
Editor to define a maximum of 10 stamps and their default values.

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following 
steps to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key operator' and enter the password.

How to create the stamps

1. Click 'View' and select 'KO settings'.
2. Navigate to KO - Printer - Stamps.
3. Define the name.
4. Define the text.

■ Enter '%DATE' if you need the date that the copy was made on a copy.
■ Enter '%TIME' if you need the time that the copy was made on a copy.

5. Define the font.
6. Click 'Apply' to confirm the settings.
7. Click 'File' and select 'Log off' to prevent unauthorised use.

How to define the default values of the stamp

1. Click 'View' and select 'KO settings'.
2. Navigate to KO - Jobs - Copy - Stamp - Copy stamp.
3. Define the required values.
4. Click 'Apply' to confirm the settings.
5. Click 'File' and select 'Log off' to prevent unauthorised use.

Result

You can apply the defined stamps to a copy directly from the scanner operator 
panel.
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Define the media series

Introduction

Use this setting to define the default media range.

When you select a new media size on the operator panel of the printer, only the 
sizes in the defined paper series are available.
When 'Auto format' is enabled, the 'Paper series' setting selects which sizes are 
used (only those available in the paper series).

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following 
steps to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key operator' and enter the password.

How to define the media series

1. Click 'View' and select 'KO settings'.
2. Navigate to KO - System - Media - Paper series.
3. Define the required value.

4. Click 'Apply' to confirm the settings.
5. Click 'File' and select 'Log off' to prevent unauthorised use.

Setting Group Values

Paper series ■ 'DIN'
■ 'DIN carto'
■ 'ANSI small'
■ 'ANSI mixed'

■ A4, A3, A2, A1, A0, E+, 
B1_707, B2_707

■ A4, A3, A2, A1, A0, E+, 
B1_700, B2_700

■ A, B, C, D, D+ E, E+, 30 inch
■ A, A+,  B, B+, C, C+  D,  D+ 

E, E+, 30 inch
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Control your print and copy workflow  
with the Océ Queue Manager

User operations in the Océ Queue Manager

Introduction

The Océ Queue Manager allows you to do the following.
■ Print a job from the inbox queue or the history queue
■ Cancel jobs

This action deletes jobs from the print queue.
■ Place jobs on hold

This action places print jobs on hold. When you place jobs on hold other 
jobs take priority.

■ Restart jobs on hold.
This action resumes jobs that were previous placed on hold.

■ Change the order
This action changes the order of the jobs in the printer queue.

The Océ Queue Manager displays the jobs in the sequence that the jobs are 
received. By default the copy jobs have priority over the print jobs.

How to print jobs from the inbox queue or the history queue

1. Select the jobs in the history queue or the inbox queue.
Print jobs are sent to the inbox queue when the setting "KO - System - Job 
management - Print jobs" is set to 'Inbox' or when you have enabled 'Send to 
inbox' in the printer driver.
After you print a job from the print queue, the job moves to the history queue.

2. From the 'Job' menu select 'Print', click the 'Print' button on the toolbar or 
rigth-click and select 'Print'.

3. The job moves to the print queue.
You can select more than one job with the mouse and the shift or control key.
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How to print a number of copies of a job from the history queue

1. Log on as a key operator or as a system administrator.
2. Select the job in the history queue.
3. Open the 'Job properties' dialogue box.

Use one of the following methods to open the 'Job properties' dialogue box.
■ From the 'Job' menu, select 'Properties' or, 
■ Click the 'Properties' button on the toolbar or, 
■ Right-click the job and select 'Properties'.

4. Select the 'Settings' tab in the 'Job properties' dialogue box.
5. Change the number of sets in the 'Sets' field.
6. Print the job as described in the paragraph above.

The system prints the indicated number of sets.

How to cancel jobs from the Océ Queue Manager

Attention: You can never undo this action. The cancelled jobs are not saved 
in the history queue.

1. Select the jobs in the print queue, the history queue, or the inbox queue.
2. From the 'Job' menu, select 'Delete', or click the 'Delete' button on the toolbar.

A cross icon indicates the deleted job.
The system does not print the cancelled job.
You can select more than one job with the mouse and the shift or control key.
Note: An anonymous user cannot cancel a job from a remote system.

How to cancel active jobs from the Océ Queue Manager

Attention: You can never undo this action.

1. Select the active job in the print queue.
2. From the 'Job' menu, select 'Delete', or click the 'Delete' button on the toolbar.

The printer stops the printing immediately.
If the controller was still processing part of the job, the controller flushes the 
job.
Note: An anonymous user cannot cancel a job from a remote system.
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How to place jobs on hold in the Océ Queue Manager

1. Select the jobs in the print queue.
2. From the 'Job' menu, select 'Hold', or click the 'Hold' button on the toolbar.

A job that is placed on hold keeps its position in the print queue. The job will 
not print until the job is resumed. While a job is on hold, other jobs are printed. 
The jobs that were in the queue behind the job on hold are also printed.
You can select more than one job with the mouse and the shift or control key.
Note: The active print job cannot be placed on hold in the Océ Queue Manager.

How to restart jobs in the Océ Queue Manager

1. Click the job that was placed on hold.
2. From the 'Job' menu, select 'Resume', or click the 'Resume' button on the 

toolbar.
The job restarts.
You can select more than one job with the mouse and the shift or control key.

How to give priority to jobs in the Océ Queue Manager

1. Select the jobs in the print queue.
2. From the 'Job' menu, select 'Move to top', or click the 'Move to top' button.

You can select more than one job with the mouse and the shift or control key.
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Control your scan workflow with the Océ 
Scan Manager

Create destinations

Introduction

You can scan to file to the following types of destination.
■ Local

The local destinations are temporary and can only contain a small number 
of scanned files. Use the SA - System - Set memory reservation setting in 
the Océ Settings Editor to define the available space on the controller for 
scanned files.

■ A network destination with SMB
■ An internet destination with FTP.

You can create a maximum number of 10 destinations.

Note: You can only enter names in Japanese for remote destinations in SMB.

Create a local destination

1. Select 'Destinations' in the tree structure.
2. From the 'File' menu, select 'New'.

You can also click the 'New' button on the toolbar.
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The 'Destination properties' dialogue box opens.
[25] The Destination properties dialogue box

[25] The Destination properties dialogue box

3. Enter a name for the destination in the 'Name' text box.
This name will appear on the scanner panel.

4. From the 'Type' drop-down list box, select 'On the controller'.
5. Enter a path of the target folder in the 'Path' text box. 

You can also click the 'Browse' button to select the path.
6. Click 'OK' to accept the destination properties.

Create a network destination with SMB

1. Create a shared folder on a workstation. For example c:\Scan.
2. From the 'File' menu on the Océ Scan Manager, select 'New'.

You can also click the 'New' button on the toolbar.
The 'Destination properties' dialogue box opens.

3. From the 'Type' drop-down list box, select 'SMB'.
4. Enter the system name of the workstation where you created the shared folder 

in the 'System' text box.
Note: Find the system name of the workstation on the control panel of the 
workstation (Control panel - Network - Identification - System name)
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5. Enter a path of the target folder in the 'Path' text box.
The path name is the name of the shared folder on your workstation.For 
Windows NT® , Windows® 2000 and XP, use the DOS name of the shared 
folder.For Windows 95/98® use the folder name. This is case sensitive.
You can also select a shared folder from the drop-down list.

6. If you defined a user name and a password for the shared folder on the 
workstation, then enter the user name and the password in the required fields.
Note: Make sure the user has write-access privileges on the destination.

7. Define the required file naming properties.
8. Click 'OK'.

Océ Scan Manager connects to the new SMB destination. Océ Scan Manager 
then shows the contents of the new SMB destination.

Create an internet destination with FTP

1. Create a home directory and a subdirectory on a workstation. For example 
c:Ftp/Scan

2. Enable FTP on the workstation.
3. From the 'File' menu on the Océ Scan Manager, select 'New'.

You can also click the 'New' button on the toolbar.
The 'Destination properties' dialogue box opens.

4. From the 'Type' drop-down list box, select 'FTP'.
5. Enter the system name of the workstation where you created the shared folder 

in the 'System' text box.
Note: Find the system name of the workstation on the control panel of the 
workstation (Control panel - Network - Identification - System name)

6. Enter a path of the target folder in the 'Path' text box.
The path name is the name of the destination folder on the workstation.

7. A user name and password is defined on the FTP server that runs on the 
workstation to access to the directory on the workstation through FTP. Enter 
this user name and this password in the required fields on the Destination 
Properties dialogue box of the Océ Scan Manager.
Note: Make sure the user has write-access privileges on the destination.

8. Define the required file naming properties.
9. Click 'OK'.

Océ Scan Manager connects to the new FTP destination. Océ Scan Manager 
then shows the contents of the new FTP destination.



150 User manual

Manage destinations

Introduction

You can do the following to manage the destinations.
■ Lock a destination.
■ Unlock a destination
■ Delete a destination
■ Change the destination properties.

Purpose

When you lock a destination, an anonymous user cannot change the 
destination properties.

Lock or unlock a destination

1. Select a destination.
2. From the 'File' menu, select 'Properties'.

You can also click the 'Properties' button on the toolbar.
3. Check the 'Locked' check box.

Uncheck the 'Locked' check box to unlock the destination.
4. Click 'OK' to accept the destination properties

Delete a destination

1. Log on to the key operator mode or the repro operator mode.
2. Select a destination.
3. From the 'File' menu, select 'Delete'.

You can also click the 'Delete' button on the toolbar.
The selected destination is deleted.

Note: You cannot delete the last destination.
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Change the destination properties

1. Select a destination.
2. From the 'File' menu, select 'Properties'.

You can also click the 'Properties' button on the toolbar.
3. Change the destination properties like described in the 'Create destinations' 

section. (see ‘Create destinations’ on page 147) 
Note: When the destination is locked, anonymous users cannot change the 
destination properties.
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Define a file name

When to do

When you scan, the scanner operator panel shows the file name. 
Before a new scan-to-file job, enter a new file name or replace the file name 
with ###.
When the file name is not changed, the new scan-to-file job writes over the 
previous scan-to-file job.

Define a file name

1. Select a destination.
2. From the 'File' menu, select 'Properties'.

You can also click the 'Properties' button on the toolbar.
3. Enter a name in the 'Base name' text box.

The 'Base name' can contain "###" for automatic file naming. An ascending 
number replaces the "###". There are no limits to the number of dots in the 
base name.

4. Select the check box 'Add correct file extension' to define a file extension. Use 
the setting KO - System - Scan to file - File extension ... in the Océ Settings 
Editor to define a file extension.

5. Click 'Apply' or press 'Enter' to accept the settings.
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Manage the scanned files

Introduction

The right-hand pane of the destination area displays information about the 
scanned files.

You can do the following to manage the scanned files.
■ View a scanned file'Auto view'

When  is enabled, Océ View Station LT starts automatically to display the 
scanned file when the scan to file is complete.

■ Print a scanned file
■ Delete a scanned file
■ View the properties of a scanned file.

View a scanned file

1. Select a file.
2. From the 'File' menu, select 'View'.

You can also click the 'View' button on the toolbar.
[26] The View button on the toolbar

[26] The View button on the toolbar

Océ View Station LT starts and displays the file

Enable Auto view

1. From the 'System' menu, select 'Auto view'.
A check mark in the menu in front of 'Auto view' indicates that 'Auto view' is 
enabled. 

Print a scanned file

1. Select a file.
2. From the 'File' menu, select 'Print'.

You can also click the 'Print' button on the toolbar.
[27] The Print button on the toolbar

[27] The Print button on the toolbar

The system prints the selected file with the default settings defined in the Océ 
Settings Editor.
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Delete a scanned file

1. Log on to the key operator mode or the repro operator mode.
2. Select a file.
3. From the 'File' menu, select 'Delete'.

You can also click the 'Delete' button on the toolbar.
[28] The Delete button on the toolbar

[28] The Delete button on the toolbar

The system deletes the selected file.

Clear the temporary store

1. From 'System' menu, select 'Clear temporary store' or, 
2. Use the settings KO - System - Disk cleanup - ... - ... in the Océ Settings Editor 

to clear the temporary store automatically.

View the properties of a scanned file

1. Select a file.
2. From the 'File' menu, select 'Properties'.

You can also click the 'Properties' button on the toolbar.
[29] The Properties button on the toolbar

[29] The Properties button on the toolbar
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3. The 'Scanfile properties' window appears.
[30] The Scanfile properties window

[30] The Scanfile properties window

4. Click 'OK' to close the 'Scanfile properties' window.
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Introduction to Océ View Station LT

Definition

Océ View Station LT is a viewer included in Océ Scan Manager. Océ View 
Station LT displays the scanned files.

Auto view

When 'Auto view' is enabled, Océ View Station LT starts automatically to 
display the scanned file when the scan to file is complete. You can also start 
Océ View Station LT manually. View a scanned file 
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Overview of Océ View Station LT

Introduction

Océ View Station LT has the following fields.
■ The menu bar
■ The view ribbon
■ The view area.
[31] Océ View Station LT

[31] Océ View Station LT
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The menu bar

■ The menu bar has the following menu's.
■ 'File'  
■ 'View'  
■ 'Preference'
■ 'Help'.
[24] The File menu

[24] The File menu

[25] The View menu

Item Function

‘Close' Close the active document.

'Properties'  Open the properties dialogue box of the document. The 
properties dialogue box enables you to change some 
properties of the document.

Item Function

'Fit'  Scale the image to fill the window.

'1:1' Show the image at a 1:1 scale factor.

'Magnify' Zoom into the page.

'Reduce' Zoom out of the page.

'Refresh'  Refresh the view of all the windows that show the active 
document.

'Invert' Reverse the black and white parts of the image.

'Mirror' Mirror the image.

'Rotate 90 CCW' Rotate the image 90 degrees counter-clockwise (to the 
left).

'Rotate 90 CW'  Rotate the image 90 degrees counter-clockwise (to the 
right).

'Rotate 180' Rotate the image 180 degrees.

'Sample' When active, 'Sample' shows only a sample of bilevel 
raster pixels.

'Negate'  Reverse the showed raster image pixels. Change the 
dominant raster image pixels for scaling.
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[25] The View menu

[26] The Preference menu

[26] The Preference menu

[27] the Help menu

[27] the Help menu

'Scale to grey' When active, 'Scale to grey'   shows 
the active bilevel raster image as a greyscale image.

'Monochrome''M
onochrome'

Show an image or screen with only background and 
foreground colours, like black-and-white or bilevel.

Item Function

'View ribbon'  Show the view ribbon. The view ribbon provides easy 
access to some 'File', 'View', and Preference menu items. 
See the 'View ribbon' section below.

'Status bar'  Shows the status bar at the bottom of the Océ View 
Station LT window. The Status Bar shows the pointer 
co-ordinates and a status line.

'Reference'  Show the 'Reference' window. The 'Reference' window is 
a small, normally floating window. The 'Reference' 
window shows the complete current page in miniature. 
The crossed box in the 'Reference' window indicates the 
part of the page showed in the document window. Move 
or change the size of the crossed box to change the area 
of the page showed.

 'Detail'  Shows the 'Detail' window.

'Measurement'  Enables you to measure the lines and the areas on the 
image.

Item Function

'About'  Show information about Océ View Station LT.

Item Function
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The view ribbon
[28] The View ribbon

[28] The View ribbon

Button Function

Reverse the black and white parts of the image.

Scale the image to fill the window.

Show the image at a 1:1 scale factor.

Zoom into the page.

Zoom out of the page.

Mirror the image.

Rotate the image 90 degrees counter-clockwise (to the 
left).

Rotate the image 90 degrees counter-clockwise (to the 
right).

Rotate the image 180 degrees.

Enables you to measure the lines and the areas on the 
image.

how the 'Reference' window. The 'Reference' window is 
a small, normally floating window. The 'Reference' 
window shows the complete current page in miniature. 
The crossed box in the 'Reference' window indicates the 
part of the page showed in the document window. Move 
or change the size of the crossed box to change the area 
of the page showed.

Shows the 'Detail' window.
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The view area

The view area shows the scanned file.

The part of the memory that is allocated to viewer is limited. When you reach 
the limitation of the memory space, the viewer cannot show the scanned file. 
Then, the viewer shows a red border with a red cross.

Use your right mouse button to click on the file shown in the view area. You 
can select the following menu items from the pop-up menu.
■ 'Zoom ±'
■ 'Pan' (Hand tool)
■ 'Fit'  
■ 'Magnify'
■ 'Reduce'  
■ 'Invert'
■ 'Rotate 90 CCW'  
■ 'Rotate 90 CW'  
■ 'Rotate 180'.

[32] An error view in Océ View Station LT

[32] An error view in Océ View Station LT
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Control your  licenses with Océ License 
Logic

Log on to  Océ License Logic

Introduction

You can run Océ License Logic on the controller of the Océ system or remote 
through a web browser. Access to Océ License Logic is password protected. 
Use the same System Administrator password as you use on the Océ system to 
log on.

Purpose

Log on to Océ License Logic for the following purposes.
■ View the current  active licenses
■ Get the host id of the Océ system
■ Save the current active licenses
■ Perform a license activation job.

You can activate new licenses or saved licenses.

Before you begin

To run Océ License Logic remote, you need the host name or IP address of the 
Océ system.

How to log on to  Océ License Logic on the Océ Power Logic® controller

1. Open the Océ Settings Editor
2. Click 'Edit' in the menu bar
3. Click 'Licenses...'

The logon window opens.
4. Select 'System administrator'
5. Enter the 'Password' 
6. Click the 'Logon' button.
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How to log on to  Océ License Logic from a remote web browser

1. Open the web browser.
Océ License logic supports Microsoft® Internet Explorer® version 5.5 or 
higher.

2. Enter the following URL in your browser: 
http://'printer-name'/LicenseLogic.html
Note: 'Printer-name' is the host name or IP address of the printer.
The logon window opens.

3. Select 'System administrator'
4. Enter the 'Password' 
5. Click the 'Logon' button.

Result

Océ License Logic starts with one of the following windows.

■ The 'No active license' window.
This window opens if there are no active licenses.

■ The 'View licenses' window.
This windows opens if Océ License Logic detects active licenses.

Note: If the log on failed, Océ License Logic displays a message. Read the 
message carefully and follow the instructions.
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View the  current active licenses

Introduction

When you log on and Océ License Logic detects active licenses, the 'View 
licenses'  window opens and displays the current active licenses. Per option the 
following fields with license information display.

■ 'Option'
This field displays the name of the option.

■ 'State'
This field displays one of the following license states.
- 'Authorised'
- 'Not authorised'
- 'Expired'
- 'Update configuration'

■ 'License type'
This field displays one of the following license types.
- 'Resale' 
- 'Demo'

■ 'Duration in days' 
This field displays the time your license is valid.

■ 'License number'
This field displays a license number.

Purpose

View the license information for the following purposes.

■ Check the active licenses on license state, license type and license duration
■ Check how long a demo license is valid
■ View all options available for your Océ system.

The list of options depends on the type and version of the  Océ system.
■ Make a list of new options you need
■ Make a list of license numbers.

When to do

View the license information to make a list of new options you need and to 
make a list of license numbers.
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Note: If an error occurs, Océ License Logic displays a message. Read the 
message carefully and follow the instructions.

Before you begin

Make sure that the print system has active licenses. If  Océ License Logic does 
not detect active licenses, the 'No active license' opens (see ‘Log on to Océ 
License Logic’ on page 162).

How to view  license

1. Log on to Océ License Logic.

Result

The 'View licenses' window opens.
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Get the host id of the Océ system

Introduction

Océ needs the host id and the license numbers of your Océ system to create a 
new license file.

When to do

Get the host id to order a new demo or resale license file from Océ.

Before you begin

Open a text editor on the  same system that you start Océ License Logic.  You 
can store the host id in a document.

How to get the host id

1. Log on to Océ License Logic.
The 'No active license' window opens if there are no active licenses.
The 'View licenses' windows opens if Océ License Logic detects active 
licenses.

2. Click the 'Host id' link.
The 'The host id of your Océ system' window opens.

3. Click the 'Copy' button to copy the host id to the clipboard.
4. Open a new document in a text editor.
5. Use the paste option of the text editor  to copy the host id into the document.
6. Enter the different license numbers into the document.
7. Save the document.

Result

The host id is stored in a document. You can use this document to send the host 
id and license numbers to Océ.
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Save the current active licenses

Introduction

You can save all current active licenses of different licenses types into one 
single file.

Purpose

Save the current active licenses for the following purposes.

■ Collect and save all active licenses of different types into one single file
■ Create a back-up file before you start a license activation job.

When to do

Save the current active licenses before you start a license activation job or to 
save the current license situation.

Before you begin

Make sure that the print system has active licenses. If  Océ License Logic does 
not detect active licenses, the 'No active license' opens (see ‘Log on to Océ 
License Logic’ on page 162).

How to save the license

1. Log on to Océ License Logic.
The 'View licenses' window opens.

2. Click the 'Save' button.
The 'Save licenses' window opens.

3. Select a directory, enter the file name and click the 'Save' button to back-up the 
current active licenses.

Result

All current active resale and demo licenses are stored into one single file.
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Perform a license activation job

Introduction

You need to activate the licenses on the Océ system to enable an option for use. 
Océ delivers the new licenses through one or more license files.

Purpose

Activate the licenses for the following purposes.

■ Activate a new demo or resale license to enable a new option
■ Activate the saved licenses of your back-up file to return to the saved 

situation.

When to do

Activate the licenses in the following situations.

■ Activate the new licenses when you received one or more new license files 
from Océ

■ Activate the saved licenses when an activation job for new licenses failed.

Before you begin

To activate the new licenses, you need a license file from Océ. Perform a 
license activation job per new license file. Make sure you use the correct 
license file: the host id in the license file must be the same host id as the host 
id on your Océ system. Make sure the license file is available on the system 
you run Océ License Logic. 

Note: If an error occurs, Océ License Logic displays a message. Read the 
message carefully and follow the instructions.
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How to activate the licenses

1. Log on to Océ License Logic.
The 'No active license' window opens if there are no active licenses.
The 'View licenses' windows opens if Océ License Logic detects active 
licenses.

2. If the 'No active license' window opens, click the 'Next' button.
The 'View licenses' window opens.

3. Click the 'Activate' button.
4. Click the  'Browse' button   to select the location of the license file and click 

'OK' 
5. Click the 'Next' button

A preview of the new license situation displays. What you see depends on the 
license types in the license file you use (see ‘The structure of license files and 
licenses’ on page 78). You see one of the following options.
■ If you use a license file with demo licenses, the current active and the new 

demo licenses display
■ If you use a license file with resale licenses, the current active and the new 

resale licenses display
■ If you use a saved file with demo and resale licenses, the demo and resale 

licenses display like the time you created the back-up file.

6. Click the 'Next' button.
The end user license agreement displays.

7. Read the end user license agreement carefully. If you agree, select ' I accept'.
8. Click the 'Finish' button to activate the license.

The 'View licenses' window displays.
9. Restart the controller of the Océ system.

Result

The licenses are active and the options are ready for use.
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Use the printer drivers to send jobs to the Océ TDS450 printer

Introduction

The Océ TDS450 printer is delivered with a driver pack CD-ROM. You can 
also download the latest Océ drivers, free of charge, from our Web site 
www.oce.com.

With these drivers PC users can access the Océ TDS450 printer remotely from 
their applications, to print their files.

Note: More information about how to install, configure and use the drivers is 
available in the documentation provided with the drivers.

Available printer drivers

(see ‘Specifications drivers and job submission software’ on page 318) for a 
list of the available printer drivers that you can use  to print files from your 
software applications.

Note: Please check at www.oce.com, section drivers for the latest 
driver-updates.
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Use Océ Print Exec® Workgroup LT to send print jobs to the Océ 
TDS450 printer

Introduction

Océ Print Exec®Workgroup LT is an print job submission application that 
allows you to send print jobs to the Océ TDS450 printer through your web 
browser. Upgrades to a full version are available as an option.

Note: For this application a separate Océ Print Exec®Workgroup user manual 
is available.

When to do

Use Océ Print Exec®Workgroup LT to do the following.

1. Select and collect the files to print (documents and drawings), in a print job. 
You can add a maximum of 100 documents or drawings to a print job.

2. Configure the print job.
You can set the document or drawing settings and the print job settings. You 
can add a banner to the print job and add a settings configuration for a print job.

3. Submit the print jobs to the printer queue or inbox queue.
4. Check the print job and the printer configuration status.

You can view the status information of the printer configuration and the 
available media.

Required tools

Microsoft® Internet Explorer® 5.0 (or higher versions) or Netscape 
Navigator® 6.0 (or higher versions). 

TCP/IP network that connects the printer and the end user workstation.

How to connect to Océ Print Exec®Workgroup LT

1. Enter the following URL in your workstation browser: http://'printer name'.
Note: 'Printer name' is the name of printer that you use for your print jobs.
Note: If you enter the URL for the first time, the required software is installed 
automatically at your workstation.
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Print on a cut sheet

Introduction

Use the printer drivers or job submission software to create a copy job or a print 
job on a cut sheet.

Before you begin

Use the   key, the  key and the 'previous' key to navigate. Use the  
'next/select' key to select a menu or a value.

How to define the manual feed media type at the printer operator panel

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Media settings' and select this menu.
3. Navigate to 'Manual feed' and select this menu.
4. Navigate to 'Material' and select this menu.
5. Navigate to the required media type and select this value.
6. Press the 'on-line' key to turn the printer on-line.

Note: To change the manual feed time-out (see ‘Define the manual feed 
time-out at the printer operator panel’ on page 133)
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How to print on a cut sheet

1. Send the print job.
2. Align the cut sheet manually with the format indication and the label on the 

manual feed table of the printer.
3. Feed the media manually and hold it until the printer pulls in the first part of 

the cut sheet.
After a few seconds, the printer pulls in the complete sheet.
Note: The printer prints the image face-up.
[33] Feed the media manually

[33] Feed the media manually

4. If the print job or the copy job requires more cut sheets, repeat steps 2 and 3 
until the display no longer indicates to feed the next sheet.
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Cancel a print job

Introduction

Cancel a print job before you start the print job or while you print.

How to cancel a print job

1. Press the red 'stop' key.
2. The print job stops.

Result
[29] Cancel a print job

[29] Cancel a print job

If Then

The printer already started 
the print job

The printer:
■ stops printing immediately.
■ cuts the paper.
■ ejects the paper.

The print job is cancelled.

The printer did not start the 
print job

The print job is cancelled
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Introduction to copy jobs

Introduction

A basic copy job takes two steps. Feed the original and press the start key. 
Every other type of copy job is called an extended copy job. An extended copy 
job takes one additional step, define the copy job settings at the scanner 
operator panel. When you turn the Océ TDS450 on or when you select 'Copy', 
the scanner operator panel shows five copy job templates. The copy job 
templates provide access to the different settings per copy job template. When 
you select a copy job template, the scanner operator panel shows the top 5 
settings of the selected copy job template. The top 5 settings are the most often 
used settings. You can define the top 5 settings for each copy job template with 
the Océ Settings Editor. You can use the scroll wheel to see the other settings. 
After you start a copy job, you can manage your jobs from the Océ Queue 
Manager.

Illustration
[34] The copy job templates

[34] The copy job templates

Steps in a basic copy job

1. Feed the original.
2. Press the green start key.
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Result

You do a basic copy job in 2 steps. The basic copy job uses the settings of the  
first template.

Steps in an extended copy job

1. Feed the original.
2. Define the job settings.

Select the required template at the scanner operator panel and change the 
pre-defined settings only if necessary.

3. Press the green start key.

Result

An extended copy job takes one additional action only.
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Use the scanner operator panel

Introduction

Use the scanner operator panel to define the job settings. You can define the 
job settings  in two ways. 
■ Use the left softkeys and the scroll wheel.

You can use this method if you prefer a general step by step method.
■ Use the scroll wheel and scroll-wheel key only.

You can use this method if you prefer a fast method.

Know that the scanner operator panel also uses icons to explain a setting. The 
following illustration shows the scanner operator panel of the Océ TDS450 
scanner.
(see table 2 on page 25).
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Illustration
[35] The operator panel of the Océ TDS450 scanner

[35] The operator panel of the Océ TDS450 scanner

1 2 3 4 5 6 7 8 9 0
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Define job settings with the left soft keys and the scroll wheel

1. Select 'Copy' or 'Scan-to-file' with the upper-left softkey.
The five job templates appear.

2. Select a job template with one of the left softkeys.
The top 5 settings appear.

3. Find a setting with the scroll wheel.
A small rectangle in front of a setting name indicates the focus of the scroll 
wheel.

4. Select a setting with the left softkey.
There are several types of settings. The behaviour of the scanner operator panel 
and the definition of a setting depends on the type of setting you selected. You 
can select one of the following types of settings.
■ A setting that contains two values only, like 'On' or ' Off'.

When you select this setting while the setting was not in focus, the setting 
becomes in focus. When you select this setting while the setting was already 
in focus, the setting stays in focus and there are no changes.
Change the value of the setting with the left softkey. The value and icon 
changes.

■ A setting that contains a list of values, like 'Lighter/darker'.
Define the required value with the scroll wheel. The value and icon changes.

■ A setting that contains a list of settings, like 'Media'.
Define the required value with the scroll wheel. The value and icon changes.
Select the next setting of the list of settings with the left softkey.

Note: You can enter a numeric value with the numeric keys. To enter a negative 
numeric value, scroll to a negative value first and than enter the value with the 
numeric keys.

5. Select  'Close' with the lower-right softkey.
6. Repeat from step 4 to define the next setting.

Note: Use the 'Defaults' option at the lower-left key to set all settings of the job 
template to default. 
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Define job setting with  the scroll wheel and scroll-wheel key only

1. Select 'Copy' or 'Scan-to-file' with the upper-left softkey.
The five job templates appear.

2. Focus on a job template with the scroll wheel.
A small diamond in front of a template indicates the focus of the scroll wheel.

3. Select a job template with the scroll-wheel key.
The top 5 settings appear.

4. Find a setting with the scroll wheel.
A small rectangle in front of a setting name indicates the focus of the scroll 
wheel.

5. Select the setting with the scroll-wheel key.
There are several types of settings. The behaviour of the scanner operator panel 
and the definition of a setting depends on the type of setting you selected. You 
can select one of the following types of settings.
■ A setting that contains two values only, like 'On' or ' Off'.

Change the value of the setting with the scroll-wheel key to change the 
value of the setting. The value and icon changes.

■ A setting that contains a list of values, like 'Lighter/darker'.
Open the setting with the scroll-wheel key.
Define the required value with the scroll wheel. The value and icon changes.
Close the setting with the scroll-wheel key.

■ A setting that contains a list of settings, like 'Media'.
Focus on a setting with the scroll wheel. The bold text of a value indicates 
the focus of the scroll wheel. The icon changes.
Open the setting with the scroll-wheel key. The list of values appears.
Open the setting with the scroll-wheel key.
Define the required value with the scroll wheel. The value and icon changes.
Close the setting with the scroll-wheel key.

Note: You can enter a numeric value with the numeric keys. To enter a negative 
numeric value, scroll to a negative value first and than enter the value with the 
numeric keys.

6. Select 'Close' with the lower-scroll-wheel key.
7. Repeat from step 4 to define the next setting.

Note: Use the 'Defaults' option at the lower-left key to set all settings of the job 
template to default. 
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Do a basic copy job

Introduction

The main steps of a basic copy job consists of the following steps.
■ Feed the original.
■ Press the green start key.

How to copy on the Océ TDS450

1. Place the original face down and right aligned.
The scanner takes the original.
[36] Place the original face down and right aligned

[36] Place the original face down and right aligned

2. Press the green start key.
The scanner operator panel shows the copy job number and the status of the 
copy job.

Note: You can copy faster when you feed the original landscape.

Result

The Océ TDS450 makes a copy.
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Do an extended copy job

Introduction

The main steps of an extended copy job are the following.
■ Feed the original.
■ Define the job settings.
■ Press the green start key.

Before you begin

If you must enter the same value for a setting very often, you can set this value 
as the default value for that setting in the Océ Settings Editor. 
After you press the start key, the scanner operator panel always shows the job 
number and status of the job. A copy job appears temporarily in the printer 
queue of the Océ Queue Manager, a scan-to-file job appears in the selected 
destination of the Océ Scan Manager.

How to copy on the Océ TDS450

1. Place the original face down and right aligned.
The scanner takes the original.
[37] Place the original face down and right aligned

[37] Place the original face down and right aligned
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2. Define  the job settings.
[38] The top 5 settings of a copy job template

[38] The top 5 settings of a copy job template

■ Select 'Copy' with the upper-left softkey.
The copy job templates appear.

■ Open a copy job template with a left softkey.
The top 5 settings appear.

■ Scroll to a setting.
■ Select a setting with the left softkey.
■ Scroll to the required value.
■ Select the next  setting with the left softkey.
■ Scroll to the required value.
■ Select 'Close' to close the setting.

3. Define the number of copies if necessary and press the green start key.

Note: You can copy faster when you feed the original landscape, unless you 
must scale your original to another media size. In that case you must feed the 
original portrait. 

Result

The Océ TDS450 makes a copy according to the defined settings.
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Stop a copy job

Introduction

You can stop a copy job with the red stop key on the scanner operator panel.

How to stop a copy job

1. Press the red stop key.
Note: This will not affect a set job.

Result

When you press the red stop key while the scanner scans, the scan process 
stops. The scanner rewinds the original and the copy job is cancelled.
When you press the red stop key while the scanner rewinds, the rewind process 
continues. The copy job is cancelled.
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Extended copy jobs

Available settings for copy jobs

Introduction

The Océ TDS450 provides a lot of settings to manage all your different copy 
jobs. These settings are used for extended copy jobs. The following table gives 
an overview and a very short description of the available settings. This table is 
not complete, because a setting can contain more than one setting. You find a 
detailed description of each setting in the on-line help at the Océ Settings 
Editor. You can change the default value of a setting that you use very often in 
the job template at the Océ Settings Editor. 
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Available settings for copy jobs
[30] The available settings for copy jobs, a setting can contain more than one setting.

[30] The available settings for copy jobs, a setting can contain more than one setting.

Setting Function

'Original type' Define the type of original you use

'Scale' Scale an original

'Media' Define the type of media you use

'Lighter/darker' Make a lighter or darker copy

'Remove strip' Copy without strips

'Original width' Define the width of the original

'Delete area' Copy without a specific area

'Cut method' Define the cut method of the printer

'Add strip' Copy with a strip

'Alignment' Align the image of the copy

'Shift' Shift the image of the copy

'Mirror' Mirror the image of the copy

'Drawing 
method'

Define the legend location

'Stamp' Copy with a stamp

'Collate' Define how to collate the copies.

'Scan quality' Optimize the copy
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Improve  the copy quality according to the original

Introduction

You can improve the copy or scan quality even more for the following 
situations.
■ You have an original from a special type.

The Océ TDS450 scanner makes sure that the copy or the scanned file has 
a sharp image. You can define the 'Original type' setting  manually to 
improve the copy or scan quality according to the type of original you use.

■ You have a dark or light original.
The Océ TDS450 scanner detects the brightness of the  image  on the 
original automatically and makes sure that the copy or the scanned file has 
a bright image. You can adjust the brightness manually with the  
'Lighter/darker' setting  to improve the copy or scan quality according to the 
type of original you use.

■ You have an original with very fine details.
The Océ TDS450 scanner optimizes the image of the original automatically. 
You can optimize the image manually to sharpen the fine details with the 
'Scan quality' setting.

Before you begin

If you must enter the same value for a setting very often, you can set this value 
as the default value for that setting in the Océ Settings Editor. 
After you press the start key, the scanner operator panel always shows the job 
number and status of the job. A copy job appears temporarily in the printer 
queue of the Océ Queue Manager, a scan-to-file job appears in the selected 
destination of the Océ Scan Manager.
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How to improve the copy quality of originals from a special type

1. Place the original face down and right aligned.
The scanner takes the original.

2. Define the job settings.
[39] The 'Lines&text' icon of the 'Original type' setting

[39] The 'Lines&text' icon of the 'Original type' setting

■ Select 'Copy' with the upper-left softkey.
The copy job templates appear.

■ Open a copy job template with a left softkey.
The top 5 settings appear.

■ Scroll to 'Original type' and open this setting with the left softkey.
■ Scroll to the original type you have.

3. Define the number of copies if necessary and press the green start key.

Result

The copy quality was improved according to the original type.
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How to improve the copy quality of dark and light originals

1. Place the original face down and right aligned.
The scanner takes the original.

2. Define the job settings.
[40] The 'Lighter/darker' icon

[40] The 'Lighter/darker' icon

■ Select 'Copy' with the upper-left softkey.
The copy job templates appear.

■ Open a copy job template with a left softkey.
The top 5 settings appear.

■ Scroll to  'Lighter/darker' and open this setting with the left softkey.
■ Adjust the required value.

A positive value lightens the copy, a negative value darkens the copy.

3. Define the number of copies if necessary and press the green start key.

Result

The copy quality improved according to the brightness of the original.
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How to improve the copy quality of an original with very fine details

1. Place the original face down and right aligned.
The scanner takes the original.

2. Define the job settings.
[41] The 'Best' icon of the  'Scan quality' setting

[41] The 'Best' icon of the  'Scan quality' setting

■ Select 'Copy' with the upper-left softkey.
The copy job templates appear.

■ Open a copy job template with a left softkey.
The top 5 settings appear.

■ Scroll to 'Scan quality' and open this setting with the left softkey.
■ Scroll to 'Best'.

3. Define the number of copies if necessary and press the green start key.

Result

The copy quality improved according to the fine details on the original.
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Make multiple sets of copies

Introduction

You can use the 'Create set' option to make multiple sets of copies.

Before you begin

If you must enter the same value for a setting very often, you can set this value 
as the default value for that setting in the Océ Settings Editor. 
After you press the start key, the scanner operator panel always shows the job 
number and status of the job. A copy job appears temporarily in the printer 
queue of the Océ Queue Manager, a scan-to-file job appears in the selected 
destination of the Océ Scan Manager.

Illustration
[42] The 'By set' (left) and 'By page' icon of the 'Collate' setting.

[42] The 'By set' (left) and 'By page' icon of the 'Collate' setting.
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How to make multiple sets of copies sorted by set

1. Feed the first original face down and right aligned.
The scanner takes the original.

2. Define the job settings.
■ Select 'Copy' with the upper-left softkey.

The copy job templates appear.
■ Open a copy job template with a left softkey.

The 'Create set' option appears at the upper-right corner of the screen.
■ Select 'Create set' with the upper-right softkey.

The 'Cancel set' option appears at the upper-left corner of the screen. The 
'Close set' option  appears at the upper-right corner of the screen.

■ Scroll to 'Collate' and define 'By set' with the left softkey. This setting is 
disabled after you press the green start key for the first time. 

■ Scroll to another setting if necessary, select the setting with the left softkey 
and define the value with the scroll wheel.

■ Define the number of copies and press the green start key. 
You can not change the number of copies after you press the green start key 
for the first time. 

■ Feed the next original, define the enabled settings for this original if 
necessary and press the green start key.
Repeat this step until all originals are fed.

3. Select 'Close set' with the upper-right softkey.
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How to make multiple sets of copies sorted by page

1. Feed the first original face down and right aligned.
The scanner takes the original.

2. Define the job settings.
■ Select 'Copy' with the upper-left softkey.

The copy job templates appear.
■ Open a copy job template with a left softkey.

The 'Create set' option appears at the upper-right corner of the screen.
■ Select 'Create set' with the upper-right softkey.

The 'Cancel set' option appears at the upper-left corner of the screen. The 
'Close set' option appears at the upper-right corner of the screen.

■ Scroll to 'Collate' and define 'By page' with the left softkey. This setting is 
disabled after you press the green start key for the first time.

■ Scroll to another setting if necessary, select the setting with the left softkey 
and define the value with the scroll wheel.

■ Define the number of copies for the first original if necessary and press the 
green start key.

■ Feed the next original, define the enabled settings and the number of copies 
for this original if necessary and press the green start key.
Repeat this step until all originals are fed.

3. Select 'Close set' with the upper-right softkey.

Result

The Océ TDS450 copies a set of originals sorted by set or by page.
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Make a copy with a stamp

Introduction

A stamp is a pre-defined text you can set on every copy. The stamp function is 
an option. Use Océ License logic to enable this option. Use the Océ Settings 
Editor to define a maximum of 10 stamps and their default values.

Before you begin

If you must enter the same value for a setting very often, you can set this value 
as the default value for that setting in the Océ Settings Editor. 
After you press the start key, the scanner operator panel always shows the job 
number and status of the job. A copy job appears temporarily in the printer 
queue of the Océ Queue Manager, a scan-to-file job appears in the selected 
destination of the Océ Scan Manager.
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How to make a copy with a stamp

1. Place the original face down and right aligned.
The scanner takes the original.

2. Define the job settings.
[43] The stamp icon

[43] The stamp icon

■ Select 'Copy' with the upper-left softkey.
The copy job templates appear.

■ Open a copy job template with a left softkey.
The top 5 settings appears.

■ Scroll to 'Stamp' and open this setting with the left softkey.
■ Select a stamp with the scroll wheel.
■ Select 'Position' with the left softkey.

Select a position with the scroll wheel.
■ Select 'Size' with the left softkey.

Select a size with the scroll wheel.
■ Select 'Colour' with the left softkey.

Select a colour with the scroll wheel.
■

3. Define the number of copies and press the green start key.

Result

The copy contains the selected stamp.
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Scale to another media size

Introduction

You can use the 'Scale' setting to copy to a larger or smaller media format. Use 
one of the following methods to scale a copy.
■ Select another media format with the 'To fit' setting.
■ Adjust a value in terms of percentage with the 'Custom' setting.

You can adjust a value between 25 and 400%. A value lower than 100% 
reduces the copy, a value greater than 100% enlarges the copy.

Before you begin

If you must enter the same value for a setting very often, you can set this value 
as the default value for that setting in the Océ Settings Editor. 
After you press the start key, the scanner operator panel always shows the job 
number and status of the job. A copy job appears temporarily in the printer 
queue of the Océ Queue Manager, a scan-to-file job appears in the selected 
destination of the Océ Scan Manager.
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How to copy to another media size

1. Place the first original face down and right aligned. Make sure that you feed 
the original portrait.
The scanner takes the original.

2. Define the job settings.
[44] Example of a 'Scale' icon

[44] Example of a 'Scale' icon

■ Select 'Copy' with the upper-left softkey.
The copy job templates appear.

■ Open a copy job template with a left softkey.
The top 5 settings appear.

■ Scroll to 'Scale' and open this setting with the left softkey.
The 'To fit' and the  'Custom' setting appear. 

■ Define the media format at the 'To fit' setting with the scroll wheel.

3. Define the number of copies and press the green start key.

Result

The Océ TDS450 copies to another media size.
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Make a copy on a cut sheet

Introduction

You can copy on cut sheet media if the required media type or size is not 
available on the media rolls of the printer.

Before you begin

If you must enter the same value for a setting very often, you can set this value 
as the default value for that setting in the Océ Settings Editor. 
After you press the start key, the scanner operator panel always shows the job 
number and status of the job. A copy job appears temporarily in the printer 
queue of the Océ Queue Manager, a scan-to-file job appears in the selected 
destination of the Océ Scan Manager.

How to copy on a cut sheet

1. Place the original face down and right aligned.
The scanner takes the original.

2. Define the job settings.
[45] Example of a 'Size' icon

[45] Example of a 'Size' icon

■ Select 'Copy' with the upper-left softkey.
The copy job templates appear.

■ Open a copy job template with a left softkey.
The top 5 settings  appears.

■ Scroll to 'Media' and open this setting with the left softkey.
The 'Feed' setting appears.

■ Define 'Manual' at the 'Feed' setting with the scroll wheel.
The settings 'Size' and 'Type' appear.

■ Select 'Size' with the left softkey and define the 'Size' with the scroll wheel.
■ Select 'Type' with the left softkey and define the 'Type' with the scroll wheel.

3. Define the number of copies if necessary and press the green start key.
4. Place the cut sheet media on the manual feed table of the printer.
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Note: The printer prints the image face-up.

Result

The Océ TDS450 copies on a cut sheet.
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Make a copy and add a strip

Introduction

You can use a strip to file a drawing. Use 'Add strip' to copy an original without 
a strip and add a strip to the copy. Use 'Remove strip' to copy an original with 
a strip and remove the strip from the copy. You can adjust a strip at the leading 
or trailing side of a copy.

Before you begin

If you must enter the same value for a setting very often, you can set this value 
as the default value for that setting in the Océ Settings Editor. 
After you press the start key, the scanner operator panel always shows the job 
number and status of the job. A copy job appears temporarily in the printer 
queue of the Océ Queue Manager, a scan-to-file job appears in the selected 
destination of the Océ Scan Manager.

How to make a copy and add a strip

1. Place the original face down and right aligned.
The scanner takes the original.

2. Define the job settings.
■ Select 'Copy' with the upper-left softkey.

The copy job templates appear.
■ Open a copy job template with a left softkey.

The top 5 settings appears.
■ Scroll to 'Add strip' and open this setting with the left softkey.
■ Select 'Leading' or 'Trailing' with the left softkey and define the value with 

the scroll wheel or numeric keys.

3. Define the number of copies if necessary and press the green start key.

Note: To measure the size of a strip you can use the ruler available at the 
scanner (metric).

The 'Leading' strip The 'Trailing' strip
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Result

The Océ TDS450 adds a trailing or leading strip to the copy.
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Make a copy and remove a strip

Introduction

You can use a strip to file a drawing. Use 'Add strip' to copy an original without 
a strip and add a strip to the copy. Use 'Remove strip' to copy an original with 
a strip and remove the strip from the copy. You can adjust a strip at the leading 
or trailing side of a copy.

Before you begin

If you must enter the same value for a setting very often, you can set this value 
as the default value for that setting in the Océ Settings Editor. 
After you press the start key, the scanner operator panel always shows the job 
number and status of the job. A copy job appears temporarily in the printer 
queue of the Océ Queue Manager, a scan-to-file job appears in the selected 
destination of the Océ Scan Manager.

Attention: When you remove a strip, make sure that you copied all the 
required information.

How to make a copy and remove a strip

1. Place the original face down and right aligned.
The scanner takes the original.

2. Define the job settings.
■ Select 'Copy' with the upper-left softkey.

The copy job templates appear.
■ Open a copy job template with a left softkey.

The top 5 settings appears.
■ Scroll to 'Remove strip' and open this setting with the left softkey.
■ Select 'Leading' or 'Trailing' with the left softkey and define the value with 

the scroll wheel or numeric keys.

3. Define the number of copies if necessary and press the green start key.

The 'Leading' strip The 'Trailing' strip
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Note: To measure the size of a strip you can use the ruler available at the 
scanner (metric).

Result

The Océ TDS450 removes a trailing or leading strip to the copy.
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Make a copy of a specific area of an original

Introduction

You can make a copy of a specific area of an original with the 'Remove strip' 
setting. Define the following strips to specify the area.
■ 'Leading'
■ 'Trailing'
■ 'Left'
■ 'Right'

Before you begin

If you must enter the same value for a setting very often, you can set this value 
as the default value for that setting in the Océ Settings Editor. 
After you press the start key, the scanner operator panel always shows the job 
number and status of the job. A copy job appears temporarily in the printer 
queue of the Océ Queue Manager, a scan-to-file job appears in the selected 
destination of the Océ Scan Manager.

Attention: When you remove a strip, make sure that you copied all the 
required information.
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How to copy a specific area of an original

1. Place the original face down and right aligned.
The scanner takes the original.

2. Define the job settings.
■ Select 'Copy' with the upper-left softkey.

The copy job templates appear.
■ Open a copy job template with a left softkey.

The top 5 settings appears.
■ Scroll to 'Remove strip' and open this setting with the left softkey.
■ Define the 'Leading' strip value with the scroll wheel or numeric keys.
■ Select 'Trailing' with the left softkey and define the value with the scroll 

wheel or numeric keys.
■ Select 'Left' with the left softkey and define the value with the scroll wheel 

or numeric keys.  'Left' is the left side of an original that is turned face up.
■ Select 'Right' with the left softkey and define the value with the scroll wheel 

or numeric keys and close the setting. 'Right' is the right side of an original 
that is turned face up.

■ Scroll to 'Alignment' and open this setting with the left softkey.
■ Define the value of the  'Horizontal' setting to 'Centre' with the scroll wheel.
■ Select 'Vertical' with the left softkey and define 'Centre' with the scroll 

wheel.

3. Define the number of copies if necessary and press the green start key.

Note: To measure the size of a strip you can use the ruler available at the 
scanner (metric).

Result

The Océ TDS450 copies a specific area of the original to the specified position 
on the copy.

The 'Leading' 
strip 

The 'Trailing' 
strip

The 'Left' strip The 'Right' strip
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Make a copy and delete a specific area of an original

Introduction

You can make a copy without a specific area of an original with the 'Delete 
area' setting.

Attention: When you copy without a specific area, make sure that you 
copied all the required information.

How to copy a specific area of an original

1. Place the original face down and right aligned.
The scanner takes the original.

2. Define the job settings.
[46] The icons of 'Y Offset', 'X Offset','Width' and 'Length' setting

[46] The icons of 'Y Offset', 'X Offset','Width' and 'Length' setting

■ Select 'Copy' with the upper-left softkey.
The copy job templates appear.

■ Open a copy job template with a left softkey.
The top 5 settings appears.

■ Scroll to 'Delete area' and open this setting with the left softkey.
■ Define the 'X Offset' with the scroll wheel or numeric keys.
■ Select 'Y Offset' with the left softkey and define the value with the scroll 

wheel or numeric keys.
■ Select 'Width' with the left softkey and define the value with the scroll wheel 

or numeric keys.
■ Select 'Length' with the left softkey and define the value with the scroll 

wheel or numeric keys and close the setting.

3. Define the number of copies if necessary and press the green start key.

Result

The Océ TDS450 copies an original without the specified area.
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Introduction to scan-to-file jobs

Introduction

A basic scan-to-file job takes three steps. Feed the original, select  'Scan-to-file' 
and press the start key. Every other type of scan-to-file job, where you change 
the scan-to-file settings, is called an extended scan-to-file job. An extended 
scan-to-file job takes one additional step. Define the scan-to-file job settings at 
the scanner operator panel. When you select 'Scan-to-file', the scanner operator 
panel shows five scan-to-file job templates. The scan-to-file job templates 
provide access to the different settings per scan-to-file job template. When you 
select a scan-to-file job template, the scanner operator panel shows the top 5 
settings of the selected scan-to-file job template. The top 5 settings are the most 
often used settings. You can define the top 5 settings and their values for each 
scan-to-file job template with the Océ Settings Editor. You can use the scroll 
wheel to see the other settings. After you start a scan-to-file job, you can 
manage your jobs from the Océ Queue Manager.

Illustration
[47] The scan-to-file job templates

[47] The scan-to-file job templates

Steps in a basic scan-to-file job

1. Feed the original.
2. Select 'Scan-to-file'
3. Press the green start key.
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Result

You get a digital file of your original.

Steps in an extended scan-to-file job without fine tuned job templates

1. Feed the original.
2. Select 'Scan-to-file'.
3. Define the scan-to-file job settings at the scanner operator panel.

■ Open a template.
■ Select the first setting and define the value.
■ Select the second setting and define the value.
■ ....
■ Select the last setting and define the value.

4. Press the green start key.

Result

The second step takes several additional actions.

Steps in an extended scan-to-file job with fine tuned job templates

1. Feed the original.
2. Select 'Scan-to-file'.
3. Define the job settings.

Select the required template at the scanner operator panel and change the 
pre-defined settings only if necessary.

4. Press the green start key.

Result

You get a tuned digital file of your original.
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Use the scanner operator panel

Introduction

Use the scanner operator panel to define the job settings. You can define the 
job settings  in two ways. 
■ Use the left softkeys and the scroll wheel.

You can use this method if you prefer a general step by step method.
■ Use the scroll wheel and scroll-wheel key only.

You can use this method if you prefer a fast method.

Know that the scanner operator panel also uses icons to explain a setting. The 
following illustration shows the scanner operator panel of the Océ TDS450 
scanner.
(see table 2 on page 25).
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Illustration
[48] The operator panel of the Océ TDS450 scanner

[48] The operator panel of the Océ TDS450 scanner

1 2 3 4 5 6 7 8 9 0
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Define job settings with the left soft keys and the scroll wheel

1. Select 'Copy' or 'Scan-to-file' with the upper-left softkey.
The five job templates appear.

2. Select a job template with one of the left softkeys.
The top 5 settings appear.

3. Find a setting with the scroll wheel.
A small rectangle in front of a setting name indicates the focus of the scroll 
wheel.

4. Select a setting with the left softkey.
There are several types of settings. The behaviour of the scanner operator panel 
and the definition of a setting depends on the type of setting you selected. You 
can select one of the following types of settings.
■ A setting that contains two values only, like 'On' or ' Off'.

When you select this setting while the setting was not in focus, the setting 
becomes in focus. When you select this setting while the setting was already 
in focus, the setting stays in focus and there are no changes.
Change the value of the setting with the left softkey. The value and icon 
changes.

■ A setting that contains a list of values, like 'Lighter/darker'.
Define the required value with the scroll wheel. The value and icon changes.

■ A setting that contains a list of settings, like 'Media'.
Define the required value with the scroll wheel. The value and icon changes.
Select the next setting of the list of settings with the left softkey.

Note: You can enter a numeric value with the numeric keys. To enter a negative 
numeric value, scroll to a negative value first and than enter the value with the 
numeric keys.

5. Select  'Close' with the lower-right softkey.
6. Repeat from step 4 to define the next setting.

Note: Use the 'Defaults' option at the lower-left key to set all settings of the job 
template to default. 
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Define job setting with  the scroll wheel and scroll-wheel key only

1. Select 'Copy' or 'Scan-to-file' with the upper-left softkey.
The five job templates appear.

2. Focus on a job template with the scroll wheel.
A small diamond in front of a template indicates the focus of the scroll wheel.

3. Select a job template with the scroll-wheel key.
The top 5 settings appear.

4. Find a setting with the scroll wheel.
A small rectangle in front of a setting name indicates the focus of the scroll 
wheel.

5. Select the setting with the scroll-wheel key.
There are several types of settings. The behaviour of the scanner operator panel 
and the definition of a setting depends on the type of setting you selected. You 
can select one of the following types of settings.
■ A setting that contains two values only, like 'On' or ' Off'.

Change the value of the setting with the scroll-wheel key to change the 
value of the setting. The value and icon changes.

■ A setting that contains a list of values, like 'Lighter/darker'.
Open the setting with the scroll-wheel key.
Define the required value with the scroll wheel. The value and icon changes.
Close the setting with the scroll-wheel key.

■ A setting that contains a list of settings, like 'Media'.
Focus on a setting with the scroll wheel. The bold text of a value indicates 
the focus of the scroll wheel. The icon changes.
Open the setting with the scroll-wheel key. The list of values appears.
Open the setting with the scroll-wheel key.
Define the required value with the scroll wheel. The value and icon changes.
Close the setting with the scroll-wheel key.

Note: You can enter a numeric value with the numeric keys. To enter a negative 
numeric value, scroll to a negative value first and than enter the value with the 
numeric keys.

6. Select 'Close' with the lower-scroll-wheel key.
7. Repeat from step 4 to define the next setting.

Note: Use the 'Defaults' option at the lower-left key to set all settings of the job 
template to default. 
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Do a basic scan-to-file job

Introduction

This section describes a general workflow for a basic scan-to-file job.

Before you begin

If you must enter the same value for a setting very often, you can set this value 
as the default value for that setting in the Océ Settings Editor. 
After you press the start key, the scanner operator panel always shows the job 
number and status of the job. A copy job appears temporarily in the printer 
queue of the Océ Queue Manager, a scan-to-file job appears in the selected 
destination of the Océ Scan Manager.

How to do a basic scan-to-file job on the Océ TDS450

1. Place the original face down and right aligned.
The scanner takes the original.
[49] Place the original face down and right aligned.

[49] Place the original face down and right aligned.

2. Select 'Scan-to-file' with the upper-left softkey.
3. Press the green start key.

Result

The scanner scans the original and the sends the scanned file to the default 
scan-to-file destination.
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Do an extended scan-to-file job

Introduction

This section describes a general workflow for an extended scan-to-file job.

Before you begin

If you must enter the same value for a setting very often, you can set this value 
as the default value for that setting in the Océ Settings Editor. 
After you press the start key, the scanner operator panel always shows the job 
number and status of the job. A copy job appears temporarily in the printer 
queue of the Océ Queue Manager, a scan-to-file job appears in the selected 
destination of the Océ Scan Manager.

How to do an extended scan-to-file job on the Océ TDS450

1. Place the original face down and right aligned.
The scanner takes the original.
[50] Place the original face down and right aligned

[50] Place the original face down and right aligned
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2. Select 'Scan-to-file' with the upper-left softkey.
The scan-to-file job templates appear.

3. Define the job settings.
[51] The top 5 settings of a scan job template

[51] The top 5 settings of a scan job template

(see ‘Available settings for scan-to-file jobs’ on page 222)
■ Open a scan-to-file job template with a left softkey.

The top 5 settings appears.
■ Scroll to a setting.
■ Select a setting with the left softkey.
■ Scroll to the required value.
■ Select the next setting with the left softkey.
■ Scroll to the required value.
■ Select 'Close' to close the setting.
■ Repeat the selection of settings from bullet 3 if you need to define more 

settings.

4. Press the green 'Start' key.

Result

The scanner scans the original and the sends the scanned file to the defined 
scan-to-file destination.
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Stop a scan-to-file job

Introduction

You can stop a scan-to-file job with the red stop key at the scanner operator 
panel.

How to stop a scan-to-file job

1. Press the red stop key.

Result

When you press the red stop key while the scanner scans, the scan process 
stops. The scanner rewinds the original and the scan-to-file job is cancelled.
When you press the red stop key while the scanner rewinds, the rewind process 
continues. The scan-to-file job is cancelled.
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Settings for extended scan-to-file jobs

Available settings for scan-to-file jobs

The scan-to-file settings

Setting Description

'Destination' Use this setting to define the default destination for 
scan-to-file jobs on the controller. You can define 
a maximum of 10 remote destinations and one of 
these destinations is the default destination.

'File type' Depending on the colour mode and file type you 
select the values for the compression mode and 
organisation will change. For some File types, the 
Compression and Organisation settings cannot be 
set in all situations.(see ‘'File type'’ on page 224)

'Resolution' Use this setting to define the resolution of the 
scanned images. The higher the resolution you 
select, the finer the image quality but the larger the 
file size. (see ‘'Resolution'’ on page 226)

'Original type' Use this setting to define the type of original for 
your scan-to-file jobs. The defined type influences 
the quality of the output.(see ‘'Original type' and 
background compensation’ on page 227)

'Original width' Use this setting to define the width of the original 
that the scanner scans.(see ‘'Original width'’ on 
page 228)
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'Remove strip' Use this setting to define blank areas on the sides 
of the scanned image. (see ‘'Remove strip'’ on 
page 229)

'Mirror' Use this setting to create a mirrored image of an 
original. Mirroring occurs in the transport 
direction. (The image is mirrored along the vertical 
axis.)

'Lighter/darker' Use this setting to define the exposure of the 
original. Negative values mean less exposure and 
darker scanned output. Positive values mean more 
exposure and greyer scanned output.

Note: This setting can only be set if the colour 
mode you select is grey or black and white.

'Checkprint' Use this setting to define if the system prints a 
checkprint for a scan-to-file job. The checkprint 
represents the quality of the scanned document.

Note: This setting can not be used for scan-to-file 
jobs with colour.

Setting Description
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'File type'

Depending on the colour mode and file type you select the values for the 
compression mode and organisation will change. For  some File types, the 
Compression and Organisation settings cannot be set in all situations.

Colour mode: Greyscale

Colour mode:  Black and White

Colour mode File type Compression Organisation

'Greyscale' 'TIFF' ■ 'None'
■ 'Packbits'
■ 'LZW'

■ 'Raw'
■ 'Tiled'
■ 'Striped'

'PDF' ■ 'None'
■ 'Flate'
■ 'Group 4'
■ 'Packbits'
■ 'LZW'

Not available

Colour mode File type Compression Organisation

'Black&white' 'TIFF' ■ 'None'
■ 'Group 3'
■ 'Group 4'
■ 'Packbits'
■ 'LZW'

■ 'Raw'
■ 'Tiled'
■ 'Striped'

'PDF' ■ 'None'
■ 'LZW'
'Flate'
■ 'Group 4'

Not available

'CALS' Not available Not available
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Colour mode:  Colour

Colour mode File type Compression Organisation

'Colour' 'TIFF' ■ 'None'
■ 'Packbits'
■ 'LZW'

■ 'Raw'
■ 'Tiled'
■ 'Striped'

'PDF' ■ 'None'
■ 'LZW'
■ 'Flate'

Not available
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'Resolution'

Use this setting to define the resolution of the scanned images. The higher the 
resolution you select, the finer the image quality. 
Select the required scan resolution with the scroll wheel.

Note: A higher resolution increases the file size.

Setting Value in dots per inch

'Resolution' ■ '72 dpi'
■ '100 dpi'
■ '150 dpi'
■ '200 dpi'
■ '300 dpi'
■ '400 dpi'
■ '600 dpi'
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'Original type' and background compensation

Use the 'Original type' setting to define the type of original for copy and 
scan-to-file  jobs. The defined type influences the quality of the output.
Use the 'Backgnd comp' setting to define the background compensation for 
your original.
Select the type of original and the background compensation with the scroll 
wheel.

Note: If the colour mode of a scan to file job is set to colour, the original type 
is fixed.

Setting Value

'Original type' ■ 'Lines&text' for paper 
■ 'Greys&Lines'
■ 'Dark original'
■ 'Blueprint'
■ 'Photo'
■ 'Transparent' for transparencies

'Backgnd comp' When the background on the original has pollution, use 
this setting to improve the quality of the background.
The compensation depends on the type of the originals. 
If enabled, the background compensation for 'Photo' or 
'Greys&Lines' originals is a standard value.
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'Original width'

Use this setting to define the width of the original that the scanner scans.

Select one of the following.

Setting Icon Result

'Auto' The scan width is automatically 
determined based on the actual width 
of the original.

'Standard' Use this setting to a 'Standard' width 
of the original. 
The standard widths that you can 
select depend on the media series 
that you selected in the Océ Settings 
Editor.

'Custom' Custom-selected width. Use this 
setting if the 'Auto' setting or the  
'Standard' setting does not give the 
required result.
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'Remove strip'

Use the 4 settings below to define the blank areas around the image.

[31] Remove strips

[31] Remove strips

Setting Icon Result

'Remove strip' -  
'Leading'

Use this setting to remove a strip at 
the top of the image. This action 
decreases the print or file length.
Note: The top side of the image is the 
side that you feed into the scanner.

'Remove strip' -  
'Trailing'

Use this setting to remove a strip at 
the bottom of the image. This action 
decreases the print or file length.

'Remove strip' -  
'Left'

Use this setting to remove a strip 
from the left side of the 
image/original viewed from the 
face-up direction. This action 
decreases the print or file width.

'Remove strip' - 
'Right'

Use this setting to remove a strip 
from the right side of the 
image/original viewed from the 
face-up direction. This action 
decreases the print or file width.
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Overview of the finishing settings

Introduction

Before you use the folder, switch the lever downward. If you want to use the 
Integrated Receiving Tray, switch the lever upward.

The lever
[52] To fold, switch the lever downward

[52] To fold, switch the lever downward
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Overview of the finishing settings

Setting Menu path Description

Folded 
output 
delivery

'Folding' - 
'Delivery'

Determines where the folder must deliver 
the output.
■ Select 'Stacker' if you have output with a 

maximum length of 2,5 m that must be 
folded completely (first fold and second 
fold) and that you want to collect in the 
stacker (2) (second fold delivery). You 
can collect a maximum of 25 PPP.

■ Select 'First Fold' if your output must be 
folded in one direction only. The output 
will be collected in the First Fold 
Delivery (8)

■ Choose 'Belt' if you have output with a 
maximum length of 2,5 m that must be 
folded completely (first fold and second 
fold) and that you want to collect in belt 
(3). You can collect a maximum of 75 
PPP. 

(see ‘Define the folded output delivery’ on 
page 236)
Note: The 'First Fold' option is selected 
automatically if the length of your output is 
between 2,5 m and 6m.
Note: You can only choose 'Belt' if your 
folder has a belt unit. (see ‘The belt unit’ on 
page 244)
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Folding 
legend

'Folding' - 
'Input' 
-'Legend'

Use this setting to define if the legend of 
your drawing is on the trailing side of your 
drawing or on the leading side. The folder 
folds the output in such a manner that the 
legend of the drawing is on top of the folded 
output.
■ Select 'Trailing' if the legend of your 

drawing is on the trailing side.
■ Select 'Leading' if the legend of your 

drawing is on the leading side.

(see ‘Define the folding legend’ on 
page 237)
Note: The leading side of the drawing is the 
side that you feed into the scanner.

Drawing 
method

'Folding' 
-'Input' 
-'Method' 

Use this setting to select a folding method 
that depends on the drawing method you use. 
If you select 'Afnor' you can define the 
length, the width and the binding edge of 
your folded package.
■ Select 'Standard' if.....
■ Select 'Afnor' if... 
■ Select 'Ericsson' if... 

(see ‘Define the drawing method’ on 
page 238)

Binding 
method

'Folding' - 
'Binding' 
-'Method' 

■ Select 'Off' if you don't want your folded 
output to have a strip that you can 
perforate for filing purposes.

■ Select 'On' if you do want your folded 
output to have a strip that you can 
perforate for filing purposes.

■ Select 'Reinforce' if you want your folded 
output to have a reinforced strip that is 
pre-perforated for filing purposes.

(see ‘Define the binding method’ on 
page 239)
Note: You can only choose 'Reinforce' if your 
folder has a reinforcement unit. (see ‘The 
reinforcement unit’ on page 243)

Setting Menu path Description
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Binding edge 
value

'Folding' 
-'Binding 
edge' 
-'Method' 

Determines the width of the strip if you have 
selected that your binding method is 'On'.
(see ‘Define the binding edge value’ on 
page 240)

Folded 
package 
length

'Folding' - 
'Package' - 
'Length' 

Select this setting if you want to define the 
length of your folded output. 
(see ‘Define the folded package length’ on 
page 241)

Folded 
package 
width

'Folding' 
-'Package' 
-'Width' 

Select this setting if you want to define the 
width of your folded output.
(see ‘Define the folded package width’ on 
page 242)

Setting Menu path Description
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Define the folded output delivery

Before you begin

Use the   key, the  key and the 'previous' key to navigate. Use the  
'next/select' key to select a menu or a value.

How to define the folded output delivery

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Folding'  and select this menu.
3. Navigate to 'Delivery' and select this menu.
4. Select 'Stacker', 'First Fold' or 'Belt'.
5. Press the 'on-line' key to turn the printer on-line.
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Define the folding method

Define the folding legend

Before you begin

Use the   key, the  key and the 'previous' key to navigate. Use the  
'next/select' key to select a menu or a value.

How to define the folding legend

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Folding'  and select this menu.
3. Navigate to 'Input' and select this menu.
4. Navigate to 'Legend' and select this menu.
5. Select 'Trailing' or 'Leading'.
6. Press the 'on-line' key to turn the printer on-line.
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Define the drawing method

Before you begin

Use the   key, the  key and the 'previous' key to navigate. Use the  
'next/select' key to select a menu or a value.

How to define the drawing method

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Folding'  and select this menu.
3. Navigate to 'Input' and select this menu.
4. Navigate to 'Method' and select this menu.
5. Select 'Standard', 'Afnor'  or 'Ericsson' .
6. Press the 'on-line' key to turn the printer on-line.
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Define the binding method

Define the binding method

Before you begin

Use the   key, the  key and the 'previous' key to navigate. Use the  
'next/select' key to select a menu or a value.

How to define the binding method

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Folding'  and select this menu.
3. Navigate to 'Binding' and select this menu.
4. Navigate to 'Method' and select this menu.
5. Select 'Off',   'On' or 'Reinforce'.
6. Press the 'on-line' key to turn the printer on-line.
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Define the binding edge value

Before you begin

Use the   key, the  key and the 'previous' key to navigate. Use the  
'next/select' key to select a menu or a value.

How to define the binding edge value

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Folding'  and select this menu.
3. Navigate to 'Binding edge' and select this menu.
4. Navigate to 'Method' and select this menu.
5. If you selected  'On' in the (see ‘How to define the binding method’ on 

page 239)                       procedure, enter a range between 15 - 30 mm, in steps 
of 1 mm; Default value is 20 mm.

6. Press the 'on-line' key to turn the printer on-line.
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Define the folded package size

Define the folded package length

Before you begin

Use the   key, the  key and the 'previous' key to navigate. Use the  
'next/select' key to select a menu or a value.

How to define the folded package length

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to'Folding'  and select this menu.
3. Navigate to 'Package' and select this menu.
4. Navigate to 'Length' and select this menu.
5. Enter a range between 276 - 310 mm in steps of 1 mm; Default value is 297 

mm.
6. Press the 'on-line' key to turn the printer on-line.
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Define the folded package width

Before you begin

Use the   key, the  key and the 'previous' key to navigate. Use the  
'next/select' key to select a menu or a value.

How to define the folded package width

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to'Folding'  and select this menu.
3. Navigate to 'Package' and select this menu.
4. Navigate to 'Width' and select this menu.
5. Enter a range between 186 - 230 mm in steps of 1 mm; Default value is 210 

mm.
6. Press the 'on-line' key to turn the printer on-line.
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The reinforcement unit

Introduction

If your folder has a reinforcement unit, you can deliver your output with a 
perforated, self-adhesive strip.

[53] Example of a reinforcement strip

[53] Example of a reinforcement strip

Note: You can only use reinforcement strips with the 'Standard' folding method.
The reinforcement strip allows you to store your copy in a binder. The punch 
holes will not wear out. You can unfold a folded map in a binder while the 
binding mechanism remains closed.

[54] Example of a folded map with a reinforcement strip

[54] Example of a folded map with a reinforcement strip

The reinforcement unit supports all media sizes larger than A4.
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The belt unit

Introduction

If your folder has a belt unit, you can stack a maximum of 75 folded A0 prints.

You can adjust the side guides of the belt, depending on the width of the folded 
package.

Before you begin

Select 'Belt' as folded output delivery, as described in the (see ‘How to define 
the folded output delivery’ on page 236) procedure.

How to adjust the side guides of the belt

1. Loosen the nuts
[55] Adjust the side guides

[55] Adjust the side guides

2. Adjust the plate in accordance with the width of the fold package.
3. Tighten the nuts.
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Off-line folding

Introduction

An important feature provided by the folder is off-line folding. You can use the 
same settings for off-line folding and normal folding. Define the default 
settings for off-line folding in the Océ Settings Editor. Do not fold Polyester or 
transparent media. This media can cause media jams.

Note: Use off-line folding only for the sheets that do not exceed a maximum 
length of 6 m. If you try to fold a sheet longer than 6 m, an error occurs.

How to make off-line folds

1. Press the 'on-line' key on the printer operator panel and watch the light on the 
top cover of the folder.
[32] Indication light folder

[32] Indication light folder

Note: See the label on the top cover of the folder.
2. Make any setting for (off-line) folding on the printer operator panel.
3. Feed the sheet of paper face down and with the legend on your right-hand side. 

Note: Wait until the light on the folder no longer blinks before you feed a new 
sheet. A media jam can occur.

4. Collect your output.

If Then

the light is off the printer is on-line and off-line folding is not 
possible.

the light blinks slowly the printer is off-line but the folder is still 
processing the last prints.

the light blinks rapidly an error has occurred

the light is on the printer is off-line and you can feed a sheet.
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Clear the set memory

Introduction

The Océ TDS450 has the following two memories.
■ The set memory.

The set memory contains the copy and print jobs. The Océ System Control 
Panel shows the use of the set memory.

■ The temporary store.
The temporary store contains the files you made with the scan-to-file jobs. 
You can clear the temporary memory with the Océ Scan Manager(see 
‘Clear the temporary store’ on page 154).

Before you begin

The system tells you when you need to clear the set memory. You can clear the 
set memory at the Océ Queue Manager and at the printer operator panel. Océ 
advises you to clear the set memory with the Océ Queue Manager if possible.
When you clear the set memory at the printer operator panel, use the  key, the 

 key and the 'previous' key to navigate. Use the 'next/select' key to select a 
menu or a value.

Attention: When you clear the set memory at the printer operator panel, all 
copy and print jobs are deleted. You can never undo this action.

Clear the set memory at the Océ Queue Manager

1. Start the Océ Queue Manager.
2. Delete jobs from the Océ Queue Manager.

(see ‘How to cancel jobs from the Océ Queue Manager’ on page 145)
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Clear the set memory at the printer operator panel

1. Make sure you have access to the system settings.
(see ‘How to access the system settings’ on page 123)

2. Navigate to ‘Clear setmem’ and select this setting.
3. Select 'Yes'
4. Press 'next/select' to confirm. 
5. Press 'on-line' to put the printer on-line again.
6. Shut down the Océ Power Logic controller.

(see ‘How to shut down the Océ Power Logic® controller’ on page 114)
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Maintain the Océ TDS450 scanner

Clear an original jam

Introduction

A red light at the scanner operator panel indicates that an original jam 
occurred.

How to remove a jammed original

1. Pull the top cover towards you and lift the top cover to open it.
[56] Open the top cover

[56] Open the top cover

2. Remove the original.
3. Lift the top cover, turn the top cover towards you and push the top cover 

backwards until you hear or feel a click.

Result

The green light at the scanner operator panel is on.
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Scanner error-messages and solutions

Introduction

When an error occurs, the Océ TDS450 scanner shows the following 
information.
■ The error-message icon
■ The error message
■ A description of the solution
■ An error code
■ Functions at the lower softkeys.

In some cases you need these functions, like wind and rewind for example, 
to come to the solution.

How to handle error messages at the scanner

1. Read the error message carefully
[57] The error-message icon

[57] The error-message icon

2. Follow the instructions on the scanner operator panel.

Result

You solved the error with the help of the instructions on the scanner operator 
panel.
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Calibrate the scanner

Introduction

You can calibrate the scanner when you are not satisfied with the scan quality. 
Use the calibration wizard to calibrate the scanner.

How to calibrate the scanner

1. Select 'System' with the lower-right softkey.
The 'System settings' screen opens.

2. Select 'Scanner calibration' with a left softkey to start the calibration wizard.
The message 'Insert calibration sheet' and the following icon appears.
[58] The 'Insert calibration sheet' icon

[58] The 'Insert calibration sheet' icon

3. Insert the calibration sheet and press the green start key to start the calibration 
process.
The message 'Scanner is calibrating...'  and the following icon appears.
[59] The 'Scanner is calibrating...' icon

[59] The 'Scanner is calibrating...' icon

When the calibration process is ready, the message 'Press OK to continue' and 
the following icon appears.
[60] The remove the calibration sheet icon

[60] The remove the calibration sheet icon

4. Select 'OK' with the lower-right softkey.
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Note: When the calibration process stops or  fails, follow the instructions on 
the scanner operator panel carefully.

Result

The Océ TDS450 scanner is calibrated and the scan quality is correct again.
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Clean the scan area

Introduction

You need to keep the glass plate clean. A dirty glass plate causes a decreased 
copy and scan quality. Clean the glass plate when you have lines on the image 
that are not on the original.

Required tools

Océ cleaner A, part of cleaning kit with codenumber 1068117

Two lint-free cloths

Attention: Use Océ cleaner A to get the best results.

Attention: Make sure you do not damage the sensor at the right of the glass 
plate.

How to clean the glass plate

1. Turn off the Océ TDS450 scanner.
2. Pull the top cover towards you and lift the top cover to open it.

[61] Open the top cover

[61] Open the top cover
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3. Clean the glass plate and the white plate with a lint-free cloth and a small 
quantity of the cleaner.
[62] Do not damage the sensor at the right side in front of the glass plate.

[62] Do not damage the sensor at the right side in front of the glass plate.

4. Dry the glass plate and the white plate with another lint-free cloth.
5. Clean the white plate.
6. Lift the top cover, turn the top cover towards you and push the top cover 

backwards until you hear or feel a click.
7. Turn on the Océ TDS450 scanner.
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Maintain the Océ TDS450 printer

Media

Load the media

Introduction

The Océ TDS450 printer is available with a roll unit for one or two rolls.
You can load each of the rolls on the Océ TDS450 printer with print media of 
a different size or type. 
The size and type of the available media are indicated on the operator panel.

If you install new print media, you must tell the system the size of the material 
and the type of print material. (paper, transparent, or polyester)

When a roll is empty during a print job, a ‘Roll empty’ message is displayed 
on the printer operator panel.  The message appears also on the Océ System 
Control Panel application. You must install a new roll of print material.

Install the paper on roll 1

1. Open the drawer completely.
[63] Open the drawer

[63] Open the drawer
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2. Remove the roll holder from the drawer
[64] Removing the roll holder from the drawer

[64] Removing the roll holder from the drawer

3. Remove the empty core from the roll holder when you press the knob.
4. Slide the roll holder in the new roll of media while pressing the knob. Make 

sure that the knob is at the right side and that the media is positioned as shown 
in the figure below.
[65] Press the knob

[65] Press the knob

34"
A0 36"
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5. Align the roll with the correct lines on the roll holder while pressing the knob. 
The line must be visible. 

6. Put the roll holder with the media in the drawer
[66] Reposition the roll

[66] Reposition the roll

7. Feed the media between the input guide plates against the rollers.
[67] Feed the media

[67] Feed the media

8. Turn the rollers until the media is visible. Also refer to the label inside the 
drawer.

9. If you inserted a roll with another media or with a different width, you must 
program the correct width and material type. If you need to cut the paper to get 
a straight leading strip, select ‘Cut media'.

10. Close the drawer.
11. Press the On-line key.
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Install the media on roll 2

1. Open the flap to get access to roll 2.
[68] Open the flap

[68] Open the flap

2. Remove the roll holder.
[69] Remove the roll holder 

[69] Remove the roll holder 
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3. Remove the empty core from the roll holder when you press the knob. 
4. Slide the roll holder in the new roll of media while pressing the knob. Make 

sure that the knob is at the right side and that the media is positioned as shown 
in the figure below.
[70] Press the knob

[70] Press the knob

5. Align the roll with the correct lines on the roll holder while pressing the knob. 
The line must be visible. 

6. Put the roll holder with the media in the lower paper compartment.
[71] Reposition the roll

[71] Reposition the roll

34"
A0 36"
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7. Feed the media between the input guide plates against the rollers.
8. Turn the rollers until the media is visible. Also refer to the label inside the 

drawer.
[72] Feed the media

[72] Feed the media

9. If you inserted a roll with another media or with a different width, you must 
program the correct width and media type. If you need to cut the paper to get 
a straight leading strip, select ‘Cut media'

10. Close the lower media compartment.
11. Press the On-line key.
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Define the media type and media size

Introduction

One of the features of the Océ TDS450 printer is the automatic media change 
function. This function allows the printer to take another roll of the same media 
format and media type in case you run out af media during a print job. You can 
activate this function in the Océ Settings Editor. 

Note: The media change will only take place if both rolls contain the same 
media format and media type.
Note: The Océ TDS450 printer can not identify the media format and media 
type. After you fill the media you must indicate the media type and media 
format in this menu.

Purpose

To define the media type and media size of a media roll

When to do

After you insert a new media roll.

Before you begin

Use the   key, the  key and the 'previous' key to navigate. Use the  
'next/select' key to select a menu or a value.

How to define the media size

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Media settings' and select this menu.
3. Navigate to 'Roll 1' or 'Roll 2' and select this menu.
4. Navigate to 'Width' select this menu.
5. Navigate to the required media size and select this value.
6. Press the 'on-line' key to turn the printer on-line.
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How to define the media type

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Media settings' and select this menu.
3. Navigate to 'Roll 1' or 'Roll 2' and select this menu.
4. Navigate to 'Material' select this menu.
5. Navigate to the required media type and select this value.
6. Press the 'on-line' key to turn the printer on-line.
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Cut the media

When to do

If the media does not have a straight leading strip, you can cut the media at a 
right angle from the roll.

Before you begin

Use the   key, the  key and the 'previous' key to navigate. Use the  
'next/select' key to select a menu or a value.

How to cut the media

1. Press the 'on-line' key to turn the printer off-line.
2. Open the drawer and feed the media manually until it is 5 cm above the top 

drawer.
3. Close the drawer.
4. Navigate to 'Media settings' and select this menu.
5. Navigate to 'Cut media' and select this value.
6. Open the drawer and remove the scrap of media.
7. Feed the media until it is visible. 

[73] Insert the media

[73] Insert the media

8. Close the drawer.
9. Press the 'on-line' key to turn the printer on-line.
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Define the media series of the Océ TDS450 printer

Introduction

You need to define which media series to use.

Before you begin

Use the   key, the  key and the 'previous' key to navigate. Use the  
'next/select' key to select a menu or a value.

How to define the media series of the Océ TDS450 printer

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Configuration' and select this menu.
3. Navigate to 'Paper series' and select this menu.
4. Navigate to the required media series and select this value.
5. Press the 'on-line' key to turn the printer on-line.

Result

The required media series is defined.
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Toner

Refill the toner

Introduction

If the ‘Refill toner’ message appears on the printer panel, you must refill the 
toner immediately.

Attention: Use only B5 toner.

Refill the toner

1. Turn off the printer.
2. Open the left cover.

[74] Open the cover

[74] Open the cover
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3. Shake the toner bottle thoroughly and open the bottle.
4. Screw in the bottle clockwise in a slanted position.

5. Move the toner bottle upwards into a vertical position

6. Tap the toner bottle gently to let the toner flow from the bottle.
7. When the toner bottle is empty, return the bottle to the original position.  Turn 

the bottle in counter clockwise direction to remove.
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Replace the waste toner bag

Attention: Replace the toner waste bag, when you refill the toner.

1. Pull the waste toner bag from the holder and place the cap provided on the bag 
on the opening.

2. Slide a new waste toner bag over the holder.
3. Close the cover.
4. Turn on the printer.
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Handle media jams at the Océ TDS450 printer

Printer error-messages and solutions

Introduction

The following table shows a list of error messages. You can use this table to 
find a description and the solution.

The error messages

Error message Description / solution

'Copy too late'
'Remove paper'
'Press <on-line>'

A media jam occurred. Remove the stuck media and press 
on-line.
(see ‘Clear media jam in the media feed section of the printer’ 
on page 274)
(see ‘Clear media jam in the fuser section’ on page 275)

'Speed failure'
'Remove paper'
'Press <on-line>'

A media jam occurred. Remove the stuck media and press 
on-line.
(see ‘Clear media jam in the media feed section of the printer’ 
on page 274)
(see ‘Clear media jam in the fuser section’ on page 275)

'Knife 1 error' 
'Remove paper'
'Press <on-line>'

An error occurred during the cut of the roll. Check the media 
on roll 1 and remove scrapped media if necessary. Press 
on-line.
(see ‘Load the media’ on page 256)

'Knife 2 error'
'Remove paper'
'Press <on-line>'

An error occurred during the cut of the roll. Check the media 
on roll 1 and remove scrapped media if necessary. Press 
on-line
(see ‘Load the media’ on page 256)

'Roll retract err'
'Press <on-line>'

A media roll error. Check the media on the rolls and press 
on-line.
(see ‘Load the media’ on page 256)
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'Roll init error'
'Open roll unit'
'Press <on-line>'

The media of a roll was not in the start position while the 
printer was turned on. Place the media back into the start 
position and press on line.
(see ‘Load the media’ on page 256)

'Input too late'
'Open roll unit'
'Press <on-line>'

The input sheet is too late.  Open the roll unit, withdraw roll 
and rewind. Press on-line

'Deposit error'
'Press <on-line>'

An error occurred in the compact output stacker.  The 
compact output stacker stops.  The print process continues. 
Press <on-line>.

'Illegal language at 
controller'
'Press <on-line>'

The controller has an illegal language. The controller uses the 
English language instead of the selected language. Call your 
Océ representative and press on-line.

'Close roll unit'
'Rewind paper'
'Press <on-line>'

The roll unit was opened during the print process.  Open the 
roll unit, rewind the paper and close the roll unit. Press on-line

'Error 1st fold' A media jam occurred in the first fold section of the folder.  
Clear the media jam and press on-line.
(see ‘Clear media jams in the folder’ on page 293)

'Error in folder' A tape jam occurred in the reinforcement unit or a media jam 
occurred  in the folder. A media jam can occur in the transport 
section  of the folder or in the reinforcement unit of the folder.  
Clear the tape jam or clear the media jam and press on-line.
(see ‘Clear media jams in the folder’ on page 293)
(see ‘Clear tape jam in the reinforcement unit’ on page 291)

'Error 2nd fold' A media jam occurred in the second fold section of the folder.  
Clear the media jam and press on-line.
(see ‘Clear media jams in the folder’ on page 293)

'Wrong format' The folder detected a media format other than specified on the  
printer operator panel.  Correct the format at the printer 
operator panel.
(see ‘Define the media type and media size’ on page 262)

Error message Description / solution
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Printer system-messages and solutions

Introduction

The following table shows a list of system messages. You can use this table to 
find a description or solution.

The system messages

System message Description / solution

'Off-line' The printer is off-line.
You can change the settings.

'Roll empty' Try the following solutions.
■ Load new media on the  roll.
(see ‘Load the media’ on page 256)
■ Make sure that the media is fixed on the roll holder.
■ Make sure the media contains no bulge.

'Open left cover'
'Refill toner'
'Press <on-line>'

■ Refill the toner.
(see ‘Refill the toner’ on page 266)

'Remove original' Try the following solutions.
■ Close the top cover.
■ Make sure that all media scraps are removed.
■ Turn the printer off and on.
(see ‘Turn the Océ TDS450 printer on and off’ on 
page 115)

'Cutter error' ■ Make sure that the media thickness is according to the 
specifications.

(see ‘Specifications Océ TDS450 scanner’ on page 302)
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'Connecting...' There is no connection between the controller and the 
printer. Try the following solutions
■ Wait for five minutes.
■ Turn the system off and on.
(see ‘Turn the Océ TDS450 scanner on and off’ on 
page 112)
(see ‘Turn the Océ TDS450 printer on and off’ on 
page 115)
(see ‘Turn on and shut down the Océ Power Logic® 
controller’ on page 114)

'Reset printer' Turn the printer off and on again.
(see ‘Turn the Océ TDS450 printer on and off’ on 
page 115)

'Printer asleep' The printer is in low power mode to save energy.

'Please wait' The printer downloads the language.

'Printer ready' The printer is ready to print.

'Preparing job' The printer prepares a copy or print job.

'Load roll 1'
'A2'
'Paper'

The required media is not loaded on roll 1. Load the 
required media.
(see ‘Load the media’ on page 256)

'Load roll 2'
'A2'
'Paper'

The required media is not loaded on roll 2. Load the 
required media.
(see ‘Load the media’ on page 256)

'Manual feed' The required media is not found. Feed the required media 
at the manual feed table.
(see ‘Make a copy on a cut sheet’ on page 201)

'Conditioning' The printer optimizes the toner concentration. Please 
wait.

'Printer ready'
'Roll 1 empty'

Media roll 1 is empty. Reload roll 1.
(see ‘Load the media’ on page 256)

'Printer ready'
'Roll 2 empty'

Media roll 1 is empty. Reload roll 1.
(see ‘Load the media’ on page 256)

'Printer running'
'Roll 1 empty'

Media roll 1 is empty. Reload roll 1 when the printer is 
ready.
(see ‘Load the media’ on page 256)

System message Description / solution
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'Printer running'
'Roll 2 empty'

Media roll 2 is empty. Reload roll 1 when the printer is 
ready.
(see ‘Load the media’ on page 256)

'Job cancelled' The active print or copy job is cancelled.

'Close roll unit' The roll unit is open. Close the roll unit.

'Sensor not free'
'Remove paper'
'Press <on-line>'

The media of a roll was not in the start position while the 
printer was turned on. Turn the media back into the start 
position and press on line.

'Paper retracted'
'Press <on-line>'

The cut sheet was retracted. Feed the cut sheet at the 
manual feed table.

'Copy too short'
'Remove paper'
'Press <on-line>'

Use an original longer than 420 mm.

'Input flap open'
'Close input flap'

The input flap is open. Close the input flap.

'Input flap open'
'Remove paper'
'Close input flap'

The input flap was opened during the print process. 
Remove the media and close the input flap again

'Roll 1 empty'
'Open roll unit'

Replace the media on roll 1
(see ‘Load the media’ on page 256)

'Roll 2 empty'
'Open roll unit'

Replace the  media on roll 2
(see ‘Load the media’ on page 256)

'Wait for folder' The communication between the printer and the folder 
starts up. Please wait.

'Folder is off' The folder is turned off. The communication between the 
printer and the folder was not created.

'Folder belt full' Empty the folder belt.

'RU tape empty' The tape roll of the Reinforcement Unit is empty. Open 
the reinforcement unit and replace the tape roll.
(see ‘Insert a new tape roll’ on page 277)

System message Description / solution
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Clear media jam in the media feed section of the printer

Introduction

If a media jam occurs, a message appears on the operator panel. In that case 
check if
■ The roll is installed correctly and the media is fed as indicated.
■ The correct media is used ((see ‘Available media types’ on page 310) and 

(see ‘Available media sizes’ on page 312)).
■ No pieces of media block the paper path.

Clear a media jam in the media feed section

1. Turn off the printer.
2. Open the correct roll compartment.

Note: You must open one (1) compartment at a time.
3. Lower the feed table, use the two locks on the front below the feed table.

4. Remove the jammed media.
5. Close the feed table.
6. Close the roll compartment.
7. Turn on the printer.

Note: If you can not clear the media jam by opening the feed table, then open 
the fuser section. See (see ‘Clear media jam in the fuser section’ on page 275)
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Clear media jam in the fuser section

Clear the jam in the fuser section

Caution: Open the fuser only to remove the media after a media jam. Do not 
remove the materials from the fuser without heat-protective gloves. The 
surface of the fuser is hot.

1. Turn off the printer.
2. Loosen the screw at the left hand side of the machine and open the cover.

3. Lift the green handle.
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4. Open the fuser unit.

5. Remove the jammed material. 
6. Lift the green handle and close the fuser unit.
7. Close the left cover and tighten the screw.
8. Turn on the printer.
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Maintain the finishing options

The reinforcement unit

Insert a new tape roll

Introduction

When the tape roll is empty while the printer is in stand-by, the following 
message will appear on the display: 'RU tape empty'. Open the reinforcement 
unit and replace the empty tape roll.

Remove an empty tape roll

Attention: To prevent damage to the reinforcement unit, only use the 
original reinforcement strips from Océ.

1. Open the side door of the reinforcement unit.
[75] Opening the side door of the reinforcement unit

[75] Opening the side door of the reinforcement unit
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2. Turn the two guide plates away from the pin roller and lock the two guide 
plates into their open position.
[76] Opening the guide plates

[76] Opening the guide plates

3. Remove the trailing strip of the old tape.
[77] Removing the trailing strip of the old tape

[77] Removing the trailing strip of the old tape

4. Open the front side plate of the roll holder (remove the screw and the old 
kernel.)
Note: Clean the reinforcement knives before you put in a new roll. See ‘(see 
‘Clean the reinforcement knives’ on page 287)
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Insert a new tape roll

1. Put the new roll and close the side plate. Make sure that the roll is placed with 
the holes to the back and the protection sheet to the front.
[78] Placing the new roll

[78] Placing the new roll

2. Loosen the end of the roll and lead the tape over the large guide roller.
[79] Guiding the tape around the guide roller

[79] Guiding the tape around the guide roller
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3. Guide the tape between the upper and lower knife and over the pin roller.
[80] Leading the tape between upper and lower knife

[80] Leading the tape between upper and lower knife

4. Make sure that at least 200 mm (2 strip lengths) of tape bulges out of the knife 
section.
[81] Protruding tape

[81] Protruding tape
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5. Align the holes in the tape with the hole pattern on the label. (You can find the 
label on the frame plate of the reinforcement unit.) Lift the tape from the pin 
roller and push the tape between the two knives until the holes are aligned.
[82] Adjusting the holes on the tape

[82] Adjusting the holes on the tape

6. Close the guide plates of the pin roller.
[83] Closing the guide plates

[83] Closing the guide plates
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Prepare the tape roll for operation

1. Remove the protection sheet from the tape.
[84] Peeling off the protection sheet

[84] Peeling off the protection sheet

2. Guide the protection sheet back between the upper and lower knife.
[85] Leading the protection  sheet between upper and lower knife

[85] Leading the protection  sheet between upper and lower knife
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3. Lift the guide and move the protection sheet between the protection sheet 
rollers. Pull the protection sheet tight.
[86] Leading the protection sheet between the rollers

[86] Leading the protection sheet between the rollers

4. Insert the strip of the tape into the closed section of the slide.
[87] Inserting the tape into the closed section of the slide.

[87] Inserting the tape into the closed section of the slide.
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5. Hold the upper guide plate down and cut the tape at the knife section. (Quickly 
pull the strip up so that the upper knife cuts the tape.)
[88] Cutting the tape at the knife section

[88] Cutting the tape at the knife section

6. Close the side door of the reinforcement unit.
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Empty the waste box

Introduction

If a reinforcement unit is installed, the protective sheet from the reinforcement 
tape is stored in a waste box. For each roll of tape, you must empty the box 
twice.

Empty the waste box

1. Open the waste box:
■ First pull the waste box to the left hand side
■ Next pull the waste box to the front
[89] Opening the waste box

[89] Opening the waste box
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2. Empty the box.
3. Close the waste box ( and .)

■ First push the waste box forward
■ Next push the waste box to the right hand side
[90] Closing the waste box

[90] Closing the waste box
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Clean the reinforcement knives

Introduction

The knives of the reinforcement unit get sticky from the glue on the 
reinforcement tape. You must clean the knives regularly. If you clean the 
reinforcement knives, you must put the knives in such a position that you have 
access to all the parts.

You are recommended to clean the knives when
■ You install a new tape roll (see (see ‘Insert a new tape roll’ on page 277)) or 
■ When an error in the reinforcement unit has occurred.

Clean the reinforcement knives

Attention: Only use the original Cleaner K and Fixing Unit Cleaning Oil 
(silicon oil) from Océ, to prevent damage to the reinforcement unit.

1. Press the On-line key on the printer operator panel.
2. Select ‘Folding’ with the left or right key.
3. Press the down key to enter the ‘Folding’ menu.
4. Select ‘Clean RU knife’ with the left or right key.
5. Press the down key to put the reinforcement unit knives in the correct position.
6. Open the side door of the reinforcement unit.
7. Clean the upper and lower knife using Cleaner K.

[91] Cleaning the upper and lower knife

[91] Cleaning the upper and lower knife
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8. Use the Fixing Unit Cleaning Oil (silicon oil) to oil the felt.
[92] Oiling the felt

[92] Oiling the felt

9. Close the side door of the reinforcement unit. The knives are automatically put 
back in their home positions. This  depends on whether or not a job was 
interrupted to clean the knives. 

10. Press the On-line key.



Maintain the Océ TDS450 289

Handle errors at the reinforcement unit

No reinforcement strips on the output

Introduction

When there is no reinforcement strip on the output, then
■ The reinforcement strip is not correctly installed, or
■ The reinforcement strip is not available.

Install a new reinforcement strip

1. Press the On-line key on the operator panel to put the printer off-line.
2. Open the side door of the reinforcement unit.
3. Check for loose reinforcement strips in the unit with the protection sheet on 

(see situation B in figure 118).
[93] Situation A: No mechanical error. Situation B: Mechanical error.

[93] Situation A: No mechanical error. Situation B: Mechanical error.
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4. If there are, remove the tape strips in the reinforcement unit.
[94] Removing the tape

[94] Removing the tape

Note: If the protection sheet is not on the reinforcement strip, there is no 
mechanical error. You must insert a new tape roll (see ‘Insert a new tape roll’ 
on page 277). If this error frequently occurs, you must call your Océ 
representative.

5. Remove all tape between the rollers and the knives .
6. Install a new trailing strip of tape between the rollers and the knives.
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Clear tape jam in the reinforcement unit

Introduction

When a tape jam occurs in the reinforcement unit, the following message 
appears on the display: 'Error in folder'.

Illustration
[95] Location of the reinforcement unit

[95] Location of the reinforcement unit

Clear a tape jam

1. Open the front door of the reinforcement unit
[96] Opening the front door of the reinforcement unit

[96] Opening the front door of the reinforcement unit
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2. Turn the two guide plates away from the pin roller and lock the two guide 
plates into their open position.

3. Remove all tape between the rollers and the knives.
[97] Removing the tape

[97] Removing the tape

4. Move a new trailing strip of tape between the rollers and the knives.
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Handle media jams at the folder

Clear media jams in the folder

Introduction

Any jams in the folder can occur in either the first fold section, the folder  
transport section, the second fold section or the belt unit.

Clear a jam in the first fold section

1. Open the top cover of the folder. The green light on the right of the folder 
blinks quickly.
[98] Top cover of the folder

[98] Top cover of the folder
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2. Remove any jammed material.
3. Open the cover of the first fold section.

[99] Opening first fold section

[99] Opening first fold section

4. Open the guide plate.
[100] Opening guide plate

[100] Opening guide plate

5. Remove any jammed material.
6. Close the guide plate.
7. Close the cover of the first fold section.
8. Close the top cover of the folder.
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Clear a jam in the folder transport section

1. Open the cover of the transport section to the first fold delivery.
[101] Opening the cover of the folder transport section

[101] Opening the cover of the folder transport section

2. Remove any jammed material.
3. Close the cover of the folder transport section from the left side. (Lift and push 

the hinge to the rear.)

Clear a jam in the second fold section

1. Open the front door of the second fold section.
[102] Opening the front door of the second fold section

[102] Opening the front door of the second fold section
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2. Remove any jammed material at the bottom of the second fold section.
3. Close the front door of the second fold section.
4. If you have a belt unit, put the belt in an upward position.

[103] Putting the belt in an upright position

[103] Putting the belt in an upright position

5. Open the delivery unit.
[104] Opening the delivery unit

[104] Opening the delivery unit
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6. Open the guide plate with the green lever.
[105] Opening the guide plate with the green lever

[105] Opening the guide plate with the green lever

7. Remove any jammed material.
8. Open the vertical transport unit with the green lever.

[106] Opening the vertical transport

[106] Opening the vertical transport
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9. Remove any jammed material.
10. Close the vertical transport unit.

[107] Closing the vertical transport

[107] Closing the vertical transport

11. Close the guide plate.
12. Close the delivery unit.

[108] Closing the delivery unit

[108] Closing the delivery unit



Maintain the Océ TDS450 299

Clear a jam in the belt unit

1. Open the door of the belt unit.
[109] Opening the belt unit door

[109] Opening the belt unit door

2. Press the two green knobs in the upper section of the belt unit and open the 
plate.
[110] Opening the plate

[110] Opening the plate
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3. Remove any jammed material.
4. Press the two knobs again and put the plate in its original position.
5. Release the green lever in the lower section of the belt unit. (lift and pull 

forward the lower section to open the lower plate.)
[111] Opening the lower plate

[111] Opening the lower plate

6. Remove any jammed material.
7. Pull the green lever again (until it locks into position) to close the plate.
8. Close the belt unit door.
9. Put the belt in the operation position (Push down carefully).
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Specifications Océ TDS450 scanner

Technology ■ Free-standing console
■ Océ Image Logic® real-time image processing
■ 1 x Reduction type CCD camera

Scan speed 
(standard)

Black&white
■ 3 m/min. or 2 inch/sec.

Greyscale & Colour
■ 1 m/min. or 0.7 inch/sec.

Scan speed (option) Black&white
■ up to 5 m/min. or 3.3 inch/sec.

Greyscale & Colour
■ up to 4 m/min. or 2.8 inch/sec.

Resolution 575 dpi

Camera 3 colour linear CCD  
21360 Pixels
24 bits colour 

Scan width 914.4 mm 

Original feed Right aligned

Original size Minimum
■ 210 mm x 210 mm (L x W)

Maximum
■ 6000 mm x 1016 mm (L x W).

Maximum media 
thickness

1.5 mm

Scale method ■ Scale to format.
Scale range 25% - 400% (0.1% fixed step interval).
■ Custom scale.
Scale range 10% - 1000% (0.1% fixed step interval).
■ Exact (1 to 1).
No scaling.

Input mode ■ Single sheet
■ Set

Number of copies 1 - 999 (scan once print many)

Colour space SRGB
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Image quality ■ Original type selection (see ‘Original types for the Océ 
TDS450 scanner’ on page 304)

■ Colour selection (Black&White / Grey / Colour)
■ Brightness light/dark
■ Image optimization for fine details or speed

Image editing ■ Remove strips (leading/trailing/left/right)
■ Mirroring horizontal
■ Delete area

Other 
functionalities

■ Pre-programming of next job
■ Programmable default settings
■ Synchro cut mode
■ Leading and trailing strip adjustment (0 mm - 400 mm)
■ Concurrent scanning and printing
■ Scan to file Black&White / Grey  (option).
■ Scan to file Colour (option).

Interface Firewire

Voltage 85-264 V

Frequency 47/63 Hz

Power consumption In operation: 110 W
Standby: 20 W

Dimensions 1105 mm x 615 mm x 1240 mm (H x D x W)

Weight 65 kg

Safety approvals TüV GS, CE, UL, (c)UL, CB, EMC Directive 89/336/EEC, FCC 
Class A
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Original types for the Océ TDS450 scanner

The original types that you can use for your Océ TDS450 scanner are listed in 
the table below.

[33] Original types

Original type Type Icon

Black & white / 
grey

'Lines&text'
[112] Lines / text icon

[112] Lines / text icon

'Greys&Lines'
[113] Greys & lines icon

[113] Greys & lines icon

'Transparent'
[114] Transparent icon

[114] Transparent icon

'Blueprint'
[115] Blueprint icon

[115] Blueprint icon
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[33] Original types

'Dark original'
[116] Dark original icon

[116] Dark original icon

Colour 'Photo'
[117] Photo icon

[117] Photo icon

Original type Type Icon
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Specifications Océ Power Logic® controller

Océ Power Logic® controller hardware

Platform Océ controller with Windows® XP embedded

Memory 512 Mb, expandable to 1024 Mb

Hard disc capacity 80 Gb. Two high speed hard discs, one dedicated to 
file spooling and one for set memory

Graphical user interface Optional keyboard, mouse and monitor

Standard interface 10/100BaseT with RJ45

Optional interfaces 10/100BaseT with RJ45

Network protocols TCP/IP, SMB, IPX/SPX, FTP, LPD

Power consumption Controller: < 100 W
Monitor: 200 W (depends on monitor type)

Electrical requirements 100-120 / 230 V, 50/60 Hz

Applicable software Océ Power Logic® controller software
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Océ Power Logic® controller software

The Océ Power Logic® controller software consists of a basic module and a 
print module.

[34] Basic module

[34] Basic module

[35] Print module

Basic functions File spooling on the controller.
Concurrent receiving, processing and printing of 
digital jobs.

Basic applications ■ Océ Settings Editor
■ Océ System Control Panel
■ Océ Queue Manager
■ Océ License Logic
■ Océ Remote Logic®

■ Océ Print Exec® Workgroup LT.

Optional ■ Océ Account Center.

Print processing technology Océ Image Logic

Number of prints 1 - 999
Set memory: send once, process once, print many

Roll selection and switching Manual
Automatic

Print manipulation Rotation
Auto-scaling
Positioning
Pen management
Trailing strip adjustment; add up to 400 mm

Colour modes ■ Black & White
■ Greyscale
■ Colour

Quality modes ■ Standard
■ Lines & Text
■ Poster

Language sensing Automatic Language Sensing (ALS)

Standard file formats ■ Vector: HPGL, HPGL/2, Calcomp
■ Raster: HP-RTL, TIFF 6.0, NIFF, CALS-I, 

NIRS, C4, ASCII
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[35] Print module

Cut length ■ Standard cut
■ Synchro cut
■ Custom cut

Optional Adobe® PostScript 3 PDF printing
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Specifications Océ TDS450 printer

Technology Electrophotography (LED) with organic 
photoconductor (OPC) drum and closed toner 
system

Resolution 600 dpi

Print speed 3 linear meters per minute or approximately 2A0s 
per minute.

Media sources 1 roll version with manual feed
2 roll version with manual feed

Guaranteed print 
length

15 meters

Output delivery Standard Integrated Receiving Tray (IRT) 

Output sizes From A3 to A0 and 36"

Warm up time None, instant behaviour

Media types Plain, translucent, transparent, recycled, fluorescent 
and coloured papers.
Films and vellum

Voltage 100/115/230 V

Frequency 50/60 Hz

Power consumption Standby: 30 W
In operation: 1,5 kW

Dimensions 1250 mm x 899 mm x 1352 mm (H x D x W), 
including Integrated Receiving Tray

Weight Model with 1 roll: 149 kg.
Model with 2 rolls: 159 kg.



310 User manual

Supported media types and sizes for the 
Océ TDS450 printer

Available media types

Introduction

Océ machines and media are matched for the best quality and performance. 
Océ advises only approved Océ media. You can receive a full list of the Océ 
media that you can use in your printer (that includes plain paper, transparent 
paper, coloured papers and different polyester films) from your Océ 
representative.

Attention: Do not store the paper in rooms where temperature and humidity 
are high. Avoid dust and direct sunlight. Wrap not used paper in the plastic 
to prevent it absorbing moisture.

Media types

The following media types are available for the Océ TDS450 printer:

Media Type Océ TDS450

Océ Papers LFM 110 Océ Top Label Paper 60 
g/m2

*

LFM 115 Océ Top Label Paper 75 
g/m2

****

LFM 116 Océ Top S Label Paper 75 
g/m2

****

LFM 120 Océ Top Label Paper 90 
g/m2

***

LFM 124 Océ Top Label Paper 100 
g/m2

** 1)

LFM 050 Océ Red Label Paper 75 
g/m2

****
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Note: 1) Guaranteed up to 50% ambient relative humidity
**** = Excellent

***     = Very Good

** = Good

* = Fair

Note: Visit Océ on the internet at www.oce.com for the latest information.

LFM 021 Océ Black Label Paper 75 
g/m2

****

LFM 010 Eng. Standard Paper 75 
g/m2

****

LFM 140 Océ Green Label TCF 80 
g/m2

****

Océ Transparent 
Papers

LFM 220 Océ Translucent Paper 80 
g/m2

**

LFM 230 Océ Translucent Paper 90 
g/m2

**

LFM 240 Océ Translucent Paper 110 
g/m2

** 1)

Océ Polyester Films LFM 310 Océ Polyester Film 3.5 
mm

***

LFM 320 Océ Antistatic Film 3.5 
mm

***

Océ Specialities LFM 410 Océ Fluorescent Paper  90 
g/m2

**

LFM 420 Océ Coloured Paper 80 
g/m2

****

Media Type Océ TDS450
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Available media sizes

Introduction

Océ machines and media are matched for the best quality and performance. 
Océ advises only approved Océ media. You can receive a full list of the Océ 
media that you can use in your printer (that includes plain paper, transparent 
paper, coloured papers and different polyester films) from your Océ 
representative.

Attention: Do not store the paper in rooms where temperature and humidity 
are high. Avoid dust and direct sunlight. Wrap not used paper in the plastic 
to prevent it absorbing moisture.

Media sizes

DIN range

Engineering Inch range

Media Width [mm] Length [mm]

A3 297 420

A2 420 594

A1 594 841

A0 841 1189

Media Width [inch] Length [inch]

11 inch / B 11 17

17 inch / C 17 22

22 inch / D 22 34

34 inch / E 34 44
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Architectural Inch range

Others

Media Width [inch] Length [inch]

12 inch / B+ 12 18

18 inch / C+ 18 24

24 inch / D+ 24 36

36 inch / E+ 36 44

Media Width Length

30 inch 30 inch 12 inch

B1+ 700 mm 1000 mm

B1 (DIN) 707 mm 1000 mm

B2+ 500 mm 700 mm

B2 (DIN) 500 mm 707 mm
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Standard scale factor

Introduction

The Océ TDS450 can scale (reduce and enlarge) the image to a defined format.
The overview below shows the scale factor if you need to copy on media of 
different sizes.

Attention: If you select the wrong scale factor you can loose information.

Supported DIN media series

The table shows the scale factor if you copy from one media size (original 
column) to another media size (first row)

[36] DIN table

[36] DIN table

Origina
ls

Standard scale fixed steps for the DIN media series [%]

A0 A1 A2 A3 36 
Inch

B1 B2

A0 100 71 50 35 109 84 59

A1 141 100 71 50 153 119 84

A2 200 141 100 71 218 168 119

A3 283 200 141 100 308 238 168

36 Inch 107 65 46 32 100 77 55

B1 119 84 59 42 129 100 71

B2 168 119 84 59 183 141 100
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Generic ISO media series

The table shows the scale factor if you copy from one media size (original 
column) to another media size

[37] ISO table

[37] ISO table

Original
s

Standard scale fixed steps for the ISO media series [%]

A0 A1 A2 A3 A4 A5

A0 100 71 50 35 - -

A1 141 100 71 50 35 -

A2 200 141 100 71 50 35

A3 283 200 141 100 71 50

A4 400 283 200 141 100 77

A5 565 400 283 200 141 100
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Specifications Océ Scan Logic®

Application Océ Scan Manager, integrated scanning solution with 
Océ View Station LT

Scan destinations Maximum of 10 destinations.
■ Scan to the local controller
■ Scan to a Microsoft® Windows network location with 

Server Message Block (SMB)
■ Scan to an internet location with File Transfer 

Protocol (FTP).

Resolution 72, 150, 200, 300, 400, and 600 dpi.

File formats ■ TIFF
■ PDF
■ CALS-I.

Available file 
organization 
types for TIFF 
files

■ RAW
■ Stripped
■ Tiled.

Available file 
compression 
methods

TIFF file format
■ None (uncompressed)
■ Group 3 2D
■ Group 4
■ Packbits
■ LZW.

PDF file format
■ Group 4
■ Flate
■ LZW.

CALS-I file format
■ Group 4.
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Available colour 
depths

TIFF file format
■ Black & white, 1 bit per pixel
■ Greyscale, 8 bits per pixel
■ RGB, 24 bits per pixel.

PDF file format
■ Black & white, 1 bit per pixel
■ Greyscale, 8 bits per pixel
■ RGB, 24 bits per pixel.

CALS-I file format
■ Black & white, 1 bit per pixel.

Scan mode Single scan.

File naming Automatically generate unique file names for each scan.

Viewing View scans at point of scanning.

Océ Image 
Logic® 

The best scan quality for different image types.

Ease of use Job templates
Scan to file from the scanner operator panel.
Scan directly to a local or a remote destination.

Requirements Océ Power Logic® Controller and a graphical user 
interface

Options Océ View Station for editing and enhancement of 
scanned documents
Océ Batch Processor for automated editing.
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Specifications drivers and job submission software

Océ drivers 

Software 
environment

Required driver Remarks

AutoCAD® 14 ( for 
Windows)

ADI Plotter Driver 
for  AutoCAD® 14

The driver allows you to plot 
from the AutoCAD® R14 
application for Windows® 
95, Windows® 98, Windows® 
ME, Windows® NT to Océ 
printers.

HDI AutoCAD® 
2000 family

AutoCAD® 2000 
family HDI drivers

The drivers allow you to plot 
from the AutoCAD® 2000, 
2000i, 2002, 2004, 2005 and 
2006 based applications to 
Océ plotters

Graphical 
application software

Océ TDS/TCS 
Adobe® Postscript 3 
Drivers

The drivers allow you to print 
from a Windows 95®, 
Windows 98®, Windows 
ME®, Windows NT®, 
Windows 2000®, Windows 
XP®, Macintosh MacOS 
8.6/9.x or Macintosh Mac OS 
X application to an Océ 
TDS300, Océ TDS450 Océ, 
Océ TDS600, Océ TDS800 
or Océ TCS400 wide-format 
printer.
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Note: Visit Océ on the internet at www.oce.com for the latest information.

Optional application software

Océ Windows 
Printer Driver (TDS)

This drivers is a mixed 
raster-vector HP-GL/2 
printer driver that allows you 
to print from any application 
under Windows NT 4.0, 
Windows 2000, Windows XP 
or Windows Server 2003 to 
your Océ TDS systems

Océ Windows Raster 
Driver (TDS)

The driver allows you to print 
from a Windows 98®, 
Windows ME®, Windows 
NT 4.0 ®, Windows 2000®, 
Windows XP® or Windows 
Server 2003® application to 
an Océ TDS450, Océ 
TDS600, or an Océ TDS800 
wide format printer. 

Function Application software

Job submission ■ Océ Print Exec® Workgroup
■ Océ Print Exec® Pro
■ Océ Repro Desk

Viewing ■ Océ View Station
■ Océ View Station and Batch Processor

Account Logging ■ Océ Account Center

Software 
environment

Required driver Remarks
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Reader's comment sheet 

Questions 

Have you found this manual to be accurate? 
O Yes 
O No

Were you able to operate the product, after reading this manual? 
O Yes 
O No 

Does this manual provide sufficient background information? 
O Yes 
O No 

Is the format of this manual convenient in size, readability and arrangement 
(page layout, chapter order, etc.)?
O Yes 
O No 

Could you find the information you were looking for? 
O Always 
O Most of the times 
O Sometimes 
O Not at all 

What did you use to find the required information? 
O Table of contents 
O Index 

Are you satisfied with this manual?
O Yes 
O No 

Thank you for evaluating this manual.
If you have other comments or concerns, please explain or suggest 
improvements overleaf or on a separate sheet. 



Miscellaneous 323

Comments:
---------------------------------------------------------------------------------------------
---------------------------------------------------------------------------------------------
---------------------------------------------------------------------------------------------
---------------------------------------------------------------------------------------------
---------------------------------------------------------------------------------------------
---------------------------------------------------------------------------------------
Date:

This reader's comment sheet is completed by: 
(If you prefer to remain unknown, please do fill in your occupation) 

Name:

Occupation:

Company:

Phone:

Address:

City:

Country:

Please return this sheet to: 

Océ-Technologies B.V.
For the attention of ITC User Documentation. 
P.O. Box 101, 
5900 MA Venlo
The Netherlands 

Send your comments by E-mail to: itc-userdoc@oce.nl 

For the addresses of local Océ organisations see: http://www.oce.com 
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Addresses of local Océ organisations 

Océ-Australia Ltd. 
P.O. Box 363
Ferntree Gully MDC
Vic 3165
Australia 
http://www.oce.com.au/ 

Océ-Osterreich GmbH 
Postfach 95
1233 Vienna
Austria 
http://www.oce.at/

Océ-Belgium N.V./S.A. 
J. Bordetlaan 32
1140 Brussel
Belgium 
http://www.oce.be/

Océ-Brasil Comércio e Indústria Ltda.
Av. das Nações Unidas, 11.857 
Brooklin Novo
São Paulo-SP 04578-000
Brasil 
http://www.oce-brasil.com.br/ 

Océ-Canada Inc. 
4711 Yonge Street, Suite 1100 
Toronto, Ontario M2N 6K8
Canada 
http://www.oce.ca/

Océ Office Equipment (Beijing) Co., 
Ltd.
Xu Mu Cheng
Chaoyang District
Beijing 100028
China 
http://www.oce.com.cn

Océ-Czech Republic ltd.
Hanusova 18
140 21 Praha 4
Czech Republic 
http://www.oce.cz/ 

Océ-Danmark a/s 
Vallensbækvej 45
2605 Brøndby
Denmark 
http://www.oce.dk/ 

Océ Finland OY
Valkjärventie 7 D, PL 3 
02130 Espoo
Finland 
http://www.oce.fi

Océ-France S.A. 
32, Avenue du Pavé Neuf
93161 Noisy-le-grand, Cedex 
France 
http://www.oce.fr/

Océ-Deutschland GmbH
Solinger Straße 5-7
45481 Mülheim/Ruhr
Germany 
http://www.oce.de/ 

Océ-Hong Kong and China head 
office
12/F 1202 The Lee Gardens
33 Hysan Avenue 
Causeway Bay
Hong Kong 
http://www.oce.com.hk/
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Océ-Hungaria Kft.
1241 Budapest
Pf.: 237
Hungary 
http://www.oce.hu/

Océ-Ireland Ltd.
3006 Lake Drive 
Citywest Business Campus
Saggart
Co. Dublin
Ireland 

Océ-Italia S.p.A. 
Strada Padana Superiore 2/B 
20063 Cernusco sul Naviglio (MI) 
Italia 
http://www.oce.it/ 

Océ Japan Corporation
3-25-1, Nishi Shinbashi
Minato-Ku
Tokyo 105-0003
Japan 
http://www.ocejapan.co.jp/

Océ-Belgium S.A.
Rue Astrid 2/A
1143 Luxembourg-Belair
http://www.oce.lu/indexfr.htm

Océ Malaysia Sdn. Bhd.
#3.01, Level 3, Wisma Academy 
Lot 4A, Jalan 19/1 
46300 Petalig Jaya 
Selangor Darul Ehsan
Malaysia 
www.ocemal.com.my

Océ-Mexico S.A. de C.V. 
Prolongación Reforma 1236, 
4to Piso 
Col. Santa Fé, Del. Cuajimalpa 
C.P. 05348 
México, D.F. 
México 
www.oceusa.com

Océ-Norge A.S. 
Postboks 4434 Nydalen
Gjerdrums vei 8
0403 Oslo
Norway 
http://www.oce.no

Océ-Poland Ltd. Sp.z o.o. 
ul. Bitwy Warszawskiej 1920 r. nr. 
7 
02-366 Warszawa  
Poland 
http://www.oce.com.pl 

Océ-Lima Mayer, S.A.
Av. José Gomes Ferreira, 11 Piso 2 - 
Miraflores 
1497-139 Algés
Portugal 

Océ Singapore Pte Ltd.
190 MacPherson Road
#03-00 Wisma Gulab 
Singapore 348548 

Océ Printing Systems (PTY) Ltd.
P.O.Box 629
Rivonia 2128
South Africa 
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Note: The web site http://www.oce.com gives the current addresses of the local 
Océ organisations and distributors.
Note: The addresses of local Océ organisations for information about the Wide 
Format Printing Systems and the Production Printing Systems can be different 
from the addresses above. Refer to the web site http://www.oce.com for the 
addresses you need.

Océ España SA 
Business Park Mas Blau
Osona, 2 08820 El Prat de 
Llobregat
Barcelona
Spain 
http://www.oce.es 

Océ-Svenska AB
Sollentunavägen 84
191 27 Sollentuna 
Sweden 
http://www.oce.se 

Océ-Schweiz AG 
Sägereistrasse 10
CH8152 Glattbrugg
Schweiz 
http://www.oce.ch

Océ (Thailand) Ltd. 
B.B. Building 16/Floor
54 Asoke Road
Sukhumvit 21
Bangkok 10110
Thailand 

Océ-Nederland B.V. 
P.O.Box 800 
5201 AV 's-Hertogenbosch 
The Netherlands 
http://www.ocenl.nl/ 

Océ (UK) Limited 
Océ House
Chatham Way
Brentwood, Essex CM14 4DZ 
United Kingdom 
http://www.oce.co.uk

Océ North America Inc.
5450 North Cumberland Avenue
Chicago, IL 60656
USA 
www.oceusa.com
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Index

A
access system settings 123
add a leading strip 203
add a trailing strip 203
auto original feed setting 139
auto view 153
automatic logon

enable 71
available media sizes 312
available media types 310
available settings 188

B
basic copy job 184
belt unit 92, 95

definition 244
media jam 299

binding edge value 233
binding method 233

C
calibrate scanner 252
calibrate wizard 252
cancel

print job 176
clean the glass plate 254
clean the scan area 254
clear an original jam 250
clear set memory 248
colour mode

black and white 224
colour 225
greyscale 224

common user 18
compact output stacker 92

components
folder 95
océ power logic® controller 28
océ tds450 printer 82
océ tds450 scanner 22

components
finishing options 92

concept 12
configuration report 117
controller

hardware
specifications 306

software
specifications 307

controller 82
controller setup 103
copy

a specific area 207, 209
on a cut sheet 201
with a stamp 197

copy an area 207
copy jobs

introduction 178
copy jobs

available settings 188
basic copy job 184
clear an original jam 250
extended copy job 185
stop a copy job 187

copy quality, according to
fine details 190
original brightness 190
original type 190

copy sets 194
cut sheet

print 174
cut sheet 201
cut the media of the printer 264

D
default gateway 127
define

the binding edge value 240
the binding method 239
the drawing method 238
the folded output delivery 236
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the folded package length 241
the folded package width 242
the folding legend 237

define media series
printer 265

define the media size of the printer 262
define the media type of the printer 262
delete an area 209
demo print 118
destination

manage 150
dhcp server 124
din media series 314
display languages

controller 119
printer 120
scanner 119

drawing method 233
drivers 318

E
error messages

printer error messages 269
scanner error messages 251

extended copy job 185

F
file name

define 152
file type

scan to file 224
finishing options

belt unit 92
compact output stacker 92
folder 92
output delivery tray 92
reinforcement unit 92

finishing options 92
finishing settings

overview 232
folded output delivery 233

define 236
folded package length 233

folded package width 233
folder 92

belt unit 95
components 95
media jam 293
reinforcement unit 95
stacker 95

folding
off-line 245

folding legend 233
fuser section

media jam 275

G
gateway 127
glass plate 254

I
install reinforcement strip

reinforcement unit 289
ip address 125
iso media series 314

J
job submission 98

printer drivers 172
job templates 137

scan-to-file 212

K
key operator 18

L
licenses 75
load media 256
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M
manual feed media type 174
media 256
media feed section

media jam 274
media jam

belt unit 299
folder 293
fuser section 275
media feed section 274

media series setting 142
media sizes 312
media types 310
menu card 116

N
network settings 122

default gateway 127
dhcp server 124
ip address 125
subnet mask 126

O
océ engineering exec ® 109
océ license logic 75
océ power logic® controller 28

applications 29
location 28

océ print exec® workgroup 173
océ repro desk 108
océ settings editor

auto original feed 139
job templates 137
media series 142
original release mode 140
paper series 142
stamp creation 141
stamp settings 141
top 5 settings 137

océ tds450 printer 82
océ tds450 scanner 22
océ view station lt 57

off-line folding 245
operator panel

scanner operator panel overview 24
scanner operator panel usage 180, 214

original release mode setting 140
original type

background compensation 227
blueprint 227
dark original 227
greys & lines 227
lines / text for paper 227
photo 227
transparent for transparencies 227

original types for the scanner 304
original width

auto 228
custom 228
standard 228

output delivery tray 92
overview 99
overview of the finishing settings 232

P
paper series setting 142
password 72, 73
power logic controller

log off 74
log on 74
queue manager 50
remote logic 62
settings editor 33
start the applications 40
supported languages 67
system control panel 44

print
océ print exec® workgroup 173

print configuration report 117
print demo print 118
print job

cancel 176
print menu card 116
print on a cut sheet 174
print system configuration 43
printer

cut the media 264
define media series 265
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define the media size 262
define the media type 262
specifications 309

printer 28
printer configuration report 117
printer demo print 118
printer drivers 172
printer error messages 269
printer menu card 116
printer operator panel 84

keys 85
screen 85

printer sleep mode time-out 133
printer system messages 271

Q
queue manager

cancel jobs 145
history queue window 54
icons 56
inbox queue window 54
job priority 146
menu bar 53
overview of the functions 50
place jobs on hold 146
print jobs 144
printer window 54
restart jobs on hold 146
status bar 54
structure 52
toolbar 54
user modes 51
user operations 144

R
refill the toner 266
reinforcement knives

reinforcement unit 287
reinforcement strip

reinforcement unit 289
reinforcement unit 92, 95

definition 243
install reinforcement strip 289

reinforcement knives 287
tape jam 291
tape roll 277
waste box 285

remote logic
add system 69
connect to controller 69
install

unix 64
windows 63

remove system 70
remote logic

applications 62
command line parameters 66
start applications 66

remove a leading strip 205
remove a trailing strip 205
remove strip

leading 229
left 229
right 229
trailing 229

repro operator 18
resolution

scan to file jobs 226

S
scale 199
scale formats

standard 314
scan area 254
scan manager 57
scan quality 252
scan to file

colour mode 224
compression method 224
file type 224
organisation 224

scan to file jobs
resolution 226

scanned file
delete 154
print 153
view 153
view the properties 154

scanner
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original types 304
specifications 302

scanner 22
scanner error messages 251
scanner operator panel

overview of functions 24
overview of keys 24
usage 180, 214

scanner operator panel time-out 131
scanner sleep mode time-out 130
scan-to-file

job templates 212
scan-to-file job 212

basic 212
basic 218
extended 212
extended 219
introduction 212

scan-to-file jobs
checkprint setting 222
destination setting 222
lighter/darker setting 222
mirror setting 222
settings 222

scan-to-file jobs
clear an original jam 250
stop 221

set memory 248
set time-out 132
sets copy 194
settings editor

key operator settings 31, 41
load settings 43
save settings 42
system administrator settings 31, 41

shut down the controller 114
solutions

printer error messages 269
printer system messages 271
scanner error messages 251

specifications
controller

hardware 306
software 307

drivers 318
océ scan logic” 316
optional application software 319
printer 309

scanner 302
stacker 95
stamp 197
stamp creation setting 141
stamp settings 141
standard scale formats 314
stop

scan-to-file jobs 221
stop a copy job 187
strip

add a leading or trailing strip 203
remove a leading or trailing strip 205

subnet mask 126
system administrator 18
system control panel

icons 49
menu bar 46
print a list of current settings 43
print system configuration 43
status bar 48
toolbar 47
user operations 44

system messages
printer system messages 271

system settings 123
default gateway 127
dhcp server 124
ip address 125
subnet mask 126

T
tape jam

reinforcement unit 291
tape roll

reinforcement unit 277
temporary store

clear 154
the binding edge value

define 240
the binding method

define 239
the drawing method

define 238
the folded package length

define 241
the folded package width
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define 242
the folding legend

define 237
time out settings

printer sleep mode time-out 128, 133
scanner operator panel time-out 128, 129, 
131

scanner sleep mode time-out 128, 129, 
130

set time-out 128, 129, 132
toner

refill 266
top 5 settings 137
turn the system on/off

océ power logic® controller 114
océ tds450 printer 115
océ tds450 scanner 112

U
user mode 57, 73
users 18

anonymous user 18
common user 18
key operator 18
repro operator 18
system administrator 19

W
waste box

reinforcement unit 285
workflow 100
workflow 12

documents 12
jobs 12
overview 12
products 12

Z
zoom 199
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